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MicroStation V8i — File Open
1.0 File Open

When you start MicroStation by using the desktop icon [2Z2#], the first dialog box that appears will be File Open.

R —
A File Open - T:\de-proj\Saline\J2P2168\Plan Sheets\ =)

Lookin: || Flan Shests - @ m- IRl 20-VBDGN
- Name B Date modified Type Size
= #)001_TITLE_)2P2169 ITITLESHEET dgn  8/4/200910:30 AM  Bentley MicroStation Design 37 KE
Recent Places | a3 Qu_01_12P2169_11.dgn 11/17/20089:29 AM  Bentley MicroStation Design 19 KB
#]004_PP_J2P2169_1100.dgn 11/18/2008 8:36 AM  Bentley MicroStation Design 69 KE
" #]005_PM_J2P2169_150.dgn 10/10/2008 8:30 AM  Bentley MicroStation Design 63 KE
Desktop
L]
Christopher ).
Ritoch
A
LY
Computer
A
e
Network

File name: 003_QU_D1_J2P2169_I1.dgn - User: | DESIGN -
Files of type: [CAD Files "dgn:” dwg:™ ) <] [ concel | Prject:[I_100 ]

Through the File Open dialog box, you can perform a variety of functions to manage your files which will be
covered in this section. Here is an overview of the various parts this dialog box contains:
A B C D

A File Open - TAde-proj\Saline\12P2169\Plan §

Look in Flan Sheets @ ¥ e m = 2D-V8 DGN
n Name ’ Date modified Type Size
e L]001_TITLE J2P2169 ITITLESHEET dgn /472009 10:30 AM  Bentley MicraStation Design 27 kB
Recent Places | {1003 qu_01_12p216 11/17/20089:20 AM _ Bentley MicroStation Design 49 KB
#4]004_PP_J2P2169_1100.d3 11/13/20088:36 AM  Bentley MicroStation Design 59 KE
[ #]005_PM_j2P2169_150.dgn 10/10/2008 830 AM _Bentley MicroStation Design 63 KE
Select
Desktop
Open with MicroStation V8i
- Print with MicroStation V8i
W Open With...
[W‘R;t.m: F U Scanforthrests..
> L Always Available Offline
[ Restore previous versions
Computer Send To K »

- «  (Right-

Copy li
ick)
(s Create Shartcut clic
Delete
Rename
Properties
File niame: 003_QU_D1_J2F2169_I1.dgn - User: [ DESIGN -
Files of type: [CAD Fies (dgn:* dwg:* &) - Froject: m
| Open as read-oniy Interface

Below is a description of the various parts.
A. Banner
» Shows the name of the active dialog box.
»  Shows the full path of the folder.
»  Allows you to move the dialog box.

B. Navigation pull down (left-click on the down arrow on the bar to activate)
» Allows you to navigate to the correct drive and folder location.
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MicroStation V8i — File Open

Folder Options (left-click icon to activate)

» Allows you to navigate to the last folder visited.

> Moves you up 1 folder in the directory tree.

> Allows you to create a new folder.

> Gives you options on viewing contents (i.e., Icons, list, and tiles).

File Options and Directory History (left-click icon to activate)
» Allows you to create a new file.

» Allows you to compress a file, and looks at the last 10 files visited.

> Looks at the last 10 directories visited.

Other navigation options (left-click icon to activate)
Looks in folders you have recently been in.
Looks on your Windows Desktop.

Looks on your local C:\users\ drive.

Looks at all of your drives (local and networked).
Looks at your network.

VVVVYVYY

Display Field
» Shows contents of the current folder.

Preview Window

»  Shows thumbnail preview of the selected file.
>  Shows if the selected file is 2-D or 3-D.

> Shows the type of file it is (i.e., dgn, dwg).

File Type Pick List (left-click on the down arrow on the bar to activate)

»  Allows you to narrow down the type of file displayed in the Display Field (This should normally be set

to “CAD Files”).

Open/Cancel buttons

> Allows you to open a file or cancel out of the File Open dialog box.

Workspace Pick Lists left-click on the down arrow on the bar to activate)

» User and Interface options should not need to be touched.
»  Project should be set to the scale of the border file.

More File Options (when you right-click on a file in the Display Field, then left-click an option in the drop-

down menu)

Select will open the selected file.

Cut/Copy/Paste will perform that operation on a file.
Delete will delete a file.

Rename allows you to rename a file.

YV VYV
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MicroStation V8i — File Open

1.1 Working with the Mouse

A typical Dell mouse has 2 buttons and a wheel (roller) in the middle. The roller also serves as a button when
pressed down on.

(Note: L=Left, R=Right, M=Middle mouse buttons)

Tentative (snap)
Data (accept) Reset (reject)

The DATA button (left mouse button) is used to:
»  Select icons, menus, or graphic elements.
» Confirm a selection (i.e., OK a confirmation to delete a file).
» Create a selection set with an element or elements (more about this later).

To enter a data point
1. Position the pointer on the desired location.
2. Click the Data (left) button on the mouse.

The TENTATIVE button (middle mouse button or wheel) is used to:
»  Snap to a point (key point, midpoint, etc).
> Reference a point (key point, midpoint, etc) on an existing element for the purpose of typing in a value to
be measured from that point.

The RESET button (right mouse button) is used to:

» Reject a selection if another element is in the same proximity (selection will toggle through all of the

elements within close range).

» Cancel or terminate a command in progress.

> Allows you to repeat the last command activated (i.e., place line).
Resetting
Resetting in MicroStation is similar to using the <esc> key in other applications. Resetting will “back you out” of
most MicroStation operations that have several steps. For example, if you use your View controls to zoom in, doing
a reset (or 2) will back you out of the View controls and back to the tool you were previously using.

To Reset

Click the Reset button (right mouse button).
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it is incorrect, select the “Remap Buttons” button.

MicroStation V8i — File Open
NOTE: The preset defaults may not be appropriate for your mouse. You can find the settings for this under
Workspace->Button Assignments. Make sure the “XButton1” (middle mouse button) is set to “Tentative Click”. If

This will bring up a new dialog box.

Butten Assignments: ...\WorkSpace\interfaces\Buttons\default.stnmenu
File
Buttons
bot D& [k
Button:  Data
‘
Button: Action
Shift+Data pan scroll
Alt+Data match attributes fromeursor
Cirl+ Tentative buttonaction tentative accudraw setorigin
Alt+Tertative buttonaction 3ddata
Cir+Reset inputmanager menu main
Citri+Shift+Reset inputmanager cumenttask
Alt+Reset md| keyin elementinfo element quickinfo fromcursor
XButton 1 tentative click
Shift+¥Button 1 rotate view drag
Citri+XButton 1 navigate swivel
Alt+XButton 1 rotate view fromcursor

Button Mappings

Buttons

<Tanlahve ’

XButton 1
XButton 2
XButton 3

Invoked by

Left Button

Left Button - Right Button Chord
Right Button

Middle Button

Button 4

Button 5

)

i

Button Defintion
Press the button you want to use for <Tentative> here
You can use any mouse button or two-button chord

K

Button Mappings

Buttons
Data
Tertative
Reset

| XButton 1
XButton 2
[ XButton 3

Invoked by
Left Bution
Middie Button
Right Btton
Bution 16
Bution 4
Bution 5

[

Button Defintion Area

Press the buiton you want o use for <Tentative> here
You can use any mouse button or two-button chord

Click on the word “Tentative”, and hover your mouse over the Button Definition Area
button. The definition for Tentative will change to “Middle Button”. Click OK.

. Click the middle mouse
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MicroStation V8i — File Open
1.2 MicroStation V8i Window Layout

A) Banner B) Pull Down Menus

7

[ 1ne-progisasnezPasssipies " v
| L gt Bement Semings T, Ty |
e=r—w R 3-8 L T S T
=" J San o)
| B Y Y Y g \
. 4 | C) Attributes D) Primary E) Standard
F) Main | 22| Tool Box Tool Bar Tool Bar
Tool s, A,
Frame o
€
*x [
M Element Selection [= || & |[ 2 |
Bci=ion G) Window/View
Ele-a@ b |, 1) Scroll
. ) Bars
J) Tool Settings Dialog Box — This dialog may look °
different depending on the selected tool.
: i Dntmt e, || T (W22 o] 5] 7 el
'_-'um:e-e\w dertty semert 12 33 . | & Commentetes
SN—— ____—
H) Status Bar
A) Banner
M T\de-proj\Saline\J2P2169\Plan Sheets\003_QU_01_J2P2169_T.dgn [2D - V8 DGN] - MicroStation Vai [ =@ ][==] 1

» Contains the name, file location, and software along with the minimize, maximize, and close
icons.
»  Allows you to move or relocate the dialog box.
> Displays which box is active when highlighted.
B) Pull Down Menus

* File Edit Element Settings Tools Utilities Workspace Applications Window Bridge Design Construction Add-Ons  Help

Some dialog boxes have pull down menus. Move your mouse to the menu item and click the data button. The
menu will pull down revealing commands and cascading sub-menus. Data point on a selection to choose an item.

C) Attributes Tool Bar
Os~-zo0-=2-
The Attributes tool bar contains frequently used drawing tools and controls for frequently used settings. By

default, it is docked to the top of the MicroStation window (directly beneath the pull down menus bar). You are
allowed to undock this tool bar.
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MicroStation V8i — File Open
With this tool bar, you may:
Set the active level.
Set the active color.
Set the line style.
Set the line weight.
Preview the active line symbology.

VVVYVYY

D) Primary Tool Bar
T =M= Mo

The Primary Tools tool bar is a launch point for commonly used MicroStation tools. By default, it is docked to the
top of the MicroStation window (directly beneath the pull down menus bar). You are allowed to undock this tool
bar.

With this tool bar, you may:

View the Reference Manager

View the Raster Manager

View the Level Manager

Look up the information attributes of an element, line, or cell.
Activate or deactivate AccuDraw.

VVVYVYVY

E) Standard Tool Bar

DNrd s s B

2

This tool bar contains items that enable quick access to commonly used pull down menus. By default, it is docked
to the top of the MicroStation window (directly beneath the pull down menus bar). You are allowed to undock this
tool bar.

With this tool bar, you may:

Create a new file.

Open an existing file.

Save afile.

Print a file.

Cut, copy, paste elements from one file to another.
Undo a function.

Redo a function.

Invoke the Help menu.

VVVVVVYVYYVY
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F) Main Tool Frame

MicroStation V8i — File Open

These are used to select drawing tools commonly used by Highway Designers and Technicians.

The Main Tool Frame is open by default the first time you open MicroStation. It is docked to the left edge of the

MicroStation window. It can be undocked and redocked on the right edge of the window.

With the exception of Select Element and Delete Element, the tools in the Main Tool Frame are also members of a
“child” tool box. When a tool is pointed to and the Data button is held down, its child tool box opens. The child tool
box can be removed by selecting “Open As Tool Box” located at the bottom of the child tool box. When a tool is

selected (whether attached or floating), the tool automatically becomes the default tool of the child tool box in the

Main Tool Frame.

Points - CO[E]

+

Text - CO [
B 4 n=es ABC -

A 3 g 00 B )

Measure - CO (=]

o A A O

T TNTAE QLTI RTRTETE (T A TY R QAT

Change Attribut... 8]

@ % eV

Madify - CO

=]
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G) Window/View
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Selection- CO (&
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Linear Elements - CO (=]

8/ 00

Patterns - CO El
7 @ () I H
@ A J _'] _J* >_<

Groups - CO [

W S 2\

Manipulate - €O

[

® Vi 1 Do

Windows or views display the design file graphics. There are eight (8) different views which can be overlapped,

cascaded, or tiled. The banner identifies the window number (and name when displaying a saved view).
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MicroStation V8i — File Open

H) Status Bar

Provides prompts, context-sensitive assistance, and some interactive functionality.

‘Eemei_’vt Selection > Identify elemert to add to set

®©

1)
2)
3)
4)
6)

7)
8)

9)

”7 J}ﬂ Common-Notes k :a / T _i
| |

@ TOO ©®DpHD®

Selected tool > prompt — Shows the name of the selected tool or view control. Usually contains a prompt
for the next step in using it.

Message Center — Shows system message information. Clicking in the Message Center portion of the
status bar opens the Message Center dialog box. This box contains a running log of system messages in
the current session of MicroStation and any further description about the message if applicable.

Snap mode — Shows the currently selected snap.

Locks icon — Clicking the Locks icon provides access to the locks sub-menu.

Active Level — Shows the current active level.

Element selection indicator — If elements are currently in a selection set, the number of elements in that
set will be displayed.

Fence indicator — If a fence has been placed, the type of fence placed will be shown.

DGN work mode - Indicates the current work mode. In DWG mode, certain functionality is disabled in
order to restrict MicroStation to only creating information that can be stored in DWG format.

DGN file changed indicator — If nothing appears in this box, there have been no savable changes to the

file, this box will be blank. If changes have been made to the file, a floppy diskette = will show. If the

file is opened as Read-Only, a floppy disk will show with a red circle with a slash through it 9 showing
that you cannot edit the current file. You can use your view tools, measure tools, and plot when in a read-
only file.

10) File not protected or signed — This block is not used by MoDOT.

1) Scroll Bars -

Toggles display of scroll bars on/off.

Scroll Bars allow the user to :
navigate through the design file
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MicroStation V8i — File Open
1.3 Pull Down Menus

File - The File pull down menu contains items for creating, opening, closing, and saving design files and cell
libraries, working with references, importing and exporting files, printing and ending a MicroStation session.

A T Satne 221631 P Sheets 003 GU_D1_LZPE169 1 g 10 - VA DA - MeroStation i
Fle | Edt Beent Semiags Teoh [mlies Werbpete Apphcatioos Window [rdge [Deign Commucion Sdd-Oms Hep

-J'I:.L".'— el ) == = O AN DY = L A
Qpan. Cate0
oe o

f8 e el

b e
Compeen
Sevt Settiegs [

& Feleemen

KD Faster Manager
trpon
fwpart

- Saline UG 2167 Plan Sheets\01 TITLL2P2163 MITLESHENT g
| de\pwite docal 0OEN1 Title K195 Taieboct dgn
1 teeel\ Deskiog MPIESTI00S TOM_MPLESS 1 dgn
el Desktop MFIESS008, 5503 P15 11 DGH dgn
1 Socal 11 1ABTT\DOY, GU_DOTT_MSI05, Cosartities T6s dgn
. i Socal 1L L46TI\001, GU_OCTE_MS10S, Grranmtities dgn
% pm_local L1138 W mmamight dgn
[ i Jcah L 25607\ BRRPLAT PO 108 BEARCHEAK

Et

Edit — The edit pull down menu contains items for undoing and redoing changes, cutting/copying/pasting from 1
file to another, grouping/ungrouping selection sets, and locking/unlocking elements.

i g UL D1_ITPTI69. 1. dge (70 V8 DGN] - N
Fle 6 | Bement Settings Toch Uit Worapace Apghestiom Window Bridge Desgn Consuction Add-Om Hdp
oo | Undo Deete Blement m:kn‘g.‘ e R ZER= X P Tt = Y

Unde Dtper
< I o]
etk |
8-
Culat
4
i Cubnc
M| D e Cariey
B Pategpecat
a et |
7 il |
£ |
B Cuteb
(%
AT Pnamepiace Tes
5 Sotect 51 emea |
_)' Sehect e
fl ey A
et Object..
I Update Links
Links.

& KL

Element — The Element pull down menu contains items for modifying the attributes of an element.

M P2 : QUoLEPRE

Fle ESt | Dewrs | Somings Tock Usitier Wodipice Applcaons Window Dridge Design Comtruction Add-On bilp

e BandBugiee l-=.- S-R-2-0s 0 " Bl
4 Cels !
K [=% | pemension stytes ]
Datwing Symbed s |
Line Stpter v

[ |

!

. Tog '|
J‘I Tt Seyber

ement Temglates |

Settings — The Settings pull down menu contains items for reviewing and changing non-element specific settings.

i A 000,101 1292189_1.cdgn [20 - V8 DN - MicrsSeation Ve
fFe fdi Uemert  Seings | Jools Ubities Wodspace Appcstoss Window Dridge Dengn  Constnction  AddeOns  Help
Comontigns = Lootimting: Az

B2 Od 00 0ls

i e

Gofor Table..

Design Fie..
<), Diapay Stifes..

i Deaing Scale

- Levely

al, & Locts v
(@ Rendering »
o S '

A | View hitsbuter  Cal-D
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MicroStation V8i — File Open

Tools — The Tools pull down menu contains items for opening and closing tool boxes, as well as creating new tool
boxes.

P T3 ooy Sl (92163 e Sheet 003 (1 02 29218 1. gn 20 -V DN - MroSeation V1
File Edi Blement Settings | Teok | Utiities Worktpate fpplicstioon  Window Bridge Deign  Condnuction Add.One  Help

:‘.'-?:-:"*-.;..._:'Dﬂ“"pf“““ 1— N2 0480 Bl
iy
g | ® Viewd Dethult Soandard |
i Han
.
R Tasks
g il Acculraw
. Animatice, .
o, Race Geometry v
- com 3
i Change Tracking 3
' Loorhnste Systems |
A Curves 1!
B Lustom Linessyles o
e P
U Detuiling Sypmbel |
= Dimesiong vl
% Shitie '
»a Geogaphi |
i fram '
s | Levels '
4 Manipulate v
M Meatue ol
&, vl
> Mhifines v|
[ 31 Barametsics i
Eatteming f
Broject Mavigabon v ‘I
Properis v
Baster ol
Rediins v
Befnimnce vl
Sefection v
|
Tet v
Virw v
Vet [
Tood Burs o T
Close Tool Bares.

Utilities — The Utilities pull down menu contains items for invoking utilities, macros, and extensions to
MicroStation.

A T Sl 92268 o Sheets 003 U 612921801 g 20 - V8 D] - MicreStation 1
File Et Tlement Sttinge Tecl |Unlsis: | Wesspate Apglicstiont Window Brdge Detign Construction Add-One Malp

W R G- 2@ Al
B = Conmect Web Browser =
y |REE HIME Auther...
; Call Selector
1 Tmage '
[ v
‘?é' 3 fniliary Coonfinates
o, Saved Wiewws
- Hined Geoup
i Bebch Comwerter..
Batch Process..
a0 Diata Clesmm
n-ﬁ, Dimensizm Suds
A, oW .
o License Management...
e Mascro '
e MDL Apglications

Workspace — The Workspace pull down menu contains items for setting user preferences, as well as customizing
buttons and function key (F1-F12) assignments.

A T Salinet 292165 Pan Sheet)£03_(U.02_I2PE189_B g (20 V8 DG] - MieroSeation V81

Apphcations Whndow flidge Deeign Cemmucion Add-Ons Help

—iSon-2-00 081

Fommentiten | (] 8 7 75 0 -4

Function Keys...
Dutton Assignments...

K | ® vew, Defeun

About Workipacs [~
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MicroStation V8i — File Open
Applications — The Applications pull down menu contains an item for activating and deactivating the Bentley Civil
application.

P Tt projSaline\ITRIES Man Sheets!003_ (U 02 _2P2165 7 dgn |20 - VE DGH] - Mcrobtation V1
[le [t Dement Setings Tooks lhiities Workspace  Appbcations | Window [ridge Design Comsbuction Add-Ons Help

Comentioms__= [0« 5 0 2| S 4 -|Loomeom ). 0. 2-@4 00 @4

K B View 1, Defoull

Window — The Window pull down menu contains items for opening and closing views, and controlling the
arrangement of views and other windows on the screen.

A T g S\ 2P 218\ Plar Sheet 003, QU 01_2P2188, 1. dign [20 - V8 EIGH] - McenStation Vi
e Edl Elemenl Seltngs ook Ulbties Werspace Apphestions | Windew | Bndge Design  Comtrsction  Add-Ons  Help

Rommontiss =] [J 0 =220 =S 4 ~ XE;EJ& * .« Dislog (= §Y
K | Ve, Defaut T* ik
2
il ferange ~
'"'" v el Bars =
. et ¢
\f_ o View ToclBex 5
o, 1 View 1, Defiult i
3

Bridge — The Bridge pull down menu has been designed to assist Bridge Division in creating Bar Bill sheets, and
placing geometry and notes which adhere to MoDOT Standards.

A Teide-proj)Saline J2P2IE3\ Plan Sheets\303_QU_01_PZLES 1.dgn [0 - V8 DGH] - MicroStation V81
file [dt Element Zettings Jook Lhilties Wordspace Applications Window Bridge  Design Constnsction  Add-Ons  Help

Cormmentatm el (10 =55 0. r = 4 v eo— ) | b T = N
Dridge ook
X | o e, Dtau Place Border

Tridge General Hates |

Bndge Standeeds |

Design -The Design pull down menu has been designed to assist Designers and Design Technicians in placing
geometry, text, or cells which adhere to MoDOT Standards. Each sheet type listed invokes a different Settings
Manager dialog box (See Settings Manager chapter).

-k Thsde-projiSaling P TIEHFlan Shestt003 QU 21_GF2063 11 dgn 20 - V8 DGN] - MicreiStation VB

Fle G Goment Sellings Took Uiikes Weskspece Aophcations Window Sidge | Devgn | Construction Add-Ons b
| Cut Btan Sheser
" Projectiice Stan GEORAK Job ¢ Add User =
g | = Viewl, Defaut st Sandard Tty .

Comentitms =] [] 0 =55 0 < = & - o— ] - (g

Tale Sheet

Typicsl Sactions

Surenaey Shast

b Plan Shest

o4 Profile Shast
Usas Disign File

3 Refaran,

Coardinate Points Sheet

Tradfic Control Sheet

u) Iresion Control Sheet

Lighting Sheet

I“. Signals Sheet

Signing Sheet

Signing Section Sheet

H-Sections / Cubverts Sheets

sirte Shast

General Services - Mapping
Survey

P e ETLL % 0

Preiminary Flan

Construction — The Construction pull down menu has been designed to assist Construction Technicians and
Inspectors in invoking the 2A Sheet program, placing geometry, text, or cells which adhere to MoDOT Standards.
Each sheet type listed invokes a different Settings Manager dialog box. Also contained in this menu are the
Construction Tool bar, and short cuts to the Snaps button bar, and the Construction Tip Jar.

H U s
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MicroStation V8i — File Open
Add-Ons — The Add-ons pull down menu contains additional tools which were created by MoDOT or a third party.

P Tkt Salne (2P 2169 Pl Sheets 003, GU.01 1291681 g 120 - V8 DM - Mecrosabion Ve

Fle Edt Eeement Setbmgs  Jook  Uhikties Weelspace  Applications

e ete A0e-Ee - = - BB O _' Fueel to Microitation
= Geapak Ulities

Wmdow Erdge Design  Censtruction | Add.Ons | Help

& ® View1, Default

InfeSnap

H AurcTum
Sh
J Descartes

Help — If a description is needed here, then you need more help than this manual can provide.

| B pro Sl 272850 Fiars St 081 1186 11 g (75 - 8 D) - Mo V04

Fie ES Fement Sesngi Jooh Uhities Werbipace Apphostiens Windew frdge Deugn Contruction add-Oei  Hep
ot = [ o -3 92 4~ S22 - O 4L s |
; CADE Services Wik
k| ® Viewd, Dt CADD Suppet Salt
fontents
Tool lndex
o Yool Tips

Tracking

& {

bt MecreStation Vi

|
5|

|
|
| Kep- B
g

Tool Tips — If on, positioning the pointer over a tool icon displays a tool tip, which is a yellow rectangle
with text that provides the name of the tool and in most cases a brief description.

Tracking — If on, the help page for each newly selected tool or view control is automatically displayed.
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MicroStation V8i — MicroStation Windows/Views

2.0 Windows/Views

MicroStation uses the terms “windows” and “views” interchangeably. MicroStation gives you the option
of having up to eight (8) view windows open at one time. Also, it lets you customize the arrangement of

view windows within the application window. —

Views 4 .\/ Dialog
From the Window menu’s Views sub-menu, choose the number ?f““ 1
of the view window you want to open. Check marks in the sub- o i
menu indicates the numbers of open view windows. M s
v !\ew;oo\éux i
1 View1, Default i
2 Element Selection 8
View Number/Name Banner Minimize/Maximize/Close buttons
“ J / — _J
/ ¥ \i ——
B View1, Default [ | =]
Restore
Move
Size
- Minimize
s <«—— Control Menu
x Close Alt+F4
View Attributes
Level Display
View Save/Recall
. Scroll bars
View Commands
EB-ARQDEEA BE|H oE
SN——r_
Window | _
Also from the Window menu’s View sub-menu, choose Dialog.
The View’s Groups window opens. By default, it is docked to the o vl
= 2
bottom of the window. Numbered buttons that are highlighted Arange 3
represent the open views. Y %E.. S
v View ToolBox 3
1 View1, Default i
2 Element Selection 8
X . X . View Groups =]
To open a closed view window, click its numbered button. :
[ Defautt Views |2]4]5]5]7]2
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MicroStation V8i — MicroStation Windows/Views

To close an opened view window:

From the Window menu’s Views sub-menu, choose the number of the view window you want to close.

View Groups

[ Default Views

=
|ales]s]7]s

Or

In the view window’s title bar, click the close window button at the far right.

Or

Double-click the window menu button at the far left.

Or

From the view windows control menu (open by clicking the window menu
button at the far left of the view window’s title bar) choose Close.

To maximize an open view window:

-
Click the view window’s Maximize button. =)=

-

Or

From the view window’s control menu, choose Maximize.

Or

Double left-click on the view’s window banner.

==

‘ j ;\EWL Default

B View 1, Default
Restore
Move
Size

—  Minimize

o Maximize

AlteFa

View Attributes
Level Display

View Save/Recall

B View1, Default
Restore
Move

Size

x Close Alt+F4

View Attributes
Level Display

View Save/Recall

B View 1, Default

To minimize an open window:
Click the view window’s Minimize button. @EA'

Or

From the view window’s control menu, choose Minimize.

e ] |

B View1, Default
Restore

Move

o I Bamize

x Close Alt+F4

View Attributes
Level Display

View Save/Recall
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To move a view window with the pointer:

1) Position the pointer on the banner of the view window

2) Press and hold down the data button

3) Drag the view window to the desired location
Using the resize borders:
The four borders of a view window are called resize borders because dragging them resizes the view
window. For example, by dragging the right or left resize border, you can change the width of the view
window. Similarly, by dragging the top or bottom resize border, you can change the height of the view
window. By dragging the corner of the resize border, you can change both the height and the width
simultaneously. The pointer indicates the directions in which you can drag the border or corner.
To resize a view window with the pointer:

1) Position the pointer on one of the view window’s resize borders or corners

To change Position pointer on The pointer becomes

Height Top or bottom resize border

Vertical double arrow

Width Right or left resize border

Harizontal double arrow

Height and width simultaneously |Any corner

Diagonal double arrow

2) Press and hold down the data button
3) Drag the border or corner to resize the view window as desired

2.1 View Commands (View Control Bar)

View controls are used to manipulate a view (the portion of the design displayed in a view window).
The most commonly used view controls can be selected in the View Control Bar on the bottom
border of each view window. The common tools are listed below.

Zoom Out Undo View

YA |
o n\ / Redo View
Update View /
View Attributes \ Copy View
\ /

E- AR @& S B H

Window Area // \\v\ Pan View

Fit View Rotate View
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View Attributes - (See section 2.2 View Attributes)

Update View — is provided to redraw the display when an operation leaves a view with an
incomplete display.

Zoom In - Increases a view window’s magnification, making elements appear larger. Zoom ratio
sets the factor by which the view is magnified. The range is 1-50.The default setting is 2.

}{ ZoomIn (==l 2

Zoom Ratio: | 2.00

Zoom Out — Decreases a view window’s magnification, making elements appear smaller. Zoom
ratio sets the factor by which the view’s magnification is decreased. The range is 1-50. The

default setting is 2.
M Zoom Out (=1ll=l] X |

‘ Zoom Ratio: | 2.00 ‘

Window Area — Lets you see the boundaries of a rectangular area in M Window Arez laall= il
the design to be displayed within a view. Apply to window option, if 2D 15 v
on, sets the destination view window. The chosen view window 3 ]
opens, if necessary. :
[
8
(aa Fit View — Adjusts the view magnification so that the entire design file is visible in the view.
[ 44 Fit View o = |
Al ]
Active
BReference
Raster
Tool Settings Effect
Sets the scope of the fit operation:
e All — Display all displayable elements in the active model file and any
Files attached references.

e Active — Display all displayable elements in the active model file.
e Reference — Display all displayable elements in attached references, if any.
e Raster— Display all displayable elements in attached raster references, if any.

Expand Clipping |If on, the view's Display Depth is adjusted, along with the view origin and

Planes

magnification, so that all elements on levels that are on for the view are displayed.
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(e

Rotate View — Used to rotate a view.

M Rotate View =RE=] @‘
1 # Dynamic I
i i 2 Points

Unrotated

Tool Settings Effect
Sets how the view is rotated.

e Dynamic — Lets you rotate a view interactively about a defined point (default is
the center of the view at the active depth). As you rotate the view, the elements
rotate to let you see the result of the rotation.

When you select Dynamic, a plus sign (+) appears in the center of the active view
to define the center of rotation. Prior to starting any rotation, you can click on the
plus sign and move it to redefine the center of rotation.

Method e 2 Points — (2D only) Lets you rotate the view by placing two points to define the
views X axis.

e 3 Points — (3D only) Lets you rotate a view by placing three points to define the
view's X and Y axes.

e Unrotated — (2D only) Lets you set the view back to an unrotated state.

e Top|Front|Right|Isometric|Bottom|Back|Left|Right Isometric — (3D only) Lets you
set a view to one of the standard view orientations.

- Pan View — Used to view a different part of the design without changing the view’s

magnification.
To pan:
1) Select the Pan View control
2) Enter a data point to select the view to pan and to define the origin for panning.
3) Enter a data point to define the position in the view where you want the origin to be
displayed.
EI

View Previous — Undoes the last viewing operation (view control operation or view attribute
change)

NOTE: To undo a drawing operation, choose Undo (action) from the Edit pull down menu.

&I

View Next — Redoes the last undone viewing operation.

Copy View — The Copy View control copies the contents of an entire view and its corresponding
attributes to other views.
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To copy a view:
1) Select the Copy View control.
2) Select the source view

3) Select the destination view to which to copy the source view.

2.2 View Attributes

View Attributes other than level display are set in the View
Attributes dialog box. Some determine whether parts of a
model and drawing aids will be displayed. Others determine
how the DGN file is displayed.

To turn View Attributes ON or OFF.

From the View Control tool bar, select the
View Attributes button

A\'%Qu&l@lw B &5

Settings

v Tool Settings
Or =} AccuDraw
Color Table...

Design File...
From the Settings Menu, choose &) Display Styles..

View Attributes (or use <CTRL-B>) Urmny St

Levels
& Locks
() Rendering

od Snaps
|| View Attributes  Ctrl+ B D

- v v -

Or

From any view window’s control menu, choose View Attributes.

The View Attributes dialog box opens.

M View Attributes - View 1
View Number: 1 - |5 &

() Presentation

Display Style: (Wirsframe Dispiay)

£ ACS Triad Bl
£ Background 2 Grid

i1 Boundary Display & Level Overrides

Camera [E]tine sytes
» Clip Back = Line Weights
* Clip Front & Pattern/Bump Maps

& Clip Volume (3] Patiems

I Constructions G- Default Lighting

D\menslons Tags
|£|Data Fields Text

X! Displayset % Text Nodes

Fast Cells @ Transparency

), Fast Curves

Global Brightness: W ¢

E view Setup

B Viewl, Default
@ Restore
Mowve
Size
— Minimize

Maximize

x Close Alt+F4

View Attributes
Level Display

View Save/Recall
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Parts of the View Attributes dialog box:

(Only the controls pertinent to MoDOT operations will be covered here. See the Help
documentation in MicroStation for explanation of the others). Those denoted with “See
MicroStation Help for explanation” should be off.

Applies to open views Applies to selected views only

M View Attributel View / BRI ES
View Number: | 1= A

) Presenta ! HEA

Display Stybe:| Display) - q

%, ACSTrisd E]Fm

i Backgrouf + Grd

i1] Boundary By Level Overrides

ElL.re Styles
1 = Line Weights

& PatternBump Maps

4 Clip Volume Fonm',

I Constructions ‘e Default Lighting
L-ums-:cs

Dz:a Fields

K- Displayset ¢ Text Nodes
[E] Fast Celts € Transparency
2, Fast Curves

Global Brightress: #

B view Setup v

ACS Triad - See MicroStation Help for explanation
Background — See MicroStation Help for explanation

Boundary Display — Controls whether the boundaries of a clip volume are displayed for a given view, as
well as reference clip boundaries.

Camera — See MicroStation Help for explanation
Clip Back — See MicroStation Help for explanation
Clip Front — See MicroStation Help for explanation
Clip Volume — See MicroStation Help for explanation

Constructions — If on, construction elements (those with the Class Attribute of Construction) will be
displayed.

Dimensions - If on, dimension elements are displayed.
Data Fields — If on, Enter data fields are displayed.
Displayset — See MicroStation Help for explanation
Fast Cells — See MicroStation Help for explanation

Fast Curves — See MicroStation Help for explanation
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Fill - If on, solid, closed elements with a fill type of opaque or outlined, and text characters with a filled
font display with color fill (if the fill color is B, the fill will appear the same color as the background).

Grid — See MicroStation Help for explanation
Level Overrides — If on, Level Overrides (previously known as Level Symbology) — the color, line style, and
line weight associated with each level — displays in the view, instead of the color, numbered line style, and

line weight of each element.

Line Styles — If on, elements display with their custom line style. If off, all elements with custom line
styles display as a MicroStation solid line style.

Line Weights — If on, elements display with their line weight. If off, elements will display with a line
weight of zero. (By default, the MoDOT Plotting Routine will briefly turn line weights on to plot, and then
turn them off automatically).

Pattern/Bump Maps — See MicroStation Help for explanation

Patterns — If on, patterned elements display.

Default Lighting — See MicroStation Help for explanation

Tags — See MicroStation Help for explanation

Text — If on, text elements display.

Text Nodes — If on, the text node number and a crosshair will be displayed.

Transparency — See MicroStation Help for explanation
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3.0 Setting the Active Element Attributes

When you place an element, the design plane locations of the data points used to draw the element are stored in

the design file. In addition, a number of element attributes are stored.
Element Symbology

These attributes compose what is called element symbology:

» Color
» Line weight
Attributes
> Line Style Defaul W5~ =0 =2~
> Fill Color
Color
Color Table
MicroStation stores the Active Color and color attribute of each File | Edit |
element as a value in the 0-255 range. To display an element in Open...
color, MicroStation looks in the active color table for the color Save As...
that corresponds to the element color value.
Revert

The attached color table is automatically activated each time
the design file is opened. Each seed design file supplied with
MicroStation already has a color table attached.

To attach the MoDOT color table:
Open the color table by choosing Settings > Color Table.

In the color table dialog box select File > Default. Then
left-click Attach to complete the steps.

To set the Active Color from the Attributes toolbox, press on the colored tile, and drag across the color palette to

select the desired color.

GetInfo

Line Weight

MicroStation stores the Active Weight and the i
rn e5

Line weight of each element as a value in the

0-31 range.

%]

A

Line Weight can also be set ByCell or ByLevel.

If ByCell is selected, when a cell is placed the
active line weight is used in place of the line
weight that was used when the cell was created.
If ByLevel is selected, when an element is placed
the active line weight on the active level is used
to display the element.

To ser the Active Line Weight from the Attributes

Toolbox’s Line Weight option menu, choose the
Desires line weight value.
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Line Style

Attributes =]

MoDOT has numerous Line Styles that can be Defaut - W s~

Accessed through the Settings Manager (see the

%]
A

Chapter on the Settings Manager) or by simply | 1 ;

Selecting the Active Line Style from the Attributes |77 77=~ 2

Tool bar. . i .
______ 5 See
—m 6 > foot

FO T ’ note
MoDOT Line Style samples CATY Ez:g:g Eushed below
MTTTTTTTT T T T T T T T T T T T T T T dash 3

Util. OH Power exist.

( Border )

(Center )

. . . , ( Dashdot )

To set the Active Line Style from the Attributes toolbox’s Line Style { Dashed ) -

option menu, choose the desired line style.

*The Line Style option menu has items that correspond to the most recent active custom line styles (up to four)
and the eight numbered Standard line styles.

Other element attributes
In addition to level, color, line weight, and line style, elements have these attributes:
»  Fill (none, opaque, or outline)
» Class (primary or construction)
» The area attribute determines whether a closed element is a solid or a hole.
Fill

The fill attribute applies only to closed elements such as circles, ellipses, and polygons. Closed elements completely
enclose the area within their boundaries.

By default, a closed element is displayed in a wire frame view by lines in the Active Color that outline the area
occupied by the element. The area of the element inside the outline is transparent.

The effects of the fill attribute and the Fill view attributes are summarized in this table:

Fill Type Fill on Fill off
None No fill displayed No fill displayed
Opaque Element filled with color of the element No fill displayed

Outline |Element filled with Active Fill Color or a gradient |No fill displayed

To set the Active Fill Type and Color
1) Select a tool in the Polygons toolbox.
2) From the Fill Type option menu in the Tool Settings window, choose none, opaque, or outline.

3) Select the desired color from the Fill Color color palette.
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To turn Fill on or off in a view
1) From the Settings menu, choose View Attributes (or press <CTRL-B).
Or
From any view window’s control menu, choose View Attributes.
The View Attributes dialog box opens.
2) From the View option menu in the settings box, choose the desired view.
3) Click the Fill check box.
4) Click Apply or All.
Class

By convention, elements with the class attribute of Construction are used as drawing aids.

Note: Using the Settings Manager will ensure that appropriate attributes are being utilized.

Linear Elements - CO - X}

3.1 Linear Elements Toolbox g 2 30

The tools in the Linear Elements toolbox are used to place linear elements.

> Place SmartLine — Place a line, line string, shape, arc, or circle, or a combination thereof as a complex
element.

» Place Line — Place or construct a line.

» Construct Angle Bisector — Constructs a line that bisects an angle defined by three points.
» Place Circle — Used to place a circle

» Place Arc — Used to create circular arc

> Place Block — Used to place a rectangular shape

3.2 Place SmartLine R S

/30O

Used to place a chain of connected line segments and arc segments as individual elements or as a single line string,
shape, circle, complex chain, or complex shape element. This tool supports all snap modes.

Rounded vertices can be created by allowing the tool to automatically place an arc tangent to two
adjacent line segments. You can also round between two arc segments, or between an arc segment
and a line segment. If a rounded vertex cannot be created, a sharp one is created instead. (This is often
a more convenient, though less versatile, way of placing an arc than directly drawing one as a
segment.)
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Tool Settings

Segment Type

Vertex Type

Rounding Radius

Chamfer Offset

Join Elements

Closed Element

Area

Fill Type

Fill Color

MicroStation V8i — Creating Elements

Place SmartLine g]

Segrent Type: | Lines bl
Werter Type: Fiﬁuu_.nd_ed’ ~
Rounding Badius: | 10.0000
Jain Elements -

Effect
Sets the type of segment.

e Lines — Sets line segments

e  Arcs — Sets arc segments

Sets the type of vertex.

e Sharp
e Rounded
e Chamfered

If after snapping to the first vertex point and before accepting it, you change Vertex Type, the
new setting applies only to the final vertex.

(with Vertex Type set to Rounded) If on, sets the arc radius for a rounded vertex. If after
snapping to the first vertex point and accepting it, you change Rounding Radius, the new
setting applies only to the next radius. If after snapping to the first vertex point but before
accepting it, you change Rounding Radius, the new setting applies to the previously placed
radius as well as the next radius.

(with Vertex Type set to Chamfered) Sets the two distances required to define a chamfer.
Chamfer Offset requires that the two chamfer distances be equal (from the theoretical
intersection point).

If on, places segments as a single element. With a tentative snap on the first vertex point, the
Closed Element settings appear.

If off, places segments as individual elements. The Closed Element settings do not appear, and
the individual segments can have different symbologies.

Toggling this setting affects previously defined segments in the chain.

If on, accepting a tentative snap on the first vertex point closes the element. Otherwise,
accepting such a tentative snap does not close the element.

(with Closed Element on) Sets the Active Area — Solid or Hole.

(with Closed Element) Sets the Active Fill Type.

e None (nofill)
e Opaque (filled with Active Color)
e  OQutlined (filled with Fill Color)

(with Closed Element on) Sets the color and optional gradient with which the element is filled:

e If Fill Type is Opaque, the fill color is the Active Color.
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Rotate AccuDraw
to segments

Always start in

line mode

MicroStation V8i — Creating Elements
e If Fill Type is Outlined, the fill color can be different from the Active Color.

(in SmartLine Placement Settings) If on, after you enter line segments, AccuDraw typically
rotates its compass such that the x-axis aligns with the line that you just placed. Instead of

turning off AccuDraw's “context sensitivity” feature which would stop this aligning behavior in
all the tools, the Rotate AccuDraw to segments setting affects only the Place SmartLine tool.

(in SmartLine Placement Settings) If on, when you select the Place SmartLine tool, the segment
type normally defaults to “Lines,” despite the last segment type used. If off, AccuDraw uses the
last segment type that you used.

To place a chain of connected line segments and arc segments

304

1) Select the Place SmartLine tool.
2) From the Segment Type option menu, choose the segment type.
3) Ifthisis the first segment, enter a data point to position the first vertex.
4) Enter data points to define the segment (follow the prompts in the status bar), snapping if
necessary to previously defined segments.
Segment Type Enter data points to Similar to
Lines Define endpoints of segments. None
Define center.
Arcs PlaceArc

Define sweep angle.

To define another segment of the same type, return to step 4. If you snap to the first segment but
are not completing a shape or complex shape, turn off Closed Element before accepting the
tentative point.

Or

To choose a different type of segment, return to step 2.

Or

To complete a line, line string, arc, or complex chain, Reset.
Or

To complete a shape, circle, or complex shape, snap to the first vertex point, and accept the
tentative point.

1\2( 1\Z< 14\*?
2 2 2
A B C
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The following table explains illustrations of the Place SmartLine tool starting at the top left and moving
clockwise.

Constructing a line string by setting Segment Type to Lines, Vertex Type to Sharp, and entering data

A points 1 and 2.

Setting Vertex Type to Rounded and Rounding Radius to 3.00 causes the active vertex (at the location of
B |data point 2) to be rounded with an arc. (If the data points entered do not allow a round of the specified
radius, a sharp vertex is created. Only one vertex at a time is affected by the vertex settings.)

C |Setting Vertex Type to Chamfered and Chamfer Offset to 3.00.

After setting Vertex Type back to Rounded and entering data point 3, Segment Type is set to Arcs, and
D |data point 4 is entered to define the arc center. The direction of the arc (clockwise or counterclockwise)
is determined by swinging the pointer past the starting point. (The Vertex Type setting is disregarded.)

After entering data point 5 to complete the arc segment, setting Segment Type back to Lines and
snapping to the starting point tentatively closes the element. To continue without closing the element,
turn off Close Element prior to accepting the snap point. (While the snap point is active it is possible to
change the vertex settings of the final vertex without affecting other vertices — here they are set to
Rounded and 1.50. It is also possible to turn on Fill and change other tool settings related to closed
elements while the snap point is active.)

To choose SmartLine Placement Settings, click the arrow in the lower right corner of the tool settings
window.

Place Smartline Q|§| g|

Segment Type: | Lines »

Vertew Type: | _Hoimded w
Rounding Badius: | 0.1000
Jain Elements

SmartLine Placement Settings

Rotate AccuDraw o zegments
Alwaps start in line mode

Place SmartLine is designed to be used with the versatile drafting aid, AccuDraw.

To negate the last data point — before Resetting (or otherwise completing the placement procedure) —
without affecting previously defined segments, choose Undo from the Edit menu. (Choosing Undo after
completing the procedure negates the entire chain.)

To combine contiguous open elements of any type into a complex chain (open) or complex shape (closed), use
the Create Complex Chain tool or Create Complex Shape tool in the Groups toolbox. (With Join Elements turned
on, Place SmartLine automatically places multiple segments defined with it as a single element.)
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3-3 PlaCe Line LiniErEIE.Tmnts—(E(.]— =]
R\ j_u ® L =

Used to place or construct a line. Where a line is constrained by a snap, such as Tangent or Perpendicular, and
more than one result is possible, MicroStation displays icons representing each possible result. In these cases you
can use the pointer to select the required solution, or you can use the Solution setting menu to choose the
required result.

Alternatively, you can use the keyboard and press the:

e  <Alt> key to switch to the next solution.
e  <Ctrl> key to select the nearest (to the pointer) solution.

Place Line

[] Solution: :Neales_t. V
Tool Settings Effect
Length If on, sets the length of the line in working units.
Angle If on, constrains the line to the Active Angle, which can be keyed in here as well.

If on, and there is more than one possibility for the next data point, lets you choose a solution

Solution
from the drop-down menu.

An additional key-in can be used, also, to control how the tool works:

Additional key- |CONSGEOM SET SHOWALTSOLUTIONS <OFF|ON> — If set to ON (the default), and a constraint

in setting snap is used, the tool displays all possible sizes and orientations of the element that would satisfy
the snap. The proposed element nearest the pointer location is shown in normal symbology,
while other possibilities are shown as dashed in muted color.

To Place a Line

1. Select the Place Line tool.
2. Enter a data point to define one endpoint.
3. If necessary, enter a data point to define the other endpoint.
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1 1
2 2
b~ X

. I X

Place Line. Clockwise from top left: Unconstrained, with Length “L” constrained, with Angle “AA”
constrained, with both Length and Angle constrained.

3.4 Construct Line at Active Angle

Linear Elements - CO - @

g /B0 v o

Used to construct a line that intersects a line segment (line or segment of a line string or shape) at the active angle.

M Construct Line at Active Angle == = |

Method: | From Point +
Active Angle: | 45,
Length: | 0.8333

Tool Settings Effect

Sets when the intersection is defined.

e From Point — The intersection is defined when the element being intersected is identified
Method (step 2).

e To Point — The intersection is defined by the second data point, as shown in step 3.

Sets the angle, measured counter-clockwise from the intersected line segment, at which the line is

Active Angle
constructed.

Length If on, the length is constrained to the value that is keyed in the field.

To construct a line that intersects a line segment at the Active Angle

1. Select the Construct Line at Active Angle. tool.
2. Identify the element to intersect.

If the Method is From Point, this data point defines the intersection.
3. Enter a data point.

If Length is off, this data point defines the length.

If the Method is To Point, this data point defines the intersection.
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Construct Line at Active Angle (“AA” denotes the Active Angle). Top Left: Method: From Point Length not
constrained. Top Right: Method: To Point Length not constrained. Bottom Left: Method: From Point Length

constrained. Bottom Right: Method: To Point Length constrained.

3.5 Place Circle

Linear Elements - CO - @

¢/ =[O] O

Used to place a circle. Where a circle is constrained by a snap, such as Tangent or Perpendicular, and more than

one resu

It is possible, MisroCtation displays icons representing each possible result. In these cases, you can use

the pointer to select the required solution.

Alternatively, you can use the keyboard and press the:

M Place Cirle = 19] ¢ |

Method |Center

<Alt> key to switch to the next solution.

<Ctrl> key to select the nearest (to the pointer) solution. frea (Soid ]
Fil Type: |Opaque -
"t Cor

Diameter = | | 2.0000

Tool Settings Effect

Method

Area

Fill Type
Fill Color

308

Sets the method by which the circle is placed.
e Center — position by center.
e Edge — position by three data points on the circumference.

e Diameter — position by diameter's endpoints.

Active Area — Solid or Hole.
Active Fill Type — None (no fill), Opaque (filled with Active Color), or Outlined (filled with Fill Color).

Sets the color and optional gradient with which the circle is filled.



Diameter
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e If Fill Type is Opaque, the Active Color.
e If Fill Type is Outlined, the fill color can be different from the Active Color.

If on, sets the diameter, in working units (if Method is set to Center or Edge). To instead set the
radius, choose Radius from the adjacent option menu.

To place a circle by its center

1) Select the Place Circle tool.

2) Inthe tool settings window, set Method to Center.

3) Enter a data point to define the center.

4) If Diameter (or radius) is off, enter a data point to define the radius.

SO

Place Circle with Method set to Center. Left: Diameter on; Right: Diameter off.

To place a circle by defining three points on its circunference

e A

Select the Place Circle tool.

In the tool settings window, set Method to Edge.

Enter a data point on the circumference.

Enter a second data point on the circumference (if Diameter is on and the pointer is moved to a location
that cannot be on the circle, the dynamic display of the circle disappears).

If Diameter (or Radius) is off, enter a third data point on the circumference

ShS

Place Circle, with Method set to Edge. Left:Diameter on; Right: Diameter off.

To place a circle by its diameter.

e S e

Select the Place Circle tool.

In the tool settings window, set Method to Diameter.

Enter a data point to define one endpoint of a diameter.

Enter a second data point to define the other endpoint of the diameter.

Place Circle, with Method set to Diameter
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3.6 Place Arc

Linear Elements - CO - @

¢ / L. O o

Used to place a circular arc. Arcs can be placed clockwise or counterclockwise. Where an arc is constrained by a
snap, such as Tangent or Perpendicular, and more than one result is possible, MicroStation displays icons
representing each possible result. In these cases you can use the pointer to select the required solution.

Alternatively, you can use the keyboard and press the:

M Place Arc == % |
e <Alt> key to switch to the next solution. Method [Star. Center =
e  <Ctrl> key to select the nearest (to the pointer) solution. —
Length:
Start Angle:
Sweep Angle:
Direction: COW b

Tool Settings Effect

Option menu that sets the method to be used for constructing the arc:

e Start, Center — Arc is constructed by placing its start point, center point, then sweep angle
and direction.

e Center, Start — Arc is constructed by placing its center point, start point, then sweep angle
and direction.

Method
e  Start, Mid, End — Arc is constructed by placing three points defining its start point, a
second point on the arc, and its end point.
e  Start, End, Mid — Arc is constructed by placing three points defining its start point, end
point, and a third point on the arc.
Radius If on, sets the radius.
Length If on, sets the length of the arc.
If on, sets the angle between the view's x-axis and an imaginary line between the start of the arc,
Start Angle

and its center.

Sweep Angle |If on, sets the arc's sweep angle.
If off, you can define the direction of the arc interactively with the pointer.
If on, the direction of the arc is controlled by the option menu.

Direction

e CW — The arcis constrained to a clockwise direction.

e CCW — The arcis constrained to a counter-clockwise direction.
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To place an arc by its center

1. Select the Place Arc tool.
Set Method to Center, Start.
3. Enter a data point to define the arc's center.
If Radius, Start Angle, Direction, and either Length or Sweep Angle are all on, the arc is placed.
4. If necessary, enter a data point to define the arc's start point.
If Radius and Start Angle are on, this data point defines the arc's sweep angle and direction, and places
the arc.
If Sweep Angle also is on, this data point defines the arc's direction and places the arc.
5. If necessary, enter a data point to define the arc's sweep angle and place the arc.

N

Place Arc, with Method set to Center, Start and no constraints.
Enter a data point to define the center (1), the radius/start (2) and the direction/sweep angle (3).

Place Arc with Method set to Center, Start, and all constraints on, except direction: Radius ©, Start Angle (ST),
Sweep Angle (SW).
Enter a data point to define the center (1) and the direction (2).

To place an unconstrained arc by three points

Select the Place Arc tool.

Set Method to Start, Mid, End.

With no constraints on, enter a data point to define the arc's beginning.
Enter a second data point to define a point on the arc.

Enter a third data point to define the endpoint and sweep angle.

uewWNPRE
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!
b
Place unconstrained arc with Method set to Start, Mid, End.
Define the start point (1), a point on the arc (2) and the end point (3).

Place Arc, with Method set to Start, Mid, End, and Radius (R), Start Angle (ST) and Sweep Angle (SW) constraints.
Place the start point (1) and define the direction (2).

3.7 Place Block

Linear Elements - CO - @

¢/ 00

Used to place a block (rectangular shape).

M PlaceBlock  [=121] ¢ |

Method: | Orthogonal

Area: |Solid -
Fill Type: [Opague -
FllColori[@ 22 ~|

Tool Settings Effect
Sets how the block's orientation is determined.
e Orthogonal — Block is orthogonal to the view in which the first data point is entered.

Method

e Rotated — Orientation is defined with a data point (step 3).

Area Active Area — Solid or Hole.

Fill Type Active Fill Type — None (no fill), Opaque (filled with Active Color), or Outlined (filled with Fill Color).
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Sets the color and optional gradient with which the block is filled.

e If Fill Type is Opaque, the Active Color is the fill color.
e [f Fill Type is Outlined, the fill color can be different from the Active Color, and the Active
Color becomes the outline color.

Fill Color

To place a rectangular shape.

Select the Place Block tool.

Enter a data point to define one corner.

If Method is set to Rotated, enter a data point to define the orientation.
Enter a data point to define the corner that is diagonal from the first.

bl A

2 2

Place Block. Left: Method set to Orthogonal; Right: Method set to Rotated.
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4.0 Identifying Elements

Many of the operations that you perform in a design session rely on the ability to identify existing elements.
MicroStation provides the tools to perform these tasks. You can quickly and conveniently identify elements, or
keypoints on elements, using tentative snap points and data points.

Identifying elements manually (Snaps)

Many tools require that you identify one or more elements. You can do this manually by placing the pointer over
the element and entering a data point to highlight the element. If you want to preview which element is being
selected, you can enter tentative snap points first, until the correct element highlights, and then accept with a data
point.

AccuSnap

AccuSnap automates the identification of elements and the placement of

tentative snap points, so that you do not have to enter all tentative snap

points manually. You can turn on the Enable AccuSnap setting in the | <3
General tab of the AccuSnap Settings dialog to automatically locate and R
snap a tentative point to elements. You simply move the screen pointer '

to the region of the element that you want to identify and AccuSnap

snaps to it automatically.

Automatic identification of elements

Separately or in conjunction with AccuSnap, you can enable the capability to automatically identify elements for
various tools. This feature is enabled with the Identify Elements Automatically setting in the AccuSnap Settings
dialog, General tab.

Like AccuSnap, this setting can greatly reduce the number of button presses required in a design session. Using this
setting with the Delete Element tool, for example, you only have to move the screen pointer over the required
element in any view and it highlights. A single data point then deletes the highlighted element.

Pup-up Info

As part of the automatic element identification functions, you can turn on Pop-up Info in the AccuSnap Settings
dialog, General tab. With this setting enabled, when you hover, or pause, the pointer over a highlighted element,
information about it appears in a pop-up window.
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4.1 Snapping to Points on Elements

During a drawing session, much of your time will revolve around joining new elements to existing elements in the
design, or modifying existing elements. In manual drafting, this is done by eye. With MicroStation, you can work
precisely, letting the system find the exact location of elements, or various points on elements. You can define

points relative to other points as well. All this is done using tentative snap points.
Tentative snap points
A tentative snap point is a form of graphic input that is used to:

e Preview the location of the next data point. Accepting the tentative

point location enters the data point there.

e Define a point of reference for entry of the next data point.
It is also possible to snap a tentative point to an existing element (put it directly on the
element). Tentative point snapping helps you accurately construct new elements that
are either connected

to existing ones or precisely related to existing ones.

Snapping to tentative points on elements

Button Bar
AccuSnap
Multi-snaps

Nearest
Keypoint
Midpoint
Center
Origin
Bisector
Intersection
Tangent
Tangent Point
Perp

Perp Point

Parallel

PhE

Point O
Multi-snap 1
Multi-snap 2
Multi-snap 3.

Snapping is affected by the Snap Lock settings. There are three basic Snap Lock settings: the snap on/off toggle, the

Snap Mode, and the Snap Mode override.

Locks = || B e
Snap Lock .
ALCS Plane otation Scale
Grid Lock Graphic Group
. Level Lock Text Node Lock
Access through pull down menus - Settings > Locks > Full Fence Mode: (Fada =]
If the Snap Lock toggle is off, tentative points do not snap to elements. Snzp
V| Snap Lock
oint hd
/ Divsor: |2
Snap / s Lock
Start Angle: | 0, 3
| Snap Lock 1 z 50,0000
Mode: oirt hd
. Unit Lock
Divisor: | 2 ngst:ncs. 0.0833
Association Lock lsometric
AT Plana lsometric Lock
e o= Isometric Plane: [Top =

Snap Mode

When Snap Lock is on, how a tentative point snaps to an element is set by the active Snap Mode (or the override

setting if one is active).

Snap Mode

2| -/

Snap Mode button bar showing the active snap mode highlighted and speckled. The override snap mode to the

right is highlighted in a lighter color.
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Button Bar

To set the Snap Mode via the status bar AccuSnap

402

Multi-snaps

Nearest

1) Place the pointer in the Snap Mode field located on the status bar. o Keypoint
2) Click the Data button. Copont
The pop-up Snap Modes menu opens. A button with a filled black argn
circle is displayed to the left of the active Snap Mode. iter:a:tmn
3) While holding down the <Shift> key, choose the desired Snap Mode ?”:“:M
by clicking it (or drag the pointer to it and release the Data button). Perp
4) Release the <Shift> key. it
Point Through
P
Multi-snap 2
Multi-snap 3.

Snap modes button bar

Choosing the “Button Bar” option from the Snap Modes menu via the status bar can launch the Snap Modes
button bar.

The appearance of this bar can be customized by right-clicking over any of the snap mode buttons on the
button bar and toggling on/off any desired snap modes. If right-clicking over the AccuSnap button or the
Multi-Snap button you must choose the “Show/Hide Tools” option from the context menu in order to
customize.

Snap Modes Bar — Default Configuration

Snap Mode

5| <

Toggle AccuSnap
Mear Snap Point

Key Point Snap
Mid Paoint Snap
Center Snap

Snap Modes Bar — Custom Configuration OrginSnep

Bisector Snap

Intersect Snap

B 1 O O I

Snap Mode =]
5 Tangent Snap
Tangent Point Snap

Perpendicular Snap

b

Perpendicular Snap Point

The Snap Modes button bar is dockable and resizable RaalElpap
Thru Point Snap

Point On Snap
SHEpMOdE @ v Multi-snap 1
@ o // @ _\éf' (J) }_( 7 _EL Multi-snap 2

Multi-snap 3

Show All

| Lst.

E-Ad8 Q8 Uaed B H/
etk views  + | T ([1]2]3]]5]6]7]e FAOE W ¢l B o]

Digplay complete Fence contents - Inside
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Snap Mode Override

During a session, you will most likely use a particular Snap Mode for a majority of operations, but occasionally you
want to use a different snap mode. At any time, you can override the current Snap Mode by choosing a Snap Mode
override. The override mode is effective only for the next operation. After you have snapped the tentative point
and accepted the data point (or reset), the override is cancelled and the active Snap Mode becomes effective
again.

You can set the Snap Mode override via the Setting menus Snap submenu, the Snap Mode button bar, the
pointer’s pop-up menu, or the status bar menu. The active Snap Mode, or Snap Mode override, is indicated in the
status bar.

Button Bar
AccuSnap
Multi-snaps

Mearest

'

Keypeint

Active Snap Midpoint

& Center
. QOrigin
Overrlde Snap/ Orig

Bisector

Intersection
Tangent
TR
Perp
Perp Point
Parallel

Point Through
Point On
Multi-snap 1
Multi-snap 2

Multi-snap 3

Snap Mode / / ]

% % 2 X s d ]

To set the Snap Mode override via the Settings menu

1) From the Settings menu Snaps sub-menu, choose the desired Snap Mode override. If you open the menu
again, you will see that the snap override has a button with a black filled circle to its left, while the active
snap has an open black circle to its left.

To set the Snap Mode override via the Snap Mode button bar

1) From the Settings menu Snaps sub-menu (or the pop-up Snaps menu in the status bar), choose Button
Bar. The Snap Mode button bar will open.

2) Inthe button bar, select the desired Snap Mode override. The Snap Mode override’s button is highlighted
in a light color; while the active Snap Mode’s button remains highlighted with speckles.

Snap Mode

e | ~

@
¥ 2 XS d ]

To set the Snap Mode override via the Snap Modes pop-up menu

1) Place the pointer in any view.

2) While holding down the <Shift> key, click the Tentative button.
The pop-up Snap Modes menu opens. If a Snap Mode override is already in effect, a button with
a filled black circle is displayed to the left of the override and an open black circle is displayed to
the left of the active Snap Mode. Otherwise, the button with a filled black circle is displayed to
the left of the active Snap Mode.

3) Release the <Shift> key.
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Choose the desired Snap Mode override by clicking it (or drag the pointer to it and release the
Tentative button).

To set the Snap Mode override via the status bar

1) Inthe status bar, click the Snap Mode indicator.
The pop-up Snap Modes menu opens.

2) Choose the desired Snap Mode override by clicking it (or drag the pointer to it and release the Data
button).

Effect of Snap Modes

With Snap Lock on, each snap mode setting has an effect on tentative snap points. When you enter a tentative
point on or near an element, the following occurs:

Snap Mode:
(or override)

Nearest
Keypoint
Midpoint

Center

Origin

Bisector

Intersection

Tangent

Tangent From

Perpendicular

Perpendicular
From

Parallel

404

Tentative point snaps to:

Point on the element nearest to the pointer.

The nearest of the Element keypoints on the element. This is the most generally useful of the snap
modes.

Midpoint of the segment of the element closest to the pointer.

Center of elements (such as circles, arcs, text, and so on) with centers. Centroid of other
elements, including shapes, line strings, and B-splines.

Origin of a cell or text, centroid of a B-spline, the first data point in a dimension element, or the
first vertex of a line, multi-line, line string, or shape.

Midpoint of an entire line string, multi-line, or complex chain, rather than to the midpoint of the
closest segment. It also snaps to the midpoint of a line or arc.

Intersection of two elements. (Two tentative points are required, although more can be used.)
The first tentative point snaps to one element, and that element is highlighted. The second
tentative point snaps to another element, and the two segments used to find the intersection of
the two elements are displayed in dashed lines. (If the two elements do not actually intersect, but
projections of the elements would intersect, the segments include projections of the elements to
the intersection.) You can continue snapping until the desired intersection is found; the last two
tentative points define where the intersection snap lies.

An existing element — the edge of the element being placed is constrained to be tangent to an
existing element. The tentative point dynamically slides along the element to maintain the
tangency as you move the pointer to finish placing the element.

An existing element — the edge of the element you are placing is constrained to be tangent to the
existing element at the tentative point. The tentative point does not move dynamically as you
move the pointer, but is locked in place.

An existing element — the line you are placing is constrained to be perpendicular to the element
— the tentative point slides dynamically along the element in order to maintain the
perpendicularity as you move the pointer to finish placing the element.

An existing element — the line you are placing is constrained to be perpendicular to the element
at the tentative point. The tentative point doesn’t move dynamically as you move the pointer, but
is locked in place.

An existing element, but does not define a point through which the line you are placing will pass.
Instead, when you accept the tentative point, the line you then place is parallel to the line to
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which the tentative point was snapped.

Through Point

Defines a point through which the element you are placing (or an extrapolation of it) must pass.

To nearest element, as follows: When entering second or later data point, constrains the next data

point to lie on it (if it is a closed element) or anywhere on the line on which it lies (if it is a linear

Point On element). When entering first data point, constrains the element being placed to extend to that
element (or the line on which it lies) from the second data point.

Multi-snapl |Multi-snap mode 1 by default is Intersection, Keypoint, Nearest.

Multi-snap2 |Multi-snap mode 2 by default is Intersection, Keypoint, Center.

Multi-snap3  |Multi-snap mode 3 by default is Midpoint, Intersection, Center.

Multi-Snaps

MicroStation gives its users the ability to use multiple snap functions in conjunction with each other through the
Multi-Snap tool. There are three separate multi-snap modes that can be set up to utilize any of the available snap
functions. When a multi-snap is active, and you move the pointer near an element with AccuSnap enabled or you

enter a tentative snap point, MicroStation sequentially
processes the list of snaps defined for that multi-snap.
Simply dragging the entry to the desired location in the
list and dropping it off in the new position can change
the order in which these functions are processed.

To access the multi-snap dialog box, you can choose
The Snaps>Multi-Snaps option from the Settings menu
at the top of the MicroStation screen, choose the
“Multi-Snaps” option from the Snaps menu via the
Information/Status bar at the bottom of the
MicroStation screen, or you can right-click over

the Multi-Snap button on the Snap Modes button

bar and select the “Properties” option.

Snapping to cells

Snap Mode

=|

= /)

Mol = =

[ Origin
[7] Bisector
[ Midpaint

Intersection

A cell is a small drawing, usually of a frequently used or complex symbol, notation, or detail created in
MicroStation. To snap to the origin of a cell, set the Snap Mode to Origin. When the Snap Mode is not set to origin,
tentative points snap to component elements within the cell. For example, when the Snap Mode is Keypoint,

tentative points will snap to a keypoint on the line, not the origin of the cell.

Locate Tolerance

Preferences [design]

How close the pointer must be to an g::f:l
element in order to snap a tentative Descartes
point to it depends upon the Locate 'L”D"Dﬁ and Feel
Tolerance. Locate Tolerance is a user g"s:;i::hee'

Position Mapping
Raster Manager

preference that is adjustable in the

Input category of the Preferences Reference

. Spelli
dialog box (Workspace menu > Togs
Preferences). Tolerance values are 125 Nawgation

View Options - Civil

set in screen resolution (pixels). o oo
ew ons

Name for preferences | Default Preferences

Set Input Preferences.
/| Start in Parse All Mode 0K
Disable Drag Operations

Allow ESC key to stop cument command Cancel

Defaults

:

Locate Tolerance: | 10
loctemmemore{—__ |
Pointer Size: MNomal ¥
Pairter Type: Othogonal =] gonal
Click Sensitivity: MNomal ¥

Beset Pop-up Menu: | Press and Hold r

Hold Delay: Short 10 Long

Focus tem Description
For more options, click on the category list at left.
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Element Key Points

Key Points are regularly spaced points on an element to which a tentative point will snap when the Snap Mode (or
override) is set to Key Point. The number of key points on each segment of a linear element (line, line string, or
shape) is one greater than the Snap Lock Divisor setting. If Snap Lock Divisor is set to 2 (as in all seed files supplied
with MicroStation), key points are shown in the figure below. The midpoint of a linear element is a key point only if

the Snap Lock Divisor is an even number.
s /’/XN
Snap
| Snap Lock
[ it mnint
USTN
'l’:' oty Ck

Element keypoints (with Snap Lock Divisor set to 2 and the text element left bottom justified).
Clockwise from upper left: Arc, arc, line, line string, text, ellipse, and shape.

To enable snapping

1) From the Settings menu Locks submenu (or the pop-up Locks
Menu in the status bar) choose Full.
The Locks dialog box opens.

Divisor: | 2

Association Lock

2) Turn on Snap Lock.
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4.2 Using AccuSnap

AccuSnap provides tentative snap functionality, which may be used stand-alone or in combination with AccuDraw.

It provides graphical assistance — a “smart” pointer — for snapping to elements. This automates the tentative
snap process, virtually eliminating the need to press the tentative snap button, thus reducing the number of

“button presses” required during a design session. When in AccuSnap mode, you simply select a tool and move the
pointer over the elements, letting AccuSnap find and display the nearest tentative snap point for you. When the

correct snap point is displayed, you enter a data point to accept. If required you can adjust various AccuSnap
settings to configure AccuSnap for your mode of operation.

AccuSnap complements the standard, or manual, method of placing tentative points. That is, even with AccuSnap
enabled, you can still use the standard tentative snap method (pressing the tentative button). Additionally, when

you are using AccuSnap in conjunction with AccuDraw, you can use AccuDraw shortcuts, which include <HU> to

suspend AccuSnap for the current tool operation, and <HS> to toggle AccuSnap on and off. Alternatively, if the
elements are selected first and then the manipulation tool, you can press (and hold down) <Ctrl + Shift> to
temporarily toggle AccuSnap on or off, as required.

Turning AccuSnap On/Off

AccuSnap can be turned On or Off:

Button Bar
1) Access the AccuSnap Settings dialog box Mult-snaps
Nearest
o  Keypoint
Midpoint
Right click over the AccuSnap icon Center
Qrigin
Bisector
Intersection
Tangent
Snap Mode / = Tangent Paint
T ;5 Perp
f P bt z
e o X i -
Multi-snap 1
In the snap menu choose AccuSnap Mutti-snap 2
Multi-snap 3
Ly e
2) Inthe AccuSnap Settings dialog box M Accusnap Sett.. [= (B [

General gments

Enable AccuSnap

(Enable AccuSnap setting).

7] Display Snap lcons
Update Statusbar Coordinates
Play Sound On Snap
Hilite Active Blement

/| Identify Elements Automatically
Enable For Fence Create

7] Fopup Info  [Automatic_~

Delay {1/10sec): |5

3) Inthe Snap Mode button bar (clicking the Toggle AccuSnap button).

Snap Mode =

T
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4) By pressing and holding down the <CTRL + SHIFT> keys, which temporarily toggles AccuSnap on or off.
Releasing the <CTRL + SHIFT> keys returns AccuSnap to its previous setting

AccuSnap settings

AccuSnap works in conjunction with the current Snap Mode setting and, for the most part, is similar in operation
to the manual method of tentative snap points — minus the button presses. How close to an element or a
keypoint that the pointer must be, before AccuSnap finds it, is governed by the Locate Tolerance setting in the

Input category of the Preferences. dialog. These settings can be further refined by the following settings in the
AccuSnap Settings dialog's Feel tab:

Snap Tolerance — for locating elements.
Keypoint Sensitivity — for locating snap points

The Snap Mode setting still controls location of snap points on elements.

With both Show Tentative Hint, and Display Icon turned on.

Left: With the pointer within the snap tolerance of an element, AccuSnap shows a prospective snap point with a
crosshair (+) along with the current snap mode icon.

Right: When the pointer is within the Keypoint Sensitivity range, AccuSnap highlights the element and displays the
tentative snap point as a heavy weight “X”. A data point at this stage will be placed at the tentative snap point

location.

Settings in the AccuSnap Settings dialog box are divided into three tabbed sections — General, Elements, and Feel.

#AccuSnapSettlu. = || B[ ER

General ,m“?‘

Enable AccuSnap

7| Show Tentative Hint

/| Display Snap lcons
Update Statushar Coordinates
Play Sound On Snap
Hilite: Active Element

/| |dentify Elements Automatically
Enable For Fence Create

| Pop-up Info [Automatic_~
Delay (1/10sec) |5

General Settings

“AccuSnapSatti.u = | =2 [ &2

General ,m‘m

Enable AccuSnap
| Show Tertative Hint
/| Display Snap lcons
Update Statusbar Coordinates
Play Sound On Snap
Enable Accusnap Hilte Active Element
/| |dentify Elements Automatically
. . Enable For Fence Create
If on (default), AccuSnap is automatically enabled when you start 7] Popup Info  (Aufomatic =

MicroStation Delay (1/105ec): |5

Contains controls to enable/disable AccuSnap, and to define the way
it operates.
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Show Tentative Hint

If on, (default) and the pointer is within the range of the Snap Tolerance, AccuSnap displays the nearest snap point
with a cross hair.

Display Snap Icons

If on, (default) AccuSnap displays the icon of the current snap mode at the snap point.

Update Status bar Coordinates

If on, the coordinate readout in the status bar updates for each tentative snap point. That is, each time AccuSnap
snaps to a point on an element, or when you press the tentative snap button, the coordinates for the snap point
appear in the status bar.

Play Sound on Snap

If on, a sound is played when you snap to an element.

Highlight Active Element

If on, AccuSnap highlights the active element as soon as the pointer is within the range of the Snap Tolerance.
Identify Elements Automatically

If on, elements are identified automatically as you pass the pointer over them.

Enable for Fence Create

If on, AccuSnap is active when placing a fence.

Pop-up Info

If on, and you pause or hover the pointer over a highlighted element, a pop-up displays information about the
element. An option menu lets you define when this information appears.

Automatic — Pop-up information appears whenever you pause or hover the pointer over a highlighted
element.

Tentative — Pop-up information appears only when you manually snap a tentative point to an element
and then hold the pointer over any part of the highlighted element.

Element Settings
Controls in this group let you control whether or not AccuSnap snaps to Curves, Dimensions, Text, and/or Meshes.
When snapping is turned off for any of these, AccuSnap will not snap to the particular element, but it will display

an icon to show that the element is being ignored.

Even if snapping to an element is turned off in AccuSnap's settings, you can still snap to the element manually with
a tentative snap point.
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o

With Curves turned off, AccuSnap displays an icon to show that the B-spline curve is being ignored.
Feel Settings

Using the controls in the Feel group of the AccuSnap settings you can set AccuSnap's sensitivity when snapping to
elements, as follows:
1) Keypoint sensitivity — lets you adjust how close the screen pointer must be, to the snap point, before
AccuSnap snaps to it.
2) Stickiness — lets you adjust the sensitivity of AccuSnap to the current element. When you have snapped
to an element, as long as you move the pointer along that element, the snap system will have a
preference for that element over other elements that may have snap points closer to the pointer. The
further to the right (+) that you set the Stickiness slider, the further away from the element the pointer
may be before AccuSnap will snap to another element.
3) Snap Tolerance — lets you adjust how close the pointer must be to an element in order to snap a
tentative point to it.

4.3 AccuSnap and Snap Mode settings

AccuSnap enhances many of the standard snap mode settings by displaying and automatically snapping to the next
tentative snap point as you move the pointer over an element. With AccuSnap enabled, you very rarely need to
enter a tentative snap point manually. In the following examples, it is assumed that a tool has been selected and
that Show Tentative Hint and Display Snap Icon are enabled (the default settings).

Snapldad

Near Snap Point @ AlI A% 2 X d d B

When working with this snap mode, manually, you move the pointer to the position that you want the snap to be
located and then enter a tentative snap point, followed by a data point to accept the location. If the location is
incorrect, you move the pointer along the element and enter another tentative snap point.

With AccuSnap, as you move the pointer to the required element, it highlights and the proposed tentative snap
point marker displays. To position the “nearest” snap point, you simply move the pointer along the highlighted
element, until the required location is reached, and enter a data point.

To select a near snap point (with AccuSnap)

1) Select Near Snap Point mode
2) With AccuSnap enabled, move the pointer over the required element.
The element highlights, and AccuSnap displays the nearest tentative snap point.
3) Move the pointer, and tentative snap point, along the element to the required position.
4) Enter a data point to accept the tentative snap point.
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Snap Mod

A R At a i e o

Key Point Snap

When you move the pointer over an element in the design, AccuSnap displays the nearest keypoint snap with the
crosshair hint, or the tentative point marker if the pointer is within the Keypoint Sensitivity range. To select a
different keypoint, simply move the pointer to the required region of the element and AccuSnap will again show
you where the nearest keypoint is located.

To select a keypoint snap point (with AccuSnap)

1) Select KeyPoint Snap mode.

2) With AccuSnap enabled, move the pointer over the required element.
AccuSnap displays the nearest keypoint snap.

3) If necessary, using the tentative hint as a guide, move the pointer toward the required snap point until
the tentative snap point marker displays.

4) Enter a data point to accept the tentative snap point.

Snap Mode =
Mid Point Snap @»}__‘_ﬂ/ OF Wi datall B BO!

When you move the pointer over an element, AccuSnap displays the MidPoint Snap location with the crosshair
hint, or the tentative snap point marker if the pointer is within the Keypoint Sensitivity range of the midpoint.

To select the midpoint of an element (with AccuSnap)

1) Select MidPoint Snap mode.

2) Move the pointer over the required element.
AccuSnap displays the element's midpoint location.

3) If necessary, using the tentative hint as a guide, move the pointer toward the required snap point
until the tentative snap point marker displays.

4) Enter a data point to accept the tentative snap point.

Center Snap

Snap Mode b

] ~ 7 A@F @ X5 L L

When Center Snap is active, the pointer does not have to be close to the actual center point of the element,
whether it be a line string, curve, arc, or circle. As soon as you place the pointer over an element, AccuSnap
highlights the element and displays the tentative snap point marker at its center point.

To select the center point of an element (with AccuSnap)

1) Select Center Snap mode.

2) Move the pointer over the required element.
The element highlights and AccuSnap displays the tentative snap point marker at the center point of the
element.

3) Enter a data point to accept the tentative snap point.
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Snap Mode

]~ I~ G X L A

Origin Snap

When you create an element, the first point defined is its origin. With Snap Mode set to Origin Snap, as you move
the pointer over an element, AccuSnap displays its origin point location with the crosshair hint, or the tentative
snap point marker if the pointer is within the Keypoint Sensitivity range.

To select the origin point of an element (with AccuSnap)

1) Select Origin Snap mode.

2) Move the pointer over the required element.
AccuSnap displays the origin point of the element.

3) If necessary, using the tentative hint as a guide, move the pointer toward the required snap point until
the tentative snap point marker displays.

4) Enter a data point to accept the tentative snap point.

Snap Mode fx]

Bisector Snap @ N A SOR - .’J) ‘Halalll BrE O

As you move the pointer over an element, AccuSnap displays its bisector point location with the crosshair hint, or
the tentative snap point marker if the pointer is within the Keypoint Sensitivity range.

To select the bisector of an element (with AccuSnap)

1) Select Bisector Snap mode.

2) Move the pointer over the required element.
AccuSnap displays the bisector snap point of the element.

3) If necessary, using the tentative hint as a guide, move the pointer toward the required snap point until
the tentative snap point marker displays.

4) Enter a data point to accept the tentative snap point.

Intersect Snap Snap Mede

]~ 3 7@ % A XK d A

To select the intersection point of two elements requires you to identify both elements. AccuSnap lets you do this
by simply hovering over the intersection point of the two elements, without entering tentative snap points. When
the pointer is over the intersection point, the elements highlight one solid and one dashed, and the tentative point
marker displays at the intersection point. Where a number of elements intersect at a common point, you can move
the pointer until the correct pair of elements highlight.

To select the intersection point of two elements (with AccuSnap)

1) Select Intersect Snap mode.

2) Move the pointer to the intersection point of the two elements so that the two elements highlight and
the snap point marker appears.

3) Enter a data point to accept the tentative snap point.
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Snap Mode =)

Tangent Snap and Tangent Point Snap
BF] ~ 3 © % 2 4

(For AccuSnap, applies only when using the Place SmartLine tool) The Fixed Point for Perp. /Tan. From. setting in
the General tab of the AccuSnap settings determines whether Tangent Snap or Tangent Point Snap is used when
either snap is active.

When you are placing a SmartLine with either Tangent Snap, or Tangent Point Snap, as the active snap mode,
setting Fixed Point for Perp. /Tan. From to:

» On — sets the snap mode to Tangent Point Snap.
» Off — sets the snap mode to Tangent Snap.

Snap Mode

B
To use Tangent Snap with the Place SmartLine tool (with AccuSnap) I@ NI ACE Wi talall i

1) Inthe AccuSnap Settings dialog, General tab, turn off Fixed Point for Perp. /Tan. From.

2) Select either Tangent Snap, or Tangent Point Snap, as the active snap mode.

3) Move the pointer over the curved element, so that it is highlighted.

4) Enter a data point to accept the element.
As you move the pointer, the SmartLine segment is restricted to remaining at a tangent to the selected
curve.

Snap Mode

To use Tangent Point Snap with Place SmartLine tool (with AccuSnap) @ o @ “$‘ A X TS d

> [

1) Inthe AccuSnap Settings dialog, General tab, turn on Fixed Point for Perp. /Tan. From.
2) Select either Tangent Snap, or Tangent Point Snap, as the active snap mode.
3) Move the pointer over the curved element, so that it highlights and AccuSnap displays the tentative point.
4) Enter a data point to accept the tentative snap point.
The SmartLine segment is restricted to being at a tangent from the highlighted element, at the accepted
snap point.

Snap Mode

=
Perpendicular Snap and Perpendicular Snap Point @ I E ﬂ@ 2 X 7 .

(For AccuSnap, applies only when using the Place SmartLine tool) The Fixed Point for Perp. /Tan. From. setting in
the General tab of the AccuSnap settings determines whether Perpendicular Snap or Perpendicular Snap Point is
used when either snap is active.

When you are placing a SmartLine with Perpendicular Snap, or Perpendicular Snap Point, as the active snap mode,
setting Fixed Point for Perp. /Tan. From to:

On — sets the snap mode to Perpendicular Snap Point.
Off — sets the snap mode to Perpendicular Snap.
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Snap Mode

To use Perpendicular Snap with the Place SmartLine tool (AccuSnap)

=

APk 2 SataF1FS:]

1) Inthe AccuSnap Settings dialog, General tab, turn off Fixed Point for Perp. /Tan. From.

2) Select either Perpendicular Snap, or Perpendicular Snap Point, as the active snap mode.

3) Move the pointer over the element, so that it is highlighted.

4) Enter a data point to accept the element.
As you move the pointer, the SmartLine segment is restricted to remaining perpendicular to the selected
element.

Snap Mode

To use Perpendicular Snap Point with the Place Line tool (with AccuSnap)

R AOE I Satalr I |

1) Inthe AccuSnap Settings dialog, General tab, turn on Fixed Point for Perp. /Tan. From.

2) Select either Perpendicular Snap, or Perpendicular Snap Point, as the active snap mode.

3) Move the pointer over the element, so that it highlights, and AccuSnap displays the tentative point.
4) Enter a data point to accept the tentative snap point.

The SmartLine segment is restricted to being perpendicular to the highlighted element, from the accepted

shap point.

4.4 Using Tentative Points (middle mouse button)

Tentative points let you see where the next data point will be placed before you are committed. They also let you
define a data point relative to the tentative point. You can specify the distance from the tentative point using a
key-in or, better still, using AccuDraw and its input window. The exact location of tentative points, on elements,
are determined by the current Snap Mode, or snap override, setting.

You can enter tentative snap points manually, or you can turn on AccuSnap and let it display tentative points
interactively as you move the pointer over elements in a view. With AccuSnap active, when the Tentative Point
marker displays, you can enter a data point to accept it. Even when AccuSnap is active, you can enter a tentative
snap point manually, by pressing the Tentative button on your system's graphical input device.

To enter a tentative point (manually) to preview a data point

1) Select the required Snap Mode.

2) Position the pointer on the location at which you plan to enter a data point.

3) Press the Tentative button.
The tentative point coordinates are shown in the status bar. Large crosshairs are displayed. The
intersection of the lines in the crosshairs marks the location of the tentative point. If you snap to an
element, the element is highlighted.
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To accept a tentative point's location and enter a data point there

1) With the tentative point location displayed, and the pointer in any view, press the Data button.
2) Press the Data button.

When using AccuSnap, to snap to elements, only one button press is required. You let AccuSnap find and display
the tentative snap point.

Using AccuSnap to view a tentative point location and place a data point there

1) With AccuSnap active, select the required Snap Mode.

2) Move the pointer to the required element and then position the pointer so that the Tentative Point
marker (a heavy line weight “X”) displays.

3) Enter a data point to accept the tentative point and place the point.

To manually snap a tentative point to an element at a keypoint

1) Select the required Snap Mode.
2) Position the pointer on or near the desired keypoint.
3) Press the Tentative button.
If the tentative point successfully snaps to the element, the element is highlighted.

To snap a tentative point to an element when more than one element lies at the desired snap point

1) Enable snapping.

2) Position the pointer on or near the desired point.

3) Press the Tentative button.

Of the elements at the desired snap point, a tentative point will snap to the element that was placed in
the design earliest. That element is highlighted.

4) (Optional) If the desired element was not snapped to (highlighted), press the Tentative button again.
Of the remaining elements at the desired snap point (the ones to which a tentative point has not
snapped), a tentative point snaps to the element that was placed in the design earliest. That element is
highlighted.

5) (Optional) Repeat step 4 until the desired element is highlighted.
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MicroStation V8i — Working with AccuDraw
5.0 Working with AccuDraw

AccuDraw is a drafting aid that evaluates such parameters as your current pointer location, the previously entered
data point, the last coordinate directive, the current tool's needs, and any directive you have entered via shortcut

key-ins or AccuDraw options. AccuDraw then generates the appropriate precision coordinates and applies them to
the active tool.

]
Activating AccuDraw -__J-

By default, when MicroStation is started, AccuDraw is activated automatically. With AccuDraw activated, all
drawing tools utilize it for dynamic data input.

# AccuDraw EZ

M AccuDraw 23 # AccuDraw 3 % [0.0000
=1 [ 0.0000 X | 0.0000 Y [0.0000
t [ 0.0000 Y [0.0000 Z [ 0.0000

AccuDraw window: Left: Polar. Center: Rectangular 2d file. Right: Rectangular 3d file

.i_Jr

Primary Tools

D-E- 2@ i |

To toggle AccuDraw on/off

1) Inthe Primary Tools toolbox, select the Toggle AccuDraw. tool.
The AccuDraw window opens or closes.

Normally, the AccuDraw compass does not appear until you enter the first data point after selecting a tool.
AccuDraw's behavior changes slightly with tools that utilize dynamics before the first data point. The Place Text
and Place Active Cell tools are examples of such tools. Instead of “waiting” for the first data point to display the
compass, AccuDraw activates the compass at the last data point location. In this way, you can place the element
with respect to this location by using any of AccuDraw's relative directives.

AccuDraw also affects operations like placing text or cells in another way. When you place a string of text with
AccuDraw active, its initial orientation will be along the current AccuDraw drawing plane. In other words, when
you have a Front-oriented drawing plane, the text will be oriented along the front axis regardless of the view
orientation.

AccuDraw will not activate when it would conflict with other tools — for instance, during fence placement and
element selection operations, dimensioning, and so on.

Although most users will activate and use AccuDraw during the entire design session, there may be times when its

actions might interfere with the current operation. For this reason, AccuDraw can be turned off. MicroStation's
tools return to their non-AccuDraw operation.
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To deactivate AccuDraw

1) Inthe Primary Tools toolbox, select the Toggle AccuDraw. tool.
Or
With the focus in the AccuDraw window, press <Q>.

AccuDraw’s compass

AccuDraw's most recognizable feature is its compass. Visible only when AccuDraw is active and has control of
MicroStation's coordinate input, the compass acts as both a status indicator and a focus for your input.

AccuDraw compass. Left: Rectangular coordinate system. Right: polar coordinate system.
The origin point

At the center of the compass is AccuDraw's origin point. This is the focal point of all AccuDraw operations. As you
select various AccuDraw options, their functions operate from this origin point.

This last point is important. All AccuDraw directives (distance key-ins, shortcut key-ins, and so on) operate in
conjunction with the compass. In most cases, the compass is located at the last entered data point. In addition,
there are AccuDraw directives that allow you to move the compass to entirely different locations without
generating a new data point. This is not unlike a tentative point.

The frame (drawing plane indicator)

Surrounding the origin point is the frame, or drawing plane indicator. Its primary purpose is to show the current
orientation of AccuDraw's drawing plane and the current coordinate system in effect. When the frame appears as
a rectangle, the rectangular coordinate system (X, Y) is in effect. When the frame appears as a circle then the polar
coordinate system (Distance, Angle) is active. By default, when AccuDraw has focus, the frame's color is grey, and
its fill color is blue, but you can change this in the Display tab of the AccuDraw Settings dialog box.

To change the color of the AccuDraw frame

1) With AccuDraw active, open the AccuDraw Settings dialog by pressing <G> followed by <S> (Get Settings).
Or
Choose Settings > AccuDraw.

2) Inthe AccuDraw Settings dialog, click the Display tab.

3) From the Frame option menu, choose a new color (the button color indicates the current setting).

To change the color of the AccuDraw compass

1) With AccuDraw active, open the AccuDraw Settings dialog by pressing <G> followed by <S> (Get Settings).
Or
Choose Settings > AccuDraw.

2) Inthe AccuDraw Settings dialog, click the Display tab.

3) From the Fill option menu, choose a new color (the button color indicates the current setting).
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The X/Y axis

To differentiate between the two axes, each is color coded. By default, the positive or +X axis is displayed in red
while the positive or +Y axis is green in color. If these colors do not suit you or are hard to discern, you can change
them via the Display tab section of the AccuDraw Settings dialog. As well, you can change the highlight color for
when the pointer is indexed to the X or Y axes.

To change the colors of AccuDraw’s X and Y axis, or its indexing highlight

1) With AccuDraw active, open the AccuDraw Settings dialog by pressing <G> followed by <S> (Get Settings).
Or
Choose Settings > AccuDraw.
The AccuDraw Settings dialog opens.
2) Click the Display tab.
3) From the X Axis or Y Axis option menu, choose a new color (the button color indicates the current setting).
4) From the Hilite option menu, choose a new color (the button indicates the current setting).

AccuDraw’s drawing plane
AccuDraw's drawing plane is central to its operation. As you work, AccuDraw orients this drawing plane based on a
number of factors including cues from the active tool, the last placed coordinate, and key AccuDraw settings. This

is known as context sensitive operation.

The AccuDraw window

M AccuDraw 53 M AccuDraw = M AccuDraw £2
=1 | 0.0000 X [ 0.0000 X | 0.0000
™ | 0.0000 Y [0.0000 Y D000

Used to facilitate data point entry. The AccuDraw window opens or closes when you click the AccuDraw icon on
the Primary Tools toolbox. If you are using the default function key menu, pressing <F11> opens the AccuDraw
window. If it is already docked or open, pressing <F11> sends focus to the AccuDraw window.

Once opened, the AccuDraw window automatically takes the focus whenever dynamic update occurs with a
drawing tool selected. The AccuDraw window is dockable.

An option in AccuDraw is to use polar coordinates. To shift from rectangular to polar coordinates, first check that
focus is in the AccuDraw window, then press the <spacebar>. Repeated pressing of the <spacebar> toggles
between rectangular and polar coordinates. Rectangular or polar coordinates also can be set from the AccuDraw
settings dialog.

The fields in the AccuDraw window depend on the type of drawing plane coordinate system in effect:

Coordinates |Fields Used to specify
Rectangular XY, (Zin 3D) Distances along the drawing plane axes
Polar Distance, Angle, (Z in 3D) |Distances and angles relative to the drawing plane origin, and Z value in 3D.

The coordinate type is set with a keyboard shortcut (highlight AccuDraw and tap the space bar to toggle between
polar and rectangular mode).
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AccuDraw’s window and the input focus

The AccuDraw window initially comes up floating just like any other window. However, it can be docked to either
the top or bottom edge of the MicroStation application window.

When AccuDraw is active it becomes part of the input focus order controlled by the <Esc> key, initially, and others.
How focus is controlled depends on whether or not you have Use Position Mapping enabled (Workspace. >
Preferences > Position Mapping).

This is important to remember as no AccuDraw shortcut key-in works unless focus is in the AccuDraw window.

Fortunately, after every data point or tentative point, the focus is forced to the AccuDraw window where it
remains until you press the <Esc> key, or enter a Reset from a tool.

5.1 AccuDraw’s Settings dialog box

Many aspects of AccuDraw's behavior are specified using the controls in the AccuDraw Settings dialog. A few have
already been mentioned (such as context sensitivity, and axis display colors).

To open the AccuDraw Settings dialog box
1) From the Settings menu, choose AccuDraw.

Or
With the focus in the AccuDraw window, press <G>, <S>.

“ AccuDraw Settings EI =] @
Operation Digplay Coordinates
| Auto Load Auto Point Placement
| Foating Origin Sticky Z Lock
Context Sensitivity Always Show Compass
| Smart Key-ins V| Auto Focus Fields

Default Origin: [View center on active 2 =]

Operation Tab

Contains controls that are used to select preferences for operation and alter aspects of the way AccuDraw
performs.

Auto Load

If on (the default), AccuDraw starts up automatically when MicroStation is started.

Floating Origin

If on (the default), the origin moves to the last point placed.

Context Sensitivity

If on (the default), enables tools to provide “hints” to AccuDraw to override its default behavior for smoother

operation. This may include setting custom “Context” rotations, setting the origin, locking values, or setting the
coordinate system type.
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Smart Key-ins

If on (the default), AccuDraw interprets a number as positive or negative, depending on the direction of the
pointer from the compass.

In rectangular mode only, Smart Key-ins cause AccuDraw to move the focus to either the x or the y field depending
on pointer position.

Auto Point Placement

If on, places data points automatically when they have been fully constrained (if you have locked both the X and Y
values, or if you have locked one or the other while the pointer is indexed to zero). The default is off (this feature is
recommended for experienced users).

Sticky Z Lock

If on, when you lock the Z axis, it will remain locked through consecutive operations. Normally, locks are cleared
when you enter a data point. This setting is useful, for example, where you want to draw on the one plane (that is,
you want to lock Z=0), while snapping to elements that are on another plane. With Sticky Z Lock enabled, the Z
value will remain locked until you turn it off.

Always Show Compass

If on, when you activate AccuDraw, the compass displays prior to you placing a data point for the current
operation.

Auto Focus Fields

(Polar coordinates only) If on, the <A> and <D> AccuDraw shortcuts set focus to the selected field and lock the
current value.
If off, the <A> and <D> AccuDraw shortcuts lock the current value without affecting the focus.

Default Option

Lets you choose the default origin. When a tool starts AccuDraw and there is no origin currently defined, then this
setting specifies the default location of the AccuDraw drawing plane origin. Options are:

e View Center on active Z — Sets AccuDraw's origin to the center of the view, at the Active Z depth of the
view.

e  Global origin — Sets AccuDraw's origin to the Global Origin of the file.

e  Global origin on active Z — Sets AccuDraw's origin to the Global Origin (X, Y) at the Active Z depth of the
view.

Display Tab M AccuDraw Settings ===

. ) Operation Display Coordinates
Contains controls that control various

!

display features of AccuDraw. ians Delayed Update
filcas I—vl Display Coordinates
Hite: I—vl | Show Negative Angles
Frame: I—vl V| Pop-up Confimations
Fill: [ ——

Dialog Size: |Medium -
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X axis
Lets you select, via an option menu, the color for the positive X axis indicator on the AccuDraw compass.
Y axis
Lets you select, via an option menu, the color for the positive Y axis indicator on the AccuDraw compass.
Hilite
Lets you select, via an option menu, the color for the negative X and Y axis indicators on the AccuDraw compass.
Frame
Lets you select, via an option menu, the color for the AccuDraw compass frame.
Fill
Sets the fill color of the inside of the AccuDraw compass.
Dialog Size
Sets the width of the AccuDraw window.

e  Small — 100 pixels.

e Medium — 126 pixels.

e large — 152 pixels.
Delayed Update

If on, X/Y coordinates are updated in the AccuDraw window when the screen pointer comes to a rest. If off
(default), coordinates are updated in the AccuDraw window continuously, as you move the screen pointer.

Display Coordinates

If on, a coordinate display at the pointer shows the increments in the x, y, and z (for 3D) directions from the
previous data point.

Show Negative Angles

If on (default), AccuDraw displays negative angles (that is, +/-180°). If off, AccuDraw displays angles as 0° to 360°.
Pop-up Confirmation

If on (default), AccuDraw displays shortcut popups.

Shortcut Key-ins

Opens the AccuDraw Shortcuts window that lists AccuDraw shortcut keys.
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Coordinates Tab

Contains controls that are used set AccuDraw's Coordinate System, unit roundoff, and indexing functionality.

“AccuDrawSr:ttingz = || = JER

Ciperation Ciisplay Coordinates
Coordinate System Indexing
Potation: | View - V| feds
Type: |Rectangular = Distance

Tolerance | 10
Unit Roundoff

Distance: | 0.0000
Angle: | 0.0000°

Rotation

Sets the rotation of the drawing plane axes, via an option menu. While the AccuDraw window has the focus,
pressing the key combination indicated in parentheses has the same effect as choosing the specified Rotation.

Choosing Aligns drawing plane
Top (T) |with axes in a standard Top view

Front (F) |with axes in a standard Front view

Side (S) |with axes in a standard (Right) side view
View (V) |with View axes

Auxiliary |with Active ACS axes

Context

(RQ) as specified interactively, or as hinted by the current drawing tool

Unlike ACS rotation, context rotation is temporary, lasting only for the duration of the current drawing tool.
Type
Sets the method used in the AccuDraw window to specify distances and angles relative to the drawing plane origin.

Type Effect

The X and Y fields (plus, in 3D, the Z field), along with their lock controls, are displayed in the

Rectangular .
& AccuDraw window.

Polar The Distance and Angle fields, along with their lock controls, are displayed in the AccuDraw window.

While the AccuDraw window has the focus, pressing <space bar> toggles Type.

Distance
Sets the roundoff value for distances relative to the drawing plane origin. While the accompanying check box is on,
the roundoff value is effective, except if overridden by keyed in values or snapped tentative points. The check box

turns on automatically when the Distance setting is entered.

This setting does not affect keyed in values and snapped tentative points.
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Angle

Sets the roundoff value, in degrees, for angles relative to the drawing plane origin when in Polar mode. While the
accompanying check box is on, the roundoff value is effective except if overridden by keyed in values or snapped
tentative points. The check box turns on automatically when the Angle setting is entered.

This setting does not affect keyed in values and snapped tentative points

Axis

If on, indexing is activated for AccuDraw's drawing plane X and Y axes. The distance required to move the pointer
from the indexed axis is controlled by the Tolerance setting.

Distance

If on, sets the minimum distance that the pointer must move from the AccuDraw origin in order to place a new
data point. The minimum distance is controlled by the Tolerance setting.

Tolerance

Sets the minimum distance, in screen pixels, used by the Axis and Distance settings. Allowable values 1-99.

5.2 Controlling and Using AccuDraw

How AccuDraw reacts to pointer movement

When active, AccuDraw reacts to pointer movement by trying to anticipate your intent.

ﬁ AccuDraw 3 .H Acculraw 3 \
X [05451 - - X [-0.1592 B .
Y [0.1791 Y [ 04307

Moving the pointer (Rectangular coordinates). Left: Toward the x-axis; Right: Toward the y-axis.

As you move the pointer, the fields in the AccuDraw window automatically update to reflect the drawing plane
coordinates of the current pointer location (expressed as relative x, y, and z offsets, or as a distance and an angle)
with respect to the location of the AccuDraw compass.

Furthermore, the AccuDraw window's input focus automatically adjusts, based on the general direction of the

pointer movement. As you move the pointer in the same direction as either drawing plane axis the focus moves to
the field that you would use to precisely locate the data point along that axis.
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Previous Distance Recall

Another example of how AccuDraw tries to help you is its previous distance feature. As you place elements in your
model, AccuDraw keeps track of the distance between your last two data points. Known as the Previous Distance,
AccuDraw uses this distance as a hint for your next data point.

Think of previous distance as a radius length from the compass origin. When you move the pointer within the
Tolerance distance to this radius, AccuDraw displays a small tangent line called the previous distance indicator, and
locks the pointer to this point.

Previous distance indicator.

As you keep the pointer within the Tolerance distance of this previous distance, AccuDraw will keep it locked. This,
of course, only works with Polar coordinates. If you are using Rectangular coordinates, the previous distance only
works when you are indexed to either drawing plane axis.

A data point will result in an offset distance from your last data point precisely the same as the distance between
your previous two data points.

This “lock” on feature is not hard to override. Just continue dragging the pointer until it is outside the Tolerance
and the previous distance lock disengages.

Recalling previous values

AccuDraw stores all entered values for its X, Y, Distance, and Angle fields for recall as needed. When in the X, Y, (Z
in 3D), Distance, or Angle fields, pressing the <PgUp> key recalls the last distance or angle value entered in any of
these fields. Pressing <PgUp> again recalls the next to last entered value and so on. You should note that the X, Y,
Z, and Distance fields share a common value buffer but that Angular data is stored separately. This means you can
enter a value in the X field, for instance, change the input focus to Y, and by pressing <PgUp>, enter the same value
as placed in the X field.

A Simple Example of Using AccuDraw
To help you understand what AccuDraw does, the following is a description of a simple design session using

AccuDraw and the Place SmartLine tool. The task presented is the creation of a simple bracket. If a 3D file is used,
the Top view is assumed in the exercise.
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The design subject is a simple bracket with the important dimensions and features noted.

With AccuDraw activated (Toggle AccuDraw. tool in the Primary Tools toolbox), select the Place SmartLine. tool in
the Linear Elements toolbox. When you enter your first data point for the lower left corner of the bracket,
AccuDraw displays a square or circular shaped “compass.”

The AccuDraw compass appears whenever AccuDraw is active and a data point is placed

Next, you need to draw the left edge of the bracket. As you move the dynamic line around the view window
nothing interesting happens until you get close to one of the axes of the AccuDraw compass. In this case, because
you want a vertical edge, you should move the line close to the Y axis. When AccuDraw senses the axis, the line
snaps or .indexes. to it. While the axis is highlighted you can key in a number for the vertical distance, in this case, 2
inches. Don't worry about telling AccuDraw the direction, it has already figured that out and also has placed the
input focus (where the key-in data will appear) in the correct field, in this case the Y field. After keying in the
distance value, entering a data point results in what you would expect, a line segment oriented along the vertical
axis and exactly two inches long.

The start of the bracket's left edge with its 2 inch measurement courtesy of AccuDraw.

At this point the AccuDraw compass moves to the end point of the line you just placed. Moving the dynamic line
segment around, it acts as before. This time you need to place the line with a fixed length of 1.25 inches in the
horizontal direction. You do this by moving the dynamic line so that it snaps onto the positive horizontal axis, key
in 1.25, and enter a data point.
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The bracket's top edge is taking shape as the indexed line is placed along the horizontal axis

The next part of the bracket involves going off at a 30 degree angle for a given distance. Pressing the Space bar
changes the AccuDraw compass to its polar mode (indicated by a circular compass), which lets you enter an angle
and a distance. Entering 30 degrees in the Angle field and 1.75 inches in the Distance field locks the line in the right
direction. A data point accepts the new location.

The notch appears next with the Polar compass oriented along the new line.

Note how the compass orients along the 30 degree line. This illustrates AccuDraw's context sensitivity. AccuDraw
provides a method for associating coordinate information with respect to existing elements. To place the half inch

line at a right angle to the 30 degree line only requires indexing to the appropriate axis, keying-in 0.5 and entering
a data point to accept.

The notch is nearing completion.

With the bracket's notch complete, all that remains is the completion of the bracket's right edge. Currently,
however, the compass still is rotated to the 60 degree angle of the notch and not the horizontal direction you
need. To override the context nature of AccuDraw you press <T> to orient the compass to the Top view (the
default). Pressing the Space bar brings up the rectangular compass. Indexing, again, to the X axis and keying in 2
inches followed by a data point locks the final known dimension of the bracket.
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A quick press of the <T> key and AccuDraw orients itself to the screen's x and y axes.

To “close out” the bracket's bottom edge, you use the smart axis locking feature of AccuDraw. Moving the pointer
down the Y axis you press <Enter> for the smart lock feature. Recognizing that you are indexed along the Y axis,
AccuDraw locks the Y direction but allows you to move up and down this axis. A tentative point on the beginning
point of the bracket (the Place SmartLine tool allows you to snap to an element under construction) followed by a
data point locates the lower right corner of the bracket. A final tentative point and data point on the origin of the
bracket completes the job.

A tentative point on the origin of the bracket results in the dashed index line.

Accepting the tentative point completes the construction.

5.3 AccuDraw and the Popup Calculator

With the pop-up calculator, you can perform mathematical operations on the values displayed in some
MicroStation text fields and the values adjust accordingly.

This feature is documented here as it works with AccuDraw. In fact, its use is extendable to other controls. For
example, Active Scale and Active Angle fields currently support it.

The pop-up calculator is supported as follows:

1) With the input focus in a field that supports pop-up calculation, type any of the following:
+ -, %/, =

2) Type avalue or expression to complete the calculation.
Press <Enter>, enter a data point, or click outside the pop-up calculator to accept the calculated value.
Press <Esc> if you want to reject the value.

.“ Acculraw 2
X[ 27.0000 ;
27 — &= H
k|
3.0000 !

Generating a calculated value (by typing “27/9”)
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5.4 AccuDraw’s shortcut key-ins

Although AccuDraw tries to anticipate your next move it cannot always predict your intentions. AccuDraw
therefore includes a wide variety of single and double character command directives known as the shortcut key-
ins. By pressing the appropriate key, you can direct AccuDraw to perform a specific task. In operation, AccuDraw is
the default input focus in most cases, thus letting you just type in the shortcut without having to consider where
the input focus is.

M AccuDraw 3]

X BEE=

Y T Top Rotation

Pop-ups confirm single letter shortcuts below the focused input field. This function is not only useful to confirm the
key-in, but also it serves to communicate that the shortcut is received via AccuDraw's input fields.

# AccuDraw 3

RQ Riotate Quick -
RA Rotate ACS

RC Rotate to Curert AC |E
RE Rotate Element

RV Rotate View &

Two letter shortcuts appear attached to the focused input field, and confirm the action through the temporary
appearance of the AccuDraw Shortcuts window. The pop-down list adjacent to the input field illustrates where the
shortcut comes from, thereby making it easy to “follow the action.”

The following is a list of the more common shortcut key-ins:

Key Effect
<?> Opens the AccuDraw Shortcuts window.

Smart Lock
e In Rectangular coordinates, locks X to O if the pointer is on the
drawing plane y-axis or Y to 0 if the pointer is on the x-axis.

<Enter> . o an° o o
e In Polar coordinates, locks Angle to 0°, 90°, -90°, or 180° if the
pointer is on a drawing plane axis or otherwise locks Distance
to its last entered value.
<space
ba$> Switches between Rectangular and Polar coordinates.
Moves the drawing plane origin to the current pointer position. This
<0> can also be used to explicitly activate AccuDraw before you enter a
data point.
<X> Toggles the lock status for the X value.
<Y> Toggles the lock status for the Y value.
<D> Toggles the lock status for the Distance value.
<A> Toggles the lock status for the Angle value.
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1) Within the focus of the AccuDraw window, press the <?> key. X Lok
The AccuDraw Shortcuts window opens. R
i
wa
General Procedure - To activate a shortcut key-in RA  Rotate ACS
RC Rotate to Cument ACS
RE Rotate Element
E{V I?ot?t Mew
1) With the focus in the AccuDraw window, simply press the keyboard -
key(s) that correspond(s) to the shortcut you wish to use. 6T o Tod S
If the first letter is, by itself, a valid shortcut, the shortcut activates. s oo e
GA Get ACS
Otherwise, the AccuDraw Shortcuts window opens. The window lists W eeors
i in (single;
the available shortcuts. Typing the second letter activates the " per e k)
shortcut. oo
K Snap Divisor
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M AccuDraw Shortcuts [ 23

Enter  Smart Lock
Space Change Mode
(o] Set Origin

T Top Rotation

Rotation

HA AccuDraw on Hold
HS AccuSnap Toggle
HU  AccuSnap Suspend
Q Quit AccuDraw

Bun Edit... DNew..

Complete List of AccuDraw Shortcut Key-ins

Key

<Enter>

<Space
bar>

<0>

<\V>

<T>

<F>

<S>

<B>

<E>

<X>
<Y>

<Z>

Effect

Smart Lock

In Rectangular coordinates, locks X to 0 if the pointer is on the drawing plane y-axis or Y to O if the
pointer is on the x-axis.

In Polar coordinates, locks Angle to 0°, 90°, -90°, or 180° if the pointer is on a drawing plane axis or
otherwise locks Distance to its last entered value.

Switches between Rectangular and Polar coordinates.

Moves the drawing plane origin to the current pointer position.

Rotates the drawing plane to align with the view axes. Pressing this key a second time restores context-
sensitive rotation.

Rotates the drawing plane to align with the axes in a standard Top view. Pressing this key a second time
restores context-sensitive rotation.

Rotates the drawing plane to align with the axes in a standard Front view. Pressing this key a second
time restores context-sensitive rotation.

Rotates the drawing plane to align with the axes in a standard Side view. Pressing this key a second time
restores context-sensitive rotation.

Rotates the drawing plane to align with the active ACS, or if you set up a rotation in the dialog, it will
return you to that rotation. In a new file (where you haven't used an ACS yet) it will be the rotation of
the view.

Rotates between three main planes: top, front, and side (3D only). This also works when your original
plane is an ACS or context rotation, so you do not have to use RX, RY to rotate to a 90° plane.

Toggles the lock status for the X value.
Toggles the lock status for the Y value.

Toggles the lock status for the Z value.
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<D>

<A>

<L>,<I>

<L>,<P>

<L>,<A>

<L>,<S>

<L>,<Z>

<R>,<Q>

<R>,<A>

<R>,<C>
<R>,<E>
<R>,<V>
<R>,<X>
<R>,<Y>
<R><Z>

<?>

<G>,<T>
<G>,<K>
<G>,<S>
<G>,<A>
<W> <A>
<pP>

<M>

<I>

<N>

<C>

<K>

<H>,<A>
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Toggles the lock status for the Distance value.
Toggles the lock status for the Angle value.

Locks the current index state. If an axis or distance is not indexed, indexing is disabled. If an axis or
distance is indexed, it is locked. The effect is temporary, lasting until a data point is entered or the
shortcut is run again. This is useful if you need to index to one axis but not the other, or to enter a data
point very close to an axis but not on the axis.

Toggles ACS Grid Plane lock, which toggles the ACS Plane and ACS Plane Snap locks, and the Grid view
attribute for all views.

Toggles ACS Plane lock.
Toggles ACS Plane snap lock.

Toggles Sticky Z Lock, which is used in conjunction with ACS Plane Snap Lock to force a series of snap
points to lie on the active ACS' XY plane (Z=0).

Used to quickly and temporarily rotate the drawing plane. The procedure is described in The Rotate
Quick keyboard shortcut.

Used to permanently rotate the drawing plane. Because it rotates the current ACS, this rotation will still
be active after the tool in use is exited. If on, the tool setting Use Current Origin causes the drawing
plane origin to be used as the x-axis origin, thereby eliminating the need to enter an extra data point. Of
course, in many cases it is desirable to be able to define the x-axis origin at a different location than the
drawing plane origin.

Rotates the drawing plane to the current ACS.

Rotates the drawing plane to match the orientation of a selected element.
Rotates the active view to match the current drawing plane.

Rotates the drawing plane 90° about its x-axis.

Rotates the drawing plane 90° about its y-axis.

Rotates the drawing plane 90° about its z-axis.

Opens the AccuDraw Shortcuts window.

Bumps an item in the tool settings dialog (shortcut is ~, usually right under the <Esc> key — there is no
need to press the <Shift> key). It finds the first enabled item in the tool settings dialog that is a toggle
button or an option button, and either toggles it or bumps it to the next valid value. For instance, if you
are drawing a SmartLine and the focus is in the AccuDraw window, you can just press the <~> key and it
switches to arcs without moving the focus from the AccuDraw window.

Moves focus to the Tool Settings window.

Opens (or moves focus to) the Key-in window (same as choosing Utilities > Key-in).

Opens (or moves focus to) the AccuDraw Settings dialog (same as choosing Settings > AccuDraw).
Opens the Get ACS dialog, which lets you select a saved Auxiliary Coordinate System.

Opens the Write to ACS dialog, which lets you save the drawing plane alignment as an ACS.
Opens the Data Point Key-in dialog for entering a single data point.

Opens the Data Point Key-in dialog for entering multiple data points.

Activates Intersect snap mode.

Activates Nearest snap mode.

Activates Center snap mode.

Opens the Keypoint Snap Divisor dialog, which is used to set the Snap Divisor for keypoint snapping.

Suspends AccuDraw for the current tool operation. Selecting a new tool or entering a Reset re-enables
AccuDraw.
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<H>,<S> |Toggles AccuSnap on/off.

Suspends AccuSnap for the current tool operation. Selecting a new tool or entering a Reset re-enables

<H><U>
AccuSnap.

<Q> Deactivates AccuDraw.

Keyboard shortcuts are not case sensitive.

5.5 Smart Lock

One of the first keyboard shortcuts you will use is Smart Lock. Similar in operation to striking a line along a T-
square, Smart Lock is invoked by pressing the <Enter> key. Depending on where the pointer is located, at the time
you select Smart Lock, one of two things will occur:

e If the pointer is oriented closer to the X axis of the compass, the pointer will lock to the X axis.
e If the pointer is oriented closer to the Y axis of the compass, the pointer will lock to the Y axis.

You know the pointer is locked on an axis when the dynamic line highlights. Pressing the <Enter> key again
deactivates Smart Lock and releases the dynamic line back to free motion.

To constrain the pending data point to a drawing plane axis

1) Position the pointer near the desired axis. When the pointer is on an axis, a highlighted line is displayed
from the drawing plane origin to the pointer location.

— -—

Positioning the pointer on a drawing plane axis — Left: on the x-axis. Right: on the y-axis

2) Press the <Enter> key.
Smart Lock is engaged. Its effect is to constrain the pending data point to the axis.

M AccuDraw @
X | 0.0000
Y

Constraining the data point along the x-axis (left) and the y-axis (right)
You now can constrain the pending data point to a precise distance along the axis by keying in a value, or simply by
snapping a tentative point to an element or monument point and accepting the tentative point as the data point

location.

To disengage Smart Lock and unconstrain the pending data point, press <Enter> again. The <Enter> key toggles
Smart Lock.
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Snapping to constrain the pending data point to a precise distance along the x-axis.

Smart Lock will not lock to an axis when you are entering coordinate values into its field. Instead, AccuDraw
returns the dynamic element to free motion.

Xand Y locks

When using the Rectangular coordinate system, you can force AccuDraw to lock the current distance along an axis
by activating the <X> or <Y> keyboard shortcut. AccuDraw responds by locking the dynamic line to the chosen axis
at the current pointer distance from the origin point of the compass. Having done this, the focus of the
complement AccuDraw axis data field becomes the focus for your next keyboard entry.

» AccuDraw automatically switches its coordinate system to rectangular in response to the X or Y lock.
» All Xand Y values entered are relative to the plane of the previous element segment.

» To override this, AccuDraw provides an option in its settings called Context Sensitivity. Turning this off
forces AccuDraw to stay oriented to the DGN file's XY axes

Distance lock

You can use the <D> shortcut to lock the distance from the compass origin point to the current location of the
pointer and, if necessary, change AccuDraw's coordinate system to Polar. The input focus automatically shifts to
the Angle field.

To interactively enter the distance of the dynamic element
1) Inthe AccuDraw window's Distance field (Polar coordinates), type the distance.
The pending data point is constrained automatically, as indicated by the pressed Distance button.
Dynamic update occurs in response to each keystroke.
Alternative Method - To interactively enter the distance of the dynamic element
1) Move the pointer away from the drawing plane origin until the desired distance is displayed in the
AccuDraw window's Distance field. As the pointer is moved, the displayed distance is rounded off to the

increment specified by the Unit Roundoff's Distance setting (if the setting is turned on) in the Coordinates
tab section of the AccuDraw Settings dialog.

2) Press the <D> key.

Angle lock

You can use the <A> shortcut to set the angle portion of the polar drawing plane and, if necessary, change
AccuDraw's coordinate system to Polar. AccuDraw sets the angle to the current position of the pointer.
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To interactively lock the angle of a dynamic element
1) Inthe AccuDraw window's Angle field (Polar coordinates), type the angle, in degrees.
The pending data point is constrained automatically, as indicated by the pressed Angle button. Dynamic
update occurs in response to each keystroke.
Alternative Method — To interactively lock the angle of a dynamic element
1) Move the pointer around the drawing plane origin until the desired angle is displayed in the AccuDraw
window's Angle field. As the pointer is moved, the displayed angle is rounded off to the increment

specified by the Unit Roundoff's Angle setting (if the setting is turned on) in the Coordinates tab section of
the AccuDraw Settings dialog.

2) Press the <A> key.

» The Angle value automatically switches to the “opposite” angle if the pointer position dictates.

AccuDraw [g]

NZ [

Angle value automatically switches to the “opposite” value.

Angle value automatically switches to the “opposite” value.

5.6 Unit roundoffs and their effect on AccuDraw

Distance Roundoff

When you enable the Distance field in Unit Roundoff, AccuDraw acts as if there is an invisible grid in effect. The
Distance Roundoff, however, always is calculated from the current compass location. In addition, at any time you
can override this value by snapping to an element, or entering a value in the X, Y, Z, or Distance fields of the
AccuDraw window.
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To round off the values displayed in AccuDraw’s X, Y, Z and Distance fields as the pointer moves

1) Inthe AccuDraw Settings dialog, click the Coordinates tab.
2) Inthe Unit Roundoff section, turn on Distance.
3) Inthe Distance field, key in the desired increment.

To cancel distance roundoff

1) Inthe AccuDraw Settings dialog, click the Coordinates tab.
2) Inthe Unit Roundoff section, turn off Distance.

Angle roundoff

You can use the Angle Unit Roundoff to lock elements along specific axes. For instance, setting the Angle Roundoff
to 30 degrees assures that all elements placed will occur along one of the normal isometric drawing axes. As with
the X, Y, Z, or Distance fields, at any time you can override this value by snapping to an element, or entering a
value in the Angle field of the AccuDraw window.

71| 0.4715

Z | 0.0000

Drawing in progress showing AccuDraw window with angle locked to 30 degrees
To round off the values displayed in the AccuDraw’s Angle field as the pointer moves
1) Inthe AccuDraw Settings dialog, click the Coordinates tab.
2) Inthe Unit Roundoff section, turn on Angle.
3) Inthe Angle field, key in the desired increment in degrees.

To cancel angle roundoff

1) Inthe AccuDraw Settings dialog, click the Coordinates tab.
2) In the Unit Roundoff section, turn off Angle.

5.7 Moving the AccuDraw Compass

By default, AccuDraw places its compass at the last data point location. There are, however, times when you need
to take over control of the AccuDraw compass. Tentative point operations can take better advantage of
AccuDraw's capabilities when you “unlock” the compass and place it wherever needed. The following covers how
you do this and some interesting ways in which you can use AccuDraw to accomplish otherwise difficult
operations.
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The floating origin option

At any time, you can move AccuDraw's compass to the pointer location. You do this with the “O” keyboard
shortcut, which forces AccuDraw to move the compass to the current pointer location.

This occurs regardless of the tool or operation currently selected. This last point is important to recognize.
AccuDraw is considered a non-modal feature in that you don't have to be in a predetermined part of a procedure
in order for it to operate.

In practice, the most common use for a relocated compass origin point is to index the element under construction
from an existing point. For instance, if you want to locate the corner of a block a specified distance from a given
location, you can tentative snap to the given location, then press O to move the drawing plane origin to the snap.
From there you can use AccuDraw to position the tentative point from this relocated origin point. This procedure is
explained in AccuDraw and the tentative point.

Rotating the drawing plane in 2D

Along with the standard drawing plane orientations, the rotation of the drawing plane axes can be altered using
keyboard shortcuts. In 2D, you are limited to rotating AccuDraw's drawing plane about the view axis. This matches
the same restriction placed on rotating views in 2D.

Rotation sensitive tools

Depending on the tool in use, dynamically rotating the drawing plane axes yields slightly different results. For
example, consider the scenario of placing a block (rectangle) with the Place Block (Orthogonal) tool, which takes its
orientation from the drawing plane XY axes.

Once the drawing plane axes are rotated, the block's main axis is constrained to the rotated XY axis.

Contrast this to the effect when using the Place Line tool: The drawing plane axes rotate, and while dynamic
readout is a function of the newly rotated system, the tool itself remains available to dynamically place the line
wherever desired.

The Rotate Quick shortcut key-in

You can use the Rotate Quick (<R>, <Q>) shortcut to change the orientation of the drawing plane only for the
current data point, after which it resumes its normal orientation. This will vary, depending on the tool being used.

To quickly rotate the drawing plane axes
For example, suppose you are using the Place Line tool to start a construction and wish to align the drawing plane

axes with the new line. After establishing the drawing plane origin (with the first data point of the line), pressing
<R>, <Q> lets you rotate the drawing plane axes interactively

Dyrnamically rotating the drawing plane axes. Placing the line.
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MicroStation V8i — Element Selection

6.0 Element Selection Tool Box

Selection tool bar

The Selection tool bar contains tools for selecting elements

Element Selection — Selects and deselects elements on a per element basis, by defining an area, by
drawing a line that intersects them, or by individually selecting them.

Fence Tool — This tool allows the selection of elements by placing a block around the geometry. This tool
also allows an alternative plotting method.

Delete Fence Tool — This tool will delete elements depending on the mode selected.

6.1 Element Selection Tool

I.W'_I-_.r‘:__)/ &)
Fe-ae § .

Used to select and deselect elements for modification or manipulation. The set of selected elements is
called the selection set.

While the Element Selection. tool is selected, the pointer becomes an arrowhead with an aperture
encircling the tip. The aperture denotes the design plane area in which MicroStation searches for
elements. The aperture size or Locate Tolerance is a user preference that is adjustable in the Preferences
dialog.

» To select a shape, the pointer must be close to one of the enclosing lines. To select a circle or an
ellipse, the pointer must be close to the circumference or center. A filled element can be selected
by its interior or surface, which is set in the Locate Interiors option menu of the Preferences
dialog Input category.

» If Level Lock is on, you can only select elements on the active level.

Tool Settings Effect

Sets the selection method. The method works in conjunction with the Mode setting. The
Method settings allow you to select individual elements or drag to select elements with a
dynamic rectangle, block, shape, circle, or line. Use a left-right direction for inside selection
and a right-left direction for overlap selection. The line style for the dynamic
rectangle/block/shape/circle changes from a solid line (inside) to a dashed line (overlap). A
tap of the <Shift> key while dragging/defining points will invert the current inside/overlap
direction.

» Individual — Lets you select individual elements graphically. To select additional

elements:

0 (when mode is set to New) Hold the <Ctrl> key, and then click on the elements.

0 (when mode is set to Add) Click on the elements.

O (when mode is set to New or Add) Click in the view window, then drag to select

Method
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Mode

Disable
Handles

>

MicroStation V8i — Element Selection

elements with a dynamic rectangle.

If you double-click an existing text element with the Element Selection pointer,
the Edit Text tool activates and the Text Editor window opens.

If you double-click an existing tag element with the Element Selection pointer, the
Edit Tags dialog opens.

If you double-click an existing flag with the Element Selection pointer, the
Show/Edit Flag tool activates and the Define Flag Information dialog opens.

If you double-click a blank area of a view, the selection mode toggles between
Block and Individual.

Block — When set to inside selection, all elements inside the block are selected.
When set to overlap selection, all elements inside or overlapping the block are
selected.

Shape — When set to inside selection, all elements inside the shape are selected.
When set to overlap selection, all elements inside or overlapping the shape are
selected.

Circle — When set to inside selection, all elements inside the circle are selected.
When set to overlap selection, all elements inside or overlapping the circle are

selected.

Line — Lets you select elements by defining a line that intersects them.

Sets the objective of using the tool. The Mode works in conjunction with the Method

setting.

New — Clears the current selection set and starts a new selection set.

>

>

Add — Adds elements to the selection set.

Subtract — Removes elements from the selection set.

Invert — Toggles the selection status of an element (selects deselected elements
and deselects selected elements).

Clear/Select All — Deselects all selected elements if element handles are not
visible. If handles are visible and selected (orange), selecting the Clear mode
deselects the handles (blue). Selects all elements if no elements are currently
selected.

If on, handles are not displayed for selected elements.

With the Individual method plus New mode, element handles are displayed by default if
you select a single element or multiple elements using <Ctrl-click>. Element handles are
not displayed when you select multiple elements by dragging a rectangle or with another
selection method (Block, Shape, Circle, or Line).
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MicroStation V8i — Element Selection

If on, the Block/Shape/Circle/Line selection methods and the Add/Subtract/Invert/Clear
selection modes apply to selecting handles rather than elements. (To use this icon, Disable
Handles must be off.)

Select
Handles

To select a single element
1) Select the Element Selection tool.
1) Inthe tool settings window, select the following icons: Method - Individual, and Mode - New.

2) Click the element you want to select.
The selected element is bracketed with handles.

To select one or more elements with the individual method
1) Select the Element Selection tool.
2) Inthe tool settings window, select these icons: Method - Individual, and Mode - New.
3) Drag around the area containing the elements you want to select. As you drag, a dynamic
rectangle outlines the area. Use a left-right direction for inside selection and a right-left direction
for overlap selection.

4) (Optional) Tap the <Shift> key while dragging to invert the current inside/overlap direction.

5) Release the Data button.
All elements that are inside (or overlapping) the rectangle are selected.

To select additional elements with the individual method
1) Select the Element Selection tool.
2) Inthe tool settings window, select these icons: Method - Individual, and Mode - New.
3) Hold the <Ctrl> key, and click on the elements to select.
To select all elements in the active model
» From the Reset pop-up menu, choose Select All.
Or
Choose Edit > Select All (or press <ctrl-A>).
Or
In the status bar, click the element selection indicator field, and choose Select All from the pop-
up menu.
Note: Elements in references cannot be selected with this method.

Alternative Method — To select all elements in the active model

1) Select the Element Selection tool.
2) Inthe tool settings window, select Mode — Select All.

Note: Elements in references cannot be selected with this mode.
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To select elements inside or overlapping a rectangular area

1)
2)

3)

6)

Select the Element Selection tool.
In the tool settings window, select the following icons: Method - Block, and Mode - Add (+).

Enter a data point to define the first corner of the block. Use a left-right direction for inside
selection and a right-left direction for overlap selection.

(Optional) Tap the <Shift> key while dragging to invert the current inside/overlap direction.

Move the pointer until the dynamically displayed block contains or overlaps the elements you
want to select.

Enter a second data point to close the block.

To select elements contained in or overlapping a polygonal area

1)

6)

Select the Element Selection tool.
In the tool settings window, select the following icons: Method - Shape, and Mode - Add (+).

Enter a data point to define the first vertex of the polygonal shape. Use a left-right direction for
inside selection and a right-left direction for overlap selection.

(Optional) Tap the <Shift> key while defining points to invert the current inside/overlap direction.

Continue entering data points until the polygonal shape contains or overlaps the elements you
want to select.

Enter a final data point to close the polygonal shape.

To select elements contained in or overlapping a circle

1)

Select the Element Selection tool.
In the tool settings window, select the following icons: Method - Circle, and Mode - Add (+).

Enter a data point to define the center of the circle. Use a left-right direction for inside selection
and a right-left direction for overlap selection.

(Optional) Tap the <Shift> key while dragging to invert the current inside/overlap direction.

Enter a second data point to complete the circle.
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To select elements that intersect a line
1) Select the Element Selection tool.

2) Inthe tool settings window, select the following icons: Method - Line, and Mode - Add (+).

$ 0o O/ @&
FEe=a9 [ |

3) Enter a data point to begin the line.

4) Enter a data point to end the line.
All elements touched by the line are selected.

To deselect an element
1) Select the Element Selection tool.
2) In the tool settings window, select the following icons: Method - Individual, and Mode - New.
3) <Ctrl-click> the element to deselect.

To deselect all elements

1) From the Reset pop-up menu, choose Select None.
Or
Choose Edit > Select None.
Or
In the status bar, click the element selection indicator field, and choose Select None from the
pop-up menu.
Alternative Method — To deselect all elements
1) Select the Element Selection tool.
2) Inthe tool settings window, select Mode — Clear.
To restore the previous selection set

1) From the Reset pop-up menu, choose Select Previous.

Note: If any currently selected elements were not in the previous selection set, choosing Select
Previous will cause those elements to be deselected.
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6.2 Place Fence Tool

Used to place a fence.

1ol x| 5
: -| b Block
Fence Mode: Inside VI ry Fence Mode: Shape ry
T ———— Cicle —
X d © 3 Bement
From Wiew
Name | Description el Name From File
From Flood

Tool Settings

Tool Settings Effect

When the Fence Type is:
e Block, Shape, or Circle — Sets the geometric characteristics of a fence for graphical
placement.

e Element — Lets you create a fence by selecting an element. Elements that can be
used for a fence include closed planar elements (shapes, circles, ellipses, complex
shapes, and grouped holes), any solid (other than spheres or feature solids) or
closed extrusion, or cylinders. If a planar element is used in a 3D file, then the
volume is applied by sweeping the planar region through the entire model.

e From View — Sets a fence to include the contents of the selected view.
Fence Type e From File — Sets a fence to include the contents of a DGN file. An option menu lets
you choose from:
0 Active — elements in the active model from a selected view.
0 All — elements in the active model and its references, from a selected
view.
0 Choose — elements from a selected reference (or the active model),
which you identify by identifying an element from the required
model/reference.

® From Flood — Sets a fence to include the (minimum) area enclosed by a set of
elements.

Sets the Fence (Selection) Mode that, in conjunction with the fence placement, defines the

Fence Mode . .
fence contents for manipulation.
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The Fence (Selection) Mode determines just what constitutes the contents of a fence — that is, whether
the elements (or parts of elements) inside, outside, or overlapping the fence are “contained” by the fence
to be processed.

e Inside — Only those elements completely inside the fence are processed.

e  Overlap — Only those elements inside or overlapping the fence are processed.

e Clip — Only elements completely inside the fence and parts of elements inside and overlapping
the fence are processed.

e Void — Only those elements completely outside the fence are processed.
e Void-Overlap — Only those elements outside or overlapping the fence are processed.

e Void-Clip — Only elements completely outside the fence and parts of elements outside and
overlapping the fence are processed.

Fence selection modes. Top, the fence and elements
Center Left: Inside; Center Middle: Overlap; Center Right: Clip

Bottom Left: Void; Bottom Middle: Void-Overlap; Bottom Right: Void-Clip

(i
Fence Type: Block hd
F Inside A

Qverap
Clip

Void

MName Void-Overap

Void-Clip
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To place a rectangular fence

1) Select the Place Fence tool. - ;

|

v |

If a fence already exists, it is removed. i ;
|

|

2) Inthe Tool Settings window, set Fence Type to Block. o ><2
3) Enter a data point to define one corner. Place Fence with Fence
Type set to Block

4) Enter a data point to define the diagonally opposite corner.
Alternative Method — To place a rectangular fence

1) Select the Place Fence tool.
If a fence already exists, it is removed.

2) Inthe Tool Settings window, set Fence Type to Block.

3) Click and drag the pointer from the first corner to the diagonally opposite corner.

7{><‘"“"~--=..HH 6

To place a polygonal (non-rectangular) fence r ><
8 f"/ L‘ 4
1) Select the Place Fence tool. . 5><=~=><

If a fence already exists, it is removed. 1 y
2) Inthe Tool Settings window, set Fence Type to Shape. ><-—--—--—--—--—--—--—><
3) Enter a data point to define the beginning (and end) point.

Place fence, with Fence
Type set to shape

4) Continue to enter data points to define the vertices.
5) To close the shape, enter a data point at the location of the first data point.

Or

Click the Close Fence button.

To place a circular fence

1) Select the Place Fence tool.
If a fence already exists, it is removed.

2) Inthe Tool Settings window, set Fence Type to Circle.
3) Enter a data point to define the center.

4) Enter a data point to define the radius.
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To place a fence using an element

1) Select the Place Fence tool.
If a fence already exists, it is removed.

2) Inthe Tool Settings window, set Fence Type to Element.
3) Identify a shape element that is the same shape as the fence shape you want to place.
4) Enter a data point to accept the element. A fence is placed.

Note: Selecting Place Fence automatically disables AccuDraw if it was not already disabled. To activate
AccuDraw for use with Place Fence, select the Toggle AccuDraw tool in the Primary Tools toolbox.

If, after placing a fence but before selecting another tool, you decide the fence placement is
unsatisfactory, simply reset to begin re-placing it.

6.3 Delete Fence Contents Tool

Used to delete the fence contents, which are defined by a fence and the Fence (Selection) Mode, which
determines what constitutes the contents of a fence.

Fence Mode: Inside -|

To delete a fence’s contents
1) Select the Delete Fence Contents tool.

2) Accept the deletion.
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6.4 Select By Attributes

When you use the Element Selection tool, you can select, or group, the elements by a variety of means,
including by:

Level

Color

Line Style
Line Weight
Type

Class
Template

VVYVVYVY

For example, you can request MicroStation to select all text elements or all elements with line weight 3.
You can even specify search criteria based on different kinds of attributes — for example, green, dotted
arc elements on level 12 and level 16.

By default, selected elements are bracketed with squares called handles. If any elements are selected, an
arrowhead icon is displayed in the status bar. The number to the right of the icon is the number of
selected elements.

The Select By Attributes dialog (Edit > Select By Attributes) provides additional attribute-based element
selection options — selection by attached tag values and by properties. Properties include the area
attribute, whether an element can be snapped to, whether it is locked, and whether it has been modified.

i

Tools Settings
r Levels

Common-Notes
Level 12

Level 16
Foadway-Berm line
Typical_Section-Existing line
Typical_Section-New line

Lkility-Railroad

X5-Proposed suface-pavement

1 | | _’I Line String

r Symbology ~ Mode

I Cobr: [ | nclusive 7|
- /0 = Selection hd

" Styie: | S

I~ Weight 2 = On hd
Execute | Properties | Tags |

This dialog also provides the capability to filter the display of elements based on their attributes.

Levels

- Levels

Used to specify level criteria. Name

Default

Common-Notes

Level 12

Level 16

Roadway-Bem line
Typical_Section-Edsting line
Typical_Section-New line
Ltility-Railroad

X5-Proposed suface-pavement
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MicroStation V8i — Element Selection

To Do this
Select a single level Click the level.
Select many levels at once Click and drag through the level list.

Select non-contiguous levels in the list |<Ctrl> click required levels.

Deselect a level <Ctrl> click the highlighted level.

Types

Used to specify criteria based on element type:

To Do this
Select a single type Click the type.
Select many types at once Click and drag through the types.

Select non-contiguous types in the list |<Ctrl> click required types.

Deselect a type <Ctrl> click the highlighted type.
Symbology ——————————
Symbology ¥ Coor. [0 4 =
v Style: j
¥ Weight: &

Used to specify criteria based on element color, line style (including custom line style), and line weight.

Mode
Inclusive i
Mode Selection bl
On b

Three unlabeled option menus control the following:

Option menu Description

Controls which elements are selected, displayed, or located when the Execute button is
clicked.

Inclusive — All elements that match search criteria.

Exclusive — All elements that do not match search criteria.

Top

Controls how criteria are used when the Execute button is clicked.
e Selection — Elements are selected based on Select By criteria.
Middle e Location — Filters location of elements based on Select By criteria. Elements can
then be selected by using the Select All command.
o Display — Filters display of elements based on Select By criteria.

If set to On (the default), Select By criteria is effective.

Bott
ottom If set to Off, Select By criteria is ignored.
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Execute Properties | Tags I

Execute = |

Selects, Locates, or Displays elements in accordance with the specified search criteria and Mode.
Properties

Opens the Select By Properties dialog, which is used to specify criteria based on less prominent element
attributes, such as area and class.

Tags

Opens the Select By Tags dialog, which is used to specify criteria based on tag values. If selection criteria
based on tag values are specified, elements that do not have attached tags with the specified tag name(s)
will not be selected, located, or displayed.

Control Criteria matched if on Tools menu > Set Select By from Element

Level Levels ise B ] 5

Ird
I~
¥ Type
I~
-

Symbology |Symbology
Type Types

Properties |Properties

Class Class

Opens the Set Select By dialog, which is used to set the search criteria so they match an element's
attributes.

After you turn on the controls for the desired criteria, identify the element whose attributes you want to
specify as criteria.

Tools menu > Selector Save Sets

Opens the Select By Save Sets dialog, which is used to save and retrieve sets of search criteria settings.

=T 5
File
--As0_thuz1-SOIbXHdlUtOuQhselectby rsc
Save Set Description

1

[T Use all Save Sets in resource file

Settings Menu > Cell

=10 =] Opens the Select By Cell dialog, which is used to specify a
Cell Name: | criterion based on the name of an unshared cell.
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Settings menu > Shared Cell

Opens the Select By Shared Cell dialog, which is used
EET I ] 1 to specify a criterion based on the name of a shared

Shared Cell Name: | cell.

Settings menu > Text

Opens the Select By Text dialog, which is used to specify criteria based on element attributes specific to
text elements. Text strings are case-sensitive. For example, inputting the string “North” would select
“North”, but not “north”, nor “NORTH”.

Fl) Select E =1ox]
¥ FEort: 3

¥ Height: 0.1100

¥ Width: 0.1100

¥ Justification: Left Center il
[ Sting: |

Settings menu > Text Node

MoDOT does not use text nodes.
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MicroStation V8i — Manipulate Elements

7.0 Manipulate Elements tool box

The tools in the Manipulate tool box are used to copy, move, resize, rotate, and/or mirror elements.

Manipulate - CO 2]

1 \
Copy Element // \ \ Stretch

i

Move Element Align Edges

Move/Copy Parallel Mirror

Scale Rotate

7.1 Copy Element — = _{oi x|
O \O — o, Copies: |1
‘ o z).zs‘ 22 e 9 4k i I UseFence: lnside -

fiF

Used to copy an element(s).

Tool Settings Effect
Copies Sets the number of copies to create.

Use Fence If on, the fence contents are copied. The option menu sets the Fence (Selection) Mode.

To copy an element(s)

1) Select the Copy tool.

2) Identify the element.

3) Enter a data point to position the copy.
Alternative Method - To copy an element(s)

1) Select or fence the element(s).

2) Select the Copy tool.

3) Enter a data point to define the origin for the copy.

4) Enter a data point to position the copy.
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g e gy

Copy tool. Left, identifying an element to copy. Right, copying the fence contents with Use Fence on.
When you do not require precision, you can copy one or more selected elements by selecting them and
dragging one of the elements by any point on the element except the handles while holding down the
<Ctrl> key. (First start dragging and then press the key.)

Choosing Copy. from the Reset pop-up menu selects the Copy Element tool. When the tool is selected in
this manner, the copy operation affects all selected elements.

If you copy elements from an attached reference, the elements' levels will be copied if only they do not
exist in the active model. To change how levels are handled, choose Preferences from the Workspace
menu and select the Reference category.

7.2 Move Element

Used to move an element(s).

i

v Use Fence:  Inside hd

Tool Settings Effect

Use Fence If on, the fence contents are moved. The option menu sets the Fence (Selection) Mode

To move an element
1) Select the Move tool (be sure Use Fence is off).
2) Identify the element.
3) Enter a data point to reposition the element.
To move one or more selected elements
1) Select the element(s).

2) Select the Move tool.
Be sure Use Fence is off.

3) Enter a data point to define the origin for the move.

4) Enter a data point to define the distance and direction of the move.
The element(s) are repositioned.

To move fence contents

1) Place a fence around the element(s).
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2) Select the Move tool.
Be sure Use Fence is on.

3) Enter a data point to define the origin for the move.

4) Enter a data point to reposition the fence contents.

Move tool. Left, identifying an element to move. Right, moving the fence contents with Use Fence on.

When you do not require precision, you can move one or more selected elements by selecting them and
dragging one of the elements by any point on the element except the handles.

Choosing Move. from the Reset pop-up menu selects the Move Element tool. When the tool is selected in
this manner, the move operation affects all selected elements.

7.3 Move/Copy Parallel v, PP i
ot o 2 2 3 iC Miter v |

S 03570 {:o
Used to move or copy an element (line, line string, multi-line, curve, arc, I™ Keep Original

i i i ™ Use Active Attribut
ellipse, shape, complex chain, or complex shape) parallel to the original. == ceve e

Tool Settings Effect

Determines the method by which the gap created, by moving two connected elements to
a parallel location, is filled.
e  Miter — Extends or shortens connecting segments while maintaining the angle
of their connections.
e Round — Fills the gap with a rounded arc between the two moved elements.
Mode e  Original — Fills the gap in the same manner as the MicroStation/J
implementation of this tool; the resulting element is the same type as the
original element.
For some element types — for example, ellipses — Original does not produce a true
parallel offset. With an ellipse Miter or Round results in a B-spline, a true parallel offset,
rather than an ellipse.

Distance If on, sets the distance to move.

Clicking the Define Dist button lets you define the distance to move, graphically with two
data points. When you have defined the distance, the Distance setting is turned on
automatically and the defined distance value is displayed in its field.

Define
Dist(ance)

Keep Original |If on, the original elements are not manipulated.

Use Active If on, the moved or copied element takes on the active attributes.
Attributes If off, the moved or copied element retains the attributes of the existing element.
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To move or copy an element parallel to the original

1) Select the Move/Copy Parallel tool.
2) Identify the element.

3) Enter a data point.

Distance Defines
Off Distance and direction.
On Direction only.

5
W

2x

Move/Copy Parallel tool. (Above) Top: Defining distance with a data point (Distance off) and Gap Mode set to Mitered. (Above)
Bottom: Distance is keyed in (Distance on). In illustrations, Make Copy is on.

5

Comparison of using the Move/Copy Parallel tool with Gap Mode set to Mitered (left) and Rounded (right).

To move or copy an element, parallel to the original, by a graphically defined distance
1) Select the Move/Copy Parallel tool.
2) Click the Define Dist button.
3) Define the required distance with two data points.
4) Identify the element.

5) Define the direction to move or copy the element.

You can instead use the Move Element tool in conjunction with AccuDraw to constrain element
movement.
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Manipulate - CO B
o o 2 H _ Ay Fa}l E:I Method: _Active Scale ™
X Scale: [1000000 —2
. . . Y Scale: | 1.000000 —
Used to resize an element(s). Elements can be scaled individually, I About Hement Corter
as a selected group, or within a fence. When About Element Center Il T
is turned on, selected elements are scaled about their (individual) " Use Fence: _Inside I
center points. M

Tool Settings

Method

X Scale
Y Scale
Z Scale

Proportional

About Element
Center

Copies

Use Fence

Scale Multi-line
Offsets

Scale
Dimension
Values

Scale
Annotations
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Effect

Sets the method used to scale an element.

e  Active Scale — Scale by the active scale factors (X Scale, Y Scale, and Z Scale). If
a scale factor is 0-1 (for example, 0.25), size in that direction is decreased; if a
scale factor is greater than 1, size in that direction is increased.

e 3 points — Scale graphically, through the entry of three data points. The scale
factors are computed by dividing the distance between the first and third points
by the distance between the first and second points.

Scale factor along view x-axis (horizontal), when Method is Active Scale.

Scale factor along view y-axis (vertical), when Method is Active Scale.

(3D only) Scale factor along view z-axis (depth), when Method is Active Scale.
(Method set to 3 points only) If on, the element(s) proportions are maintained.

If on, in Extended Information section of tool settings, the selected element(s) is scaled
about its center point instead of a selected point. Cells and text elements are scaled
about their origins.

Elements may be selected individually, or you can select multiple elements to scale in a
selection set or using a fence. Where multiple elements are selected, they all will be
scaled about their own center points.

If on, the element(s) are copied and the copy(s) are scaled; the original(s) are not
manipulated. The adjacent field sets the number of scaled copies to create.

If on, the fence contents are scaled. The option menu sets the Fence (Selection) Mode.

If on, multi-line offsets are scaled (for example, to scale wall thickness when resizing a
room).

If on, dimension values are modified to reflect the size of the scaled dimension.
If off, only the dimension elements are scaled, while the dimension value remains
unchanged.

If on, annotations are scaled. An annotation is an annotation-able element that is placed
with the annotation scale lock on. Annotation-able element types are dimensions, text
elements, text nodes, notes, detailing symbols, annotation cells, tags, and linestyles.

If off, size of annotations remains unchanged (We do not use Scale Annotations at
MoDOT).
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To scale an element(s) by the active scale factors

1)
2)
3)

4)

Select or fence the element(s).
Select the Scale tool.
In the tool settings window, set Method to Active Scale.

Enter a data point to define the point about which the element(s) are scaled.

Alternative Method — To scale an element(s) by the active scale factors

1)
2)
3)

4)

Select the Scale tool.
In the tool settings window, set Method to Active Scale.
Identify the element.

Enter a data point to define the point about which the element(s) are scaled.

1. 1.1
\f/
X2

i

2

Scale, with Method set to Active Scale. Illustrations show X Scale = 2.0, Y Scale = 0.5, and Make Copy on.

To scale an element(s) graphically

1)

2)

Select or fence the element(s).

Select the Scale tool.

In the tool settings window, set Method to 3 points.
Enter a data point to define the point to scale about.
Enter a data point to define a known location or keypoint.

Enter a data point to define scaling factors.
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Alternative Method — To scale an element(s) graphically
1) Select the Scale tool.
2) Inthe tool settings window, set Method to 3 points.
3) Identify the element.
4) Enter a data point to define the point to scale about.
5) Enter a data point to define a known location or keypoint.

6) Enter a data point to define scaling factors.

J{E 3

Scale, with Method set to 3 points.
To scale elements, in a fence, about their centers (by a scale factor)
1) Use the Place Fence tool to place a fence around the elements.

2) Select the Scale tool.
The Scale settings window opens.

3) Set Method to Active Scale and set the scale factor.
4) Turn on About Element Center (in the Extended Information section of the tool settings).

5) Enter a data point to accept the scaled elements.

Left: Selecting the elements to scale with a fence.
Right: After scaling the elements with About Element Center turned on (originals shown dashed).

Choosing Scale from the Reset pop-up menu selects the Scale tool. When the tool is selected in this
manner, the scale operation affects all selected elements.
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Manipulate - CO

I:IEjl E::gl 28

il

AN IEZ_LI nm Method: Active Angle ™

7.5 Rotate

[ooo00 =
T About Blement Cent
Used to rotate an element(s). Elements can be rotated individually, F [:ao' = I—_er
Copies ]

as a selected group, or within a fence. When About Element Center I Use Fence:  Inside -
is turned on, selected elements are rotated about their (individual) -
center points.

Tool Settings Effect

Sets the method used to rotate an element.

e Active Angle — The element(s) are rotated by the Active Angle, which can be
keyed in.
Method cyedin

e 2 Points — The angle of rotation is defined by entering two data points.

e 3 points — The angle of rotation is defined by three data points.

If on, in Extended Information section of tool settings, the selected element(s) is rotated
about its center point instead of a selected point. Cells and text elements are rotated
About Element |about their origins.
Center Elements may be selected individually, or you can select multiple elements to rotate in a
selection set or using a fence. Where multiple elements are selected they all will be
rotated about their own center points.

If on, the element(s) are copied and the copy(s) are rotated; the original(s) are not

Copies . . . .
P manipulated. The adjacent field sets the number of rotated copies to create.

Use Fence If on, the fence contents are rotated. The option menu sets the Fence (Selection) Mode.

To rotate an element(s)

1) Select or fence the element(s).

2) Select the Rotate tool.

3) Enter a data point to define the pivot point.
If Method is set to Active Angle, the element(s) are rotated by the Active Angle; repeat to rotate
the element(s) again. Otherwise, continue with step 4.

4) If Method is set to 2 Points, enter a data point to define the angle of rotation graphically.
or
If Method is set to 3 points, enter a data point to define the start of rotation.
If Method is set to 2 Points, the element(s) are rotated; repeat to rotate the element(s) again.

Otherwise, continue with step 5.

5) Enter a data point to define the angle of rotation graphically.
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Alternative Method — To rotate an element(s)

1) Select the Rotate tool. >3< 1 /\ >3<
2) Identify the element. 2 / /,/’\g

< -
3) Follow steps 3-5 above. e \ 2 /

I

12—
N

[~

L\

Rotate tool. Top: with Method set to 2 Points. Middle: with Method set to Active Angle and Active Angle set to 30°. Bottom: with
Method set to 3 points.

To rotate an element by the Active Angle about its center
1) Select the Rotate tool.
2) Set Method to Active Angle and set the required angle.
3) Turn on About Element Center (in the Extended Information section of the tool settings).

4) Identify the element to be rotated.
The rotation is displayed dynamically.

5) Accept to complete the rotation.

|

B Eﬁ"

2X

With Method set to Active Angle and About Element Center turned on:
Left: Identify the element (1) — a cell in the illustration
Center: The rotation displays dynamically
Right: Accept (2) to complete the rotation about the center of the element
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Choosing Rotate from the Reset pop-up menu selects the Rotate tool. When the tool is selected in this
manner, the rotate operation affects all selected elements.

If Use Fence is on and the rotation is repeated, any element(s) inside the moved fence are copied along
with the original fence contents.

7-6 Mirror Manipulate - CO

o) {5
CE‘I ? 82 I:j‘l (\} I::| error&bout Horizortal v|
[~ About Element Center
Used to mirror an element(s). ™ Make Copy
[ Use Fence: nside ¥
-
Tool Settings Effect

Sets direction in which element(s) are mirrored:

e Horizontal — about horizontal axis.
Mirror About

e Vertical — about vertical axis.

e Line — about line defined by two data points.

If on, the element(s) are copied and the copy(s) are mirrored; the original(s) are

Make Co
Py not manipulated.
Mirror Text If on, text is mirrored.

Mirror Multi-line

Offsets If on, multi-line profile offsets are mirrored.

If on, the fence contents are mirrored. The option menu sets the Fence (Selection)

Use F
se Fence Mode

To mirror an element(s)
1) Select or fence the element(s).
2) Select the Mirror tool.
3) Enter a data point.
If Mirror About is set to Horizontal or Vertical, the element(s) are mirrored.
If Mirror About is set to Line, this data point defines one point on the mirroring line.
4) If Mirror About is set to Line, enter another data point to define another point on the mirroring

line.
The element(s) are mirrored. You can go back to step 3 to mirror the element(s) again.
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Alternative Method — To mirror an element(s)
1) Select the Mirror tool.
2) Identify the element.

3) Follow steps 3 and 4 above.

Mirror tool. Clockwise from top left: Mirror About Horizontal, Vertical, and Line. Mirror Text is on.

Choosing Mirror. from the Reset pop-up menu selects the Mirror tool. When the tool is selected in this
manner, the mirror operation affects all selected elements.

7.7 Align Edges Manipulate - CO

III? z:::gAI 8 8 I:TI O{'fz

Used to align an element(s) to an edge of another element.

Tool Settings Effect
Sets the manner by which to align:

e Top
e Bottom
o Left

Ali

'8n e Right

e Horiz(ontal) Center
e Vert(ical) Center
e Both Centers

Make Copy If on, the element(s) are copied and the copy(s) are aligned to the identified base element;

the original(s) are not manipulated.

Use Fence If on, the fence contents are aligned. The option menu sets the Fence (Selection) Mode
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To align elements to another element
1) Select or fence the elements to align.
2) Select the Align Edges tool.

3) Identify the base element to which to align the selected elements.
The selected elements are aligned to the edge of the base element.

4) Accept the alignment to the base element.
Alternative Method — To align elements to another element
1) Select the Align Edges tool.

2) Identify the base element to which to align other elements.
The base element highlights, and a range block is displayed normal to the view.

3) Identify an element to align.
The identified element is aligned to the edge of the base element, which remains highlighted
with the range block.

4) Continue identifying elements until all of the desired elements are aligned to the base element.

5) Accept the last element's alignment to the base element.
The base element remains highlighted with the range block.

6) Reset.

7.8 StretCh Manipulate - CO

EE‘I {::5‘I 8 2 I:ﬁ‘l O{‘f} AE.

‘%} Stretch ElementEI [=] @
I.

Used to stretch fence contents, which are defined by a fence. The fence can be an existing fence, or you
can define a new rectangular (only) fence with this tool.

The Stretch Element tool operates on elements as follows:

e Avertex of a ling, line string, multi-line, or shape is moved if it is inside the fence. A vertex
outside the fence is not moved.

e Anendpoint of an arc is moved if it is inside the fence. An arc endpoint outside the fence is not
moved.

o An ellipse, circle, or cell is moved if it is completely inside the fence.

e One or more poles (control points) of a B-spline surface, that are located inside the fence, are
moved.

You can use the Stretch Element tool to manipulate breaks (such as breaks in multi-lines, which are often
used to represent windows or doorways when the multi-line itself is the wall). For instance, you can place
your fence to include a window, and move the window along the wall. You may also change the size of the
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window by including only the start or end of the break in the fence. This means that in most cases, you do
not have to drop the multi-line into its component elements to perform such manipulations.

You cannot move the break off the multi-line segment that contains it. If you move the fence so the start
or endpoint of a break would move off the segment, the break position will simply be projected to the
nearest point on the segment. If you move a break off the end of the segment, it will simply be deleted.

Tool Settings Effect

Use Fence (Fence present only) If on, the current active fence is used.

Stretch Cells |If on, cells that overlap the fence are selected.

To stretch segments of elements that overlap a fence
1) Select the Stretch Element tool.
2) Enter a data point to define one corner of the fence.
3) Enter a data point to define the diagonally opposite corner of the fence.
4) Enter a data point to define the origin point.

5) Enter a data point to reposition the fence and the affected elements and/or vertices.

To stretch segments of elements that overlap an existing fence
1) Use the Place Fence tool to place a fence around the segments that you wish to stretch.
2) Select the Stretch Element tool.
3) Turn on Use Fence.
4) Enter a data point to define the origin point.

5) Enter a data point to reposition the fence and the affected elements and/or vertices.

Strefching elements that overlap an existing fence.
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MicroStation V8i - Levels

8.0 Levels

Levels within MicroStation are very much like a series of transparent overlays. These levels can be used to
organize information within the design file. They also allow the user to interact with the design file more
efficiently through the ability to turn on and off levels of information to enhance viewing and working
within that file.

MicroStation V8i employs a “named” level system rather than a numbered level system used in older
versions such as MicroStation J. MicroStation V8i is also not restricted to the 63 levels used in the
previous versions. At the date of this publication, MoDOT has over 600 levels in use.

MoDOT will utilize a series of levels with names reflecting the type of elements that our different offices

work within their files. The first 63 levels in MoDOT'’s new level system correspond to the old numbered
system from MicroStation J.

8.1 Level Display

Used to turn on and turn off levels in a model. Also used to apply filters created in the Level Manager
dialog to a model.

Opens when the Level Display icon in the Primary Tools toolbox is selected, when Levels > Display. is
chosen from the Settings. menu, or when Level Display. is chosen from a view window control menu.

| Settings Tools Utlities Workspace Applications m E
-, ]
I|T Tool Settings = 7 - J ":’j Q - .EK‘ 9’ @ -:j
H —
e T
| Color Table...
Coordinate Readout =1o1x]
Design File... ly ERJ View Display ¥ |
@ Display Styles. ..
Drawing Scale = I EE A _Used ~ Lovels ¥| [&4 ~
—== =3 Manager [EY¥E[002 TS 01 4451935 Typ Sec.dan
@ Lods 2 L\ Border1, PW_WORKDIR dms01329\MoDOT_DE
L_:'] Rendering 3
o4 Snaps »
() View Attributes  Ctrl48
4 | i
The Level Display dialog is used to control whether a level is rY— T
visible or not as well as other viewing aspects of the available 1
levels. Defa

Once activated, the Level Display gives the user a evel 16
number of different options for manipulating level e =
viewing and interaction.
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Apply To Open Views

If on, targets the open views for level
display settings adjustment.

Apply To Selected View

If on, targets the selected view for level
display settings adjustment.

Typical_Section-Existing line
Typical_Section-New line

=10l

Typical_Section-Existing line
Typical_Section-New line
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Mode (option menu) o]
% SO
(= E Global Freeze s | [ied =

L8 PW_WORKDIR:dms(1929\MoDOT_DE_2008 dg

Sets the operating mode for this dialog.

Turning on/off View Display, Global Display, or Global Freeze is basically
the same as thawing/freezing levels, with one difference. When a level is

frozen, any cells or references placed on that level will not be displayed, el I
regardless of how levels are used in the elements that make up the cell Name / eeo |
or reference. .

e View Display — Changes in the level display affect the chosen
view in the active model or the level.

e  Global Freeze — Indicates whether the level is frozen. If frozen,
elements on the level are not displayed and cannot be printed.
When a level is frozen, all component elements contained in
shared cell instances or references placed on that level are not displayed.
If a reference is assigned to a level, and the level is frozen, it does not display.

e Global Display — Changes in the level display affect all views in all models in the open file.
Change Level

Opens the Change Level tool, which is used to toggle the display or locked status of a level.
LT Level Display - View 1 =1=1x]

Bl ViewDisply v

i ees v Lovels | [ +

P Crange Level [EIRRANLL

PW_WORKDIR:dms01923\MoDOT_DE_2008 dg

sheet.dan

12 chang e
Level: Display OFf -
[T Use Fence:  Inside i

Tool Settings |Effect

Sets the mode of the change.
e Display Only — Turn on the display the selected level(s) only.
e Display Off — Turn off the display of the selected level(s).
Level e Lock — Lock the display of the selected level(s) in the current state.
e Unlock — Unlock the display of the selected level(s).
e Set Target — Set the target level for the display of the selected level(s).
e Set Active — Set the active level for the display of the selected level(s).
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To display elements on the selected level only

1. From the Level Display dialog, click the Change Level icon.
The Change Level tool settings box opens.

2. Choose Display Only.
3. Identify an element on the level to be display

4. Accept the change
Only elements on that level display.

To turn off the display of a level(s)

1. From the Level Display dialog, click the Change Level icon.
The Change Level tool settings box opens.

2. Choose Display Off.
3. Identify an element on the level to be turned off.

4. Accept the change
The display of the selected level is turned off.

Show Target Tree

Toggles the display of the target tree, which is used to set the target

model for level display settings changes or sets the model as a target.

List filter (option menu)
If the mode option menu is set to Levels, sets the Filter —

named or defined on-the-fly— applied to level display

We normally keep this set to USED so that we can
see any levels that are available in the file.

=lolx
Ly]  ViewDisplay ¥

i

Border Fils
Bridge Division
q Design Division
~GEOPAK-
[Profile]
[Proposed]
[Topography]
[%s]

PN  Bidgs Sheet
Coordinate Poirts Shest
Culvert Sheet
Lighting Sheet
Location Suvey Plan
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=10
Show level nhames or filters (option menu) oy Gy VewDipy ~
= .
Determines the contents of the list box. =40 T

!
\MoDOT_DE_2008.dg

e  Filters — Lists level filters defined in the open file (and in
reference attachments if they are included in the target tree).

e Levels — Lists the levels in the open file (and in reference
attachments if they are selected in the target tree).

At MoDOT, we normally leave this set to LEVELS.

Dialog Properti ced| =]
1alo roperties =
& P Ly Byl VewDisply | Terget lsf] Horzontal ~

¥ Merge Names
- & ( ¥ Link Tree Selection
= - Level 1@
S ET @D i
¥ Alow Docking
[¥ Follow Active View

SR 001_Title_J451935_Titleshest.don
Lo PW_WORKDIR:dms01929\MoDOT_DE_2008 dg

3 - Number Mep Seffings ————————————

DGN Levels as: _Names hd
Start Nitmber: | 0w
lep Size:  Dynamic ¥

Pops up the Level Display Properties dialog, which is
used to set the properties of the Level Display dialog.

Target List
Sets the orientation of the Level Display dialog.
e Horizontal — Sets the Level Display dialog to display the Target Tree above the list box.

e Vertical — Sets the Level Display dialog to display the Target Tree on the left and the list box on
the right side.

Merge Names

When multiple targets are selected, only unique level names are displayed. For example, if 10 instance of
the same level name exists that level name will only appear once.

Link Tree Selection
Links the actions of the Level Manager and the Level Display dialog. When turned on, any target file(s)

selected in the tree in Level Manager are selected in Level Display and vice versa..
Auto-arrange items
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If on, icons in the tool bar wrap when the dialog is resized.
Allow Docking

If on, the next time you open the Level Display dialog, it will be available for docking.

DGN Levels as:
Sets the interface of the Level Display dialog to display Names or Number Map.
e Names — Sets the Level Display dialog to display a list of levels by name.

o Number Map — Sets the Level Display dialog to display levels by a matrix of numbers and makes
the following options available.

Start Number
If DGN Levels is set to Number Map, defines 0 or 1 as the first level displayed.
e 0 — Displays zero as the first level.
e 1 — Displays one as the first level.
Map Size
If DGN Levels is set to Number Map, sets the map size as either Fixed or Dynamic.

e Dynamic — Dynamically changes the number of rows and columns in the Number Map when the
dialog is resized.

e  Fixed — Sets the map size display as fixed.
Rows
If Map Size is set to Fixed, sets the number of rows in the Number Map.
Columns
If Map Size is set to Fixed, sets the number of columns in the Number Map.
Box Size
Sets the size of the boxes in the Number Map. Options are:

e Smallest

e Small

e Medium
e large

e largest
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Target Tree

Used to select the target model for level display settings changes. This tree control enables selection of
the active model, another model in the open DGN file, or an attached reference in the open file or
another file, as the target.

Right-clicking in the target tree area opens up a pop-up menu with the following options:

e Reference — opens the References dialog or Attach Reference dialog.
e Update Levels

e Select All

e Select None

e Invert Selection

e (Cut
e Copy
e Paste

e  Properties
A dimmed entry in the tree indicates that the display of that reference is turned off.
Levels (list box)

Lists the levels (or filters if Mode is set to Filters) in the target model.
Right-clicking the title of the list box brings up a pop-up menu with the following options:

e Save Layout

e Name —displays the name of the level.

e Library — shows whether the level was imported from a library.

e  Number

e  Description

e  File in which it resides

e Logical — either Master (for the open DGN file) or the reference Logical name.

e Color —indicates either the ByLevel or Override color, depending on the value of the symbology
in the Level Manager dialog.

e Style —indicates either the ByLevel or Override style, depending on the value of the symbology in
the Level Manager dialog.

e Weight —indicates either the ByLevel or Override weight, depending on the value of the
symbology in the Level Manager dialog.

e  Material — indicates either the ByLevel or Override material, depending on the value of the
symbology in the Level Manager dialog.

e Lock — indicates whether the level is locked. If locked, you cannot manipulate or modify its
existing elements. However, you can copy elements on locked levels. You can click in the Lock
column to change the level's Lock setting.

e Plot — indicates whether elements on the level can be printed.

e Used — shows whether the level is used in it references.

e Elements — lists the number of elements on the level.

e New Level— indicates whether the specified level is new.

e Show All

e List—opens the Show/Hide Tools option box, which allows you to turn display options on and off.

e  Restore Defaults

Right-clicking on a level in the list box, pops up the following options.
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Menu Iltem
Set Active

Jump To
Active Level

Create Display
Set

All On

All Off

Invert On/Off

Off By
Element

All Except
Element

Save Filter

MicroStation V8i - Levels

Description

Sets the selected (highlighted) level to the active level in the active model.

Takes you to the active level.

Creates a display set.

Turns on all levels in the file (and attached references if they are included in the Target
field).

Turns off all levels in the file (and attached references if they are included in the Target
field).

Selects all unselected and deselects all selected levels listed in the dialog.

Opens the Change Level tool in Display Off mode.

Opens the Change Level tool in Display Only mode.

If the Mode is Levels and Untitled, All Levels or a filter is select from the Filter List, the
filter row appears allowing you to create an on-the-fly filter. Clicking Save Filter opens the
Save Filter dialog for saving and naming the filter.

Level Manager Opens the Level Manager dialog.

8.2 Level

Manager

The Level manager displays information about levels and filters for the active design file and all available

reference files.

The Level manager also allows you to attach and detach reference files.

The Level Manager can be launched by choosing the Level > Manager option from the Settings menu at
the top of the MicroStation screen. It can also be accessed from the context menu when right-clicking
within the Levels List Box in the Level Display dialog box.

-
U Level Manager

Levels Filter Edit

g [ 3

& |22 Symbology: Bylevel ¥||[ 7 _Used v [l ~

= Fiters

) TSI | & | Name ¢
E PW_WORKDIRx i

2T, PW_WORKL Lighting_Signals-Conduit 1846 Conduit cable power source wires cable conduit Master [ 0

Ref. PW_WORK Lighting_Signals-Equipment 2408 __\post with or without lighting amms, luminaire...  Master [ ] 0

= Mllevel Roadway Centerline main 1522 Main line centerline Master [0
Roadway-Centerline other 1521 Sd rd bl ramps o rd Master []0

| Numbe Description
[ ]

Roadway-Existing rw 1530 Bxsting right of way (may be used by GPK criteria) Master Oo

KT i

Text-General notes 1114 General notes Master []0
Text-Main route label 1122 Main centerine route note Master []0
Text-Route label 1121 Route label intersection tie Master []0
Text-Signal 1148 Signal notes Master []0

coooocooo B
coooocooo B

A R AN

N

[Active Level: Test-Signal

[12cf 627 displayed, 1 selected;

Files, Levels, and Filter List

Displays the models, levels, and filters for the file.
e The current model is listed. You can expand (+)

B D06_PL_I-64INT_J6P226D.
E PW_WORKDIR:d01141

2T, PW_WORKDIR:dms
Ref, PW_WORKDIRd0®

= All Levels
or contract (-) it to show or hide attached references. > Fitters
The levels for the model or selected reference are
displayed in the detail section on the right.
K i
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MicroStation V8i - Levels

e All Levels shows level information within all models in the open file.

e The Filters list can be expanded (+) or contracted (-) to show or hide named filters. These filters
customize the level displays based on user-defined search criteria. When you select Filters, a list
of all filters and their search criteria appears in the detail section. When you select a named
filter, the search criteria are applied to the levels for the model.

If you select a named filter and right-click, you have the following options:

Menu Item Usage
New Creates a new filter.
Level Group |Opens the Level Groups dialog, which lets you select a list of levels for the filter.

Opens the Filter Groups dialog, which lets you use existing filters with set

Filter Grou . . .
P operations to define a new filter.

Cuts a filter from its present location on the filter list to be placed in a different

Cut location. If a filter is moved under another filter, it inherits the top-level filter
settings.

o Copies a filter from its present location on the filter list to a different location. If a

Py filter is moved under another filter, it inherits the top-level filter settings.

Paste Places a filter in the selected location on the filter list. If a filter is moved under
another filter, it inherits the top-level filter settings.

Move Moves a filter from its present location on the filter list to a different location. If a
filter is moved under another filter, it inherits the top-level filter settings.

Delete Removes a filter from the filter list.

Rename Lets you enter a new name for the filter.

Properties Opens the Level Properties dialog, which is used to set the preferences of the filter.

Levels list

Shows the attributes and properties of individual levels for the selected file or reference. You can filter
this list using the dialog's Filter option. The list entry for the Active Level is displayed in the color cyan.

To modify attributes and properties for a level, select the level in the list, and click in a column.

=[O
Levels Filter Edit
"2 5 |2 | Smbology: Bylevel || 3 Used v [ld v
=8 006_PL_I-64INT_J6P2260_i | A [ Name / Numbe Description
PW_WORKDIR 01141
E T, PW_WORKDIR:dms | *  Roadway-Centerline main 1522 Main line centerline: Master [15 0 [
Ref. PW_WORKDIRd0 | *  Roadway-Centerline other 1521 Sd rd bl ramps o rd o Master [l 29 0 ov
= Allevels +  Roadway-Existing rw 1530 Existing right of way (may be used by GPK criteria) Master [ 30 0 oV
"= Fiters *  Text-General notes 1114 General notes Master [l 17 0 [
*  Text-Msin route lsbel 1122 Main centeriine route note Master [ 15 0 ov
*  Text-Route label 1121 Route label intersection tie Master [ 31 0 [
s Text-Signal 1148 Signal notes Master [l 17 0 0
4l | i || K1 |
[Active Level: Text-Signal [72 of 627 displayed; 1 selected; A

A level's list entry shows:

e Modified — The field is populated if one or more of the level attributes or properties differs from
the source. The source could be either a library or reference level. With respect to reference
levels, Modified is always in the context of the reference source regardless of whether the
reference level is also a library level.
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MicroStation V8i - Levels

A tool tip listing the out-of-sync attribute or property displays when the cursor is over the modified
icon.

Name — displays the name of the level.

Library — shows whether the level was imported from a library.

Number

Description

File in which it resides

Logical — either Master (for the open DGN file) or the reference Logical name.

Color

Style

Weight

Material — allows additional, global control of material specifications.

Global Display — indicates whether elements on the level are displayed. You can click the Global
Display column to change the level's Display setting for all views in all models in the open DGN
file.

Global Freeze — indicates whether the level is frozen. If frozen, elements on the level are not
displayed and cannot be printed. When a level is frozen, all component elements contained in
shared cell instances or references placed on that level are not displayed.

You can click in the Global Freeze column to change the level's Global Freeze setting for all views in all
models in the open DGN file.

Lock — indicates whether the level is locked. If locked, you cannot manipulate or modify its
existing elements. However, you can copy elements on locked levels. You can click in the Lock
column to change the level's Lock setting.

Plot — indicates whether elements on the level can be printed.

Used — shows whether the level is used in its references.

Elements — list the number of elements on the level.

Priority — (2D models only) identifies the level display priority value. A level with the highest
priority value displays in front, while a level with the lowest priority value displays in back.
Reference and element priority values also affect the display.

Transparency — identifies the level transparency value. A value of 0 indicates no transparency
and a value of 100% indicates almost complete transparency.

Show All

List — opens the Show/Hide Tools option box, which allows you to turn display options on and off.

If you select one or more levels and right-click, a pop-up menu provides options for managing levels.
These options are also available on the Level, Filters, and Edit menus and the toolbar. In addition, you can

choose:

Jump to Active Level — Takes you to the active level.
Remap Elements — Opens the Remap Elements to Level dialog.

A level displays as bold when it is used in a model, cell definition or dimension style.
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Changing & Modifying Elements

Section 9
9.0 Change Attributes Tool Box Page 900
9.1 Change Element Attributes Page 900-902
9.2 Modify Line Style Attributes Page 902-903
9.3 SmartMatch Page 904
9.4 Modify Tool Box Page 904-905
9.5 Modify Element Page 905-911
9.6 Partial Delete Page 911-912
9.7 Break Element Page 912
9.8 Extend Page 913
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9.10 Extend Element to Intersection Page 914-915
9.11 Trim Element Page 915
9.12 IntelliTrim Page 916-919
9.13 Construct Circular Fillet Page 919-920

9.14 Construct Chamfer Page 920



MicroStation V8i — Changing & Modifying Elements

Change Attribut... [2

9.0 Change Attributes tool box @ % g?

These tools in the Change Attributes tool box are used to change an elements active element attribute
settings.

To Select in the Change Attributes tool box

Change an elements level, color, line style or f-'_?
line weight —

Change Element Attributes

Sl

Modify an elements Line Style Attribute by i
shifting it .

Modify Line Style Attributes
Match all of the attributes of an element or !.’.P?
text

SmartMatch

9.1 Change Element Attributes e

< e? %é}*‘@

Used to change selected attributes of an element(s). Change Element Attributes. tool settings are used to
specify the new attribute settings.

The .Change Element Attributes. tool is efficient for changing the level of an element to a level that is
currently turned off (the effect of “sending” an element to another level) without changing the active
attributes. Also, since it allows you to match and change attributes using the same tool, .Change Element
Attributes. is very useful when you are doing repetitive changes to many different elements (like going
though an entire drawing cleaning up line weights).

R IaTE
™ Use Active Attributes <
¥ Level: |IJg|'rting_SignaIs-Cc 'I

[+ Calor: [ ] 51 |
E Conduit Trench YI

r Priority:
[T Class:

[~ | Use Eence: Clip v
[~ Make Copy
I~ Change Entire Element

Tool Settings Effect
. If on, the active attributes are affected when you change the attribute settings.
Use Active . . .
Attributes If off (the default), the active attributes are not affected when you change the attribute
settings.
Level If on, level is included when changing or matching settings.
Color If on, color is included when changing or matching settings.
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If on, line style (and any active line style modifiers) is included when changing or

Style matching settings.

Weight If on, line weight is included when changing or matching settings.

Transparency |We do not use this at MoDOT.

Priority We do not use this at MoDOT.
Class If on, element class is included when changing or matching settings.
Use Fence If on, the selected attributes of the fence contents are changed.

If on, the element(s) are copied and the attributes of the copy(s) are changed; the

Make C
ake Lopy attributes of the original(s) are not changed.

If on, the attributes for the entire element are changed. Take, for example, where you
want to change the color for a text style to green, where the existing text color is red and
the underline color blue. If Change Entire Element is off, only the text will change color. If
Change Entire Element is on, both the text and the underline will change to the new
color.

Change Entire
Element

To change an element's attributes (those that are set to on)

1. Select the Change Element Attributes tool.

2. Turn on Use Active Attributes to change an element's attributes to match the active element
attribute settings.
Or
Turn off Use Active Attributes to change an element's attributes without using or affecting the
active element attribute settings.

3. Identify the element.

4. Accept the change.

To match the active attributes to an element and use these settings to change the attributes of other
elements

1. Select the Change Element Attributes tool.

2. Identify the element to match.

3. Turn on the attributes you want to change in the next element(s) selected.
4. Select or fence the element(s).

5. Accept the change.

To change the attributes of one element to match those of another, without affecting the active
attributes

1. Select the Change Element Attributes tool.

2. Turn off Use Active Attributes.
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3. Identify the element to match.

4. Turn on the attributes you want to change in the next element(s) selected.

5. Select or fence the element(s).

6. Accept the change.

e To change the Active Level, Active Color, Active Line Style, Active Line Weight, Active Element
Transparency, Active Element Priority, or Active Class and the corresponding attribute of the

selected element(s) in one step, use the controls in the Attributes toolbox.

e To set the active element attributes so they match those of an element in the design, you can
also use the Match Element Attributes tool.

9.2 Modify Line Style Attributes

Used to modify the line style attributes of an element with a custom line style. You can enter a value for
the attribute, or modify it graphically. The icon bar contains options for setting the type of custom line

style attribute to modify. (o]
R
r St [0000000 I Absohte
I Usefence: [Gp =]
Tool Settings Effect
Width zé
The starting, or Origin, width and the End width of an element.
Start Width Q*;&
The starting, or Origin, width of an element.
i
End Width Q%;
The End width of an element.
[
Scale "%%
The scale factor applied to strokes.
Dash Scale | W%
The scale factor applied to variable length dash strokes.
]
t
Gap Scale
P The scale factor applied to variable length gap strokes.
B
Shift

The Shift distance by which the stroke pattern is shifted relative to the beginning of an
element or its segments.
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Width

Start Width

End Width

Scale

Dash Scale

Gap Scale

Shift

Absolute

True Width

Use Fence

MicroStation V8i — Changing & Modifying Elements

(Width icon selected only) Specifies the starting and end width of an element.
If Absolute is on, this value represents the width value. If Absolute is off, this value
represents the amount to modify the existing width value.

(Start Width icon selected only) Specifies the starting width of an element.
If Absolute is on, this value represents the width value. If Absolute is off, this value
represents the amount to modify the existing width value.

(End Width icon selected only) Specifies the end width of an element.
If Absolute is on, this value represents the width value. If Absolute is off, this value
represents the amount to modify the existing width value.

(Scale icon selected only) Specifies the scale factor applied to strokes.
If Absolute is on, this value represents the scale factor. If Absolute is off, this value
represents the amount to modify the existing scale factor.

(Dash Scale icon selected only) Specifies the scale factor applied to variable length dash
strokes.

If Absolute is on, this value represents the scale factor value. If Absolute is off, this value
represents the amount to modify the existing scale factor.

(Gap Scale icon selected only) Specifies the scale factor applied to variable length gap
strokes.

If Absolute is on, this value represents the scale factor value. If Absolute is off, this value
represents the amount to modify the existing scale factor.

(Shift icon selected only) Specifies the shift distance by which the stroke pattern is shifted
relative to the beginning of an element or its segments.

If Absolute is on, this value represents the shift distance value. If Absolute is off, this value
represents the amount to modify the existing shift distance value.

If on, the value entered in the adjacent text field represents the actual value for the width,
scale, or shift distance. If off, the value in the text field represents the amount to modify
the current value.

For example, suppose you have a custom line style with a scale of 2.0, and you specify a
Scale value of 3.0. If Absolute is on, the line style scale will be 3.0. If Absolute is off, the line
style scale will be 6.0.

(Width, Start Width, or End Width icon selected only) If on, the line style width is not
affected by a change in line style scale. The line style scale may be modified by the Modify
Line Style Attributes tool, as well as by the global line style scale (ACTIVE LINESTYLE SCALE
key-in).

For example, if you set width to 2.0 and have a scale of 3.0, a line with True Width on will
be 2.0 working units wide, while a line with True Width off will be 6.0 working units wide.

If on, the custom line style attributes of elements inside the fence are modified.

To modify a line style attribute graphically

1. Select the Modify Line Style Attributes tool.

2. Select the icon that corresponds to the attribute to modify.

3. Identify the element.

4. Move the pointer to adjust the setting.

5. Accept the change.
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9.3 SmartMatch

11 Match All Element Sek — o]

’ [~ Msatch Mutidine Caps
[~ Match Annotation Scale

Used to change all active element attribute settings, including those specific to particular element types,
so they match the attributes of an element in the design. When a cell is matched, the active scale factors
and Active Cell are also matched.

Tool Settings Effect

Match Multi-line Caps |If on, multi-line caps settings are matched as well.

Match Annotation Scale |If on, annotation scales are matched as well.

To match an element's attributes

1.

2.

Select the element.

Select the Match All Element Settings tool.

Alternative Method — To match an element's attributes

1. Select the Match All Element Settings tool.
2. Identify the element.
3. Accept the new active settings.
e Thistool is also referred to as SmartMatch..
e To change the color, line style, line weight, or level of an element(s) to the active element
attributes, use the Change Element Attributes tool.
9.4 Modify tool box Modify - CO ]

ENE A R 2 B

Used to do the following:

904

Move a vertex or segment of a line, line string, multi-line, curve, B-spline control polygon, shape,
complex chain, or complex shape.

Scale a block about the opposite vertex.

Modify rounded segments of complex chains and complex shapes created with the Place
SmartLine tool while preserving their tangency.

Change rounded segments of complex chains and complex shapes to sharp and vice-versa.

Scale a circular arc while maintaining its sweep angle.

Change a circle's radius or the length of one axis of an ellipse.

Move dimension text or modify the extension line length of a dimension element.
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MicroStation V8i — Changing & Modifying Elements

Elements with multiple segments are line strings, shapes, and complex chains and complex shapes placed
with the Place SmartLine tool. The Modify Element tool not only lets you modify vertices and segments,

but also lets you change a vertex's type (Sharp, Rounded, or Chamfered).

Settings for the Modify Element tool vary, depending on the type of element you are modifying, and
display when you select a segment or a vertex of the element.

9.5 Modify Elements

Tool Settings

Vertex Type

Rounding Radius

Chamfer Offset

Orthogonal

SmartLine
Modification
Settings icon

Enable SmartLine
modifications

Enable segment
selection

Minimize number of

linear elements

[ oty

Vertex Type: _Shamp vI
Rounding Radius: | 0.0000

¥ Orthogonal

=101

SmartLine Modification Settings

¥ Enable SmartLine modffications

¥ Enable segment selection

\ [~ Minimize number of linear elements

[T Convert selected round or chamfer to segment

Wertex Settings: From Elemert 'I

Effect

(Vertex selected only) Displays the type of vertex selected and lets you modify the
vertex type.
e Sharp — Sets the vertex to a point.
e Rounded — Sets the vertex to rounded and lets you define the Rounding
Radius value.
e Chamfered — Sets the vertex to chamfered and lets you define the
Chamfer Offset value.

(Vertex Type set to Rounded) Sets the arc radius for a rounded vertex.

(Vertex Type set to Chamfered) Sets the two (equal) distances from the vertex to the
end points of the chamfer.

(Vertex of an orthogonal shape selected only). If on, the sides adjoining the vertex
remain orthogonal as the vertex is moved.

If off, the sides adjoining the vertex do not remain orthogonal as the vertex is
moved.

Displays the controls for defining how SmartLine elements are modified with the
Modify Element tool.

If on (the default), modifications to vertices and segments of SmartLines take into
account the adjoining elements. For example, lines that are tangential to a rounded
vertex, remain tangential.

If off, vertices and segments of SmartLines are modified individually.

e Turning off this setting disables the remaining settings as they apply
only to SmartLine style modifications.

If on (the default), segments of SmartLines may be selected, as well as the vertices.
If off, only vertices may be modified.

If on, attempts to reduce the number of component elements in a complex chain or
shape. For example, a number of individual lines that have been chained together
may be converted to a line string.

If off, does not attempt to reduce the number of component elements in a complex
chain or shape.
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If on, when a rounded or chamfered vertex is selected, it is converted to a segment
(arc or linear segment) so that it can be modified as such. This applies only to the
selected round or chamfer, not to the whole chain or shape. After modification, the
component will not be treated as a round or chamfer again.

Convert selected
round or chamfer to
segment

Defines the type of vertex to use.

From Element — Uses the element's own settings.

Last Used — Uses the type of vertex that was last used when modifying a SmartLine
element.

Vertex Settings
g e Use this setting to set the vertex being modified to sharp, rounded,

or chamfered, along with its radius or chamfer offset. This can be
convenient when changing the type or size of many vertices,
eliminating having to enter values for each vertex.
To modify an element
1. Select the Modify Element tool.

2. ldentify the element close to the vertex, segment, or axis to modify.

3. Enter a data point to make the modification.

1y o 11 1675 =
Py /w%\ reéii.ii;]

2

Modify Element. Clockwise from top left: moving the endpoint of a line, moving a vertex of a line string,
modifying dimension extension line length, moving a vertex of a B-spline control polygon, scaling a block,
and changing the radius of a circle.

To modify the endpoint of a line
1. With AccuDraw active, select the Modify Element tool.
2. Identify the end of the line that you wish to modify.
The drawing plane origin moves to the opposite end of the line, and the coordinate system aligns
its x-axis with the line. Additionally, the length of the line is displayed in the AccuDraw window.
3. (Optional) Rotate the drawing plane axes.

4. (Optional) Preview the modifications by keying in desired changes in the AccuDraw window.

5. Enter a data point to complete the modification.
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To modify a circle

1.

With AccuDraw active, select the Modify Element tool.

Identify the circle.

The drawing plane origin moves to the center of the circle. In addition, the coordinate system
switches to Polar, and aligns with the view axes.

(Optional) Rotate the drawing plane axes.

(Optional) Preview the modifications by keying in a radius value in the AccuDraw window. (When
modifying a circle, any value keyed in the AccuDraw window defines a new radius.)

Enter a data point to complete the modification.

To modify an ellipse

With AccuDraw active, select the Modify Element tool.

Identify the ellipse by entering a data point near the axis to modify.

The drawing plane origin moves to the center of the ellipse, and the coordinate system aligns its
x-axis with the primary axis of the ellipse.

(Optional) Rotate the drawing plane axes.

(Optional) Preview the modifications by keying in desired changes in the AccuDraw window.

Enter a data point to complete the modification.

To modify the sweep angle of an arc

1.

With AccuDraw active, select the Modify Element tool.

Identify the arc.

From the Method option menu in the tool settings window, choose Angle.

The drawing plane origin moves to the center of the arc, and the coordinate system aligns its x-
axis with the start of the arc's sweep.

(Optional) Rotate the drawing plane axes.

(Optional) Preview the modifications by keying in desired changes in the AccuDraw window.

Enter a data point to complete the modification.

Modifying the sWéep angle of an arc
You can adjust the arc sweep by either complement of the angle (180° either way).
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To modify the radius of an arc without changing its center point

1.

With AccuDraw active, select the Modify Element tool.

Identify the arc.

From the Method option menu in the tool settings window, choose Radius About Center.

The drawing plane origin moves to the center of the arc, and the coordinate system aligns with
the view axes.

(Optional) Rotate the drawing plane axes.

(Optional) Preview the modifications by keying in a radius value in the AccuDraw window. (When
modifying an arc, any value keyed in the AccuDraw window defines a new radius.)

Enter a data point to complete the modification.

Modifying the radius of an arc without changing its center point.

To modify the radius of an arc without changing its endpoints

908

With AccuDraw active, select the Modify Element tool.

Identify the arc.

From the Method option menu in the tool settings window, choose Radius Preserve Ends.

The drawing plane origin moves to the center of the arc, and the coordinate system aligns with
the view axes.

(Optional) Rotate the drawing plane axes.

(Optional) Preview the modifications by keying in a radius value in the AccuDraw window.

Enter a data point to complete the modification.

Modifying the radius of an arc without changing its endpoints.
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To modify a vertex of a multi-segment element

1.

With AccuDraw active, select the Modify Element tool.

Identify the element by entering a data point near the vertex to modify.

The drawing plane origin moves to the vertex, and the coordinate system aligns with the view
axes.

(Optional) Rotate the drawing plane axes.

(Optional) Preview the modifications by keying in desired changes in the AccuDraw window.

Enter a data point to complete the modification.

Modifying the vertex of a Linear segment and an Arc segment

To modify a linear segment of a multi-segment element

With AccuDraw active, select the Modify Element tool.

Identify the element by entering a data point near the segment's midpoint.

The drawing plane origin moves to the identification point, and the coordinate system aligns its
x-axis with the segment.

(Optional) Rotate the drawing plane axes.

(Optional) Preview the modifications by keying in desired changes in the AccuDraw window.

Enter a data point to complete the modification.

Modifying a Linear segment
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To modify an arc segment of a multi-segment element

With AccuDraw active, select the Modify Element tool.

Identify the element by entering a data point near the segment's midpoint.
The drawing plane origin moves to the identification point.

(Optional) Preview the modifications by keying in desired changes in the AccuDraw window.

Enter a data point to complete the modification.

Modifying an Arc segment

To move a linear segment parallel to itself

With AccuDraw active, select the Modify Element tool.

Identify the element by entering a data point near the segment's midpoint.

The drawing plane origin moves to the identification point, and the coordinate system aligns its
x-axis with the segment.

Position the pointer on the drawing plane's y-axis.

Press the <Enter> key.
The movement of the segment is constrained parallel to its current location.

Enter a data point to complete the modification.

To modify the vertex of orthogonal segments

910

With AccuDraw active, select the Modify Element tool.

Identify the element by entering a data point near the vertex to modify.

The drawing plane origin moves to the vertex, and the coordinate system aligns with the
segments.

(Optional) Rotate the drawing plane axes.

(Optional) Preview the modifications by keying in desired changes in the AccuDraw window.

Enter a data point to complete the modification.
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To change a vertex type

1.

. Modi El
9.6 Partial Delete B(g():__f o S d £

With AccuDraw active, select the Modify Element tool.

Identify the element by entering a data point near the vertex to modify.
The drawing plane origin moves to the vertex. If the vertex is contained within a right angle, the
coordinate system aligns with the right angle.

From the Vertex Type option menu in the tool settings window, choose the desired type —
Sharp, Rounded, or Chamfered.

If changing Vertex Type to Rounded, key in the desired rounding radius, in working units
(MU:SU:PU) in the tool settings window's Rounding Radius field.

If changing Vertex Type to Chamfered, key in the desired chamfer offset, in working units
(MU:SU:PU) in the tool settings window's Chamfer Offset field.

To maintain the vertex in its original location — that is, to just change its type — enter a data
point at the drawing plane origin.

Or

To otherwise modify the vertex, follow steps 3-5 in the procedure to modify a vertex of a multi-
segment element.

You can modify a line, line string, multi-line, arc, circle, ellipse, curve, shape, text, or complex
element by dragging its handles when selected.

To choose SmartLine Modification Settings, click the arrow in the bottom right corner of the tool
settings window.

Arc axes cannot be modified with the Modify Element tool. Instead, use the Modify Arc Axis tool.

S

Used to delete part of an element. The first data point defines the start point of the deletion and the
second data point defines the direction and extent of the deletion.

A closed element is turned into an open element — an ellipse or circle becomes an arc; a shape
becomes a line string; a closed B-spline curve becomes an open B-spline curve.

If an interior portion of an open element — line, line string, multi-line, curve, or arc — is partially
deleted, the element is divided into two elements of the same type.

To delete part of an element

1.

2.

3.

Select the Delete Part of Element tool.
Identify the element at one end of the part to delete.

Enter a data point to define the other end of the part to delete.
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MicroStation V8i — Changing & Modifying Elements

7.8
M
Y
L d
~
»\

9.7 Break Element Modify - CO o | =
Bl ST 2 = = A

=

Used to break a linear element at a defined point.

To break an element at a defined point
1. Select the Break Element tool.
2. Select the element at the point where the break is required.

3. Accept to place the break point.

Ny

| 1] I

Left: Placing break points in the shape
Right: After placing break points, the two sections can be manipulated individually.
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B( 5 ::'\? ﬂ‘] _\ [ Distance:

[ From End

9-8 EXtend Modify - CO O\ B EE =10 ]
1., & *~tt4

S

Used to extend or shorten a line or an end segment of a line string or multi-line.

Tool Settings Effect

If on, sets the distance.
Distance e A negative distance shortens the line.

e A positive distance extends the line.

(Applies for Distance off only) If on, the extension, or shortening, of the line is relative to
the nearest endpoint to the identification point.

If off, the extension, or shortening, of the line is relative to the origin point of the line, no
matter where it is identified

From End

To extend or shorten a line by entering a data point
4. Select the Extend tool.
5. Identify the line near the endpoint to modify.
6. If Distance is on, accept the modification.

Or
If Distance is off, enter a data point to define the new endpoint.

1, 2 1
. £ £

Ao TD
¢ Ay

P

In each example, identify the line (1) and accept the extension (2). (Cont. next page)

Top: Defining the new endpoint graphically when Distance is off. Bottom: Defining the new endpoint when
Distance is on. If the Distance, denoted by “D,” is negative, the line is shortened. If the Distance is positive,
the line is lengthened.

913



MicroStation V8i — Changing & Modifying Elements

9.9 Extend 2 Elements to Intersection

Used to extend or shorten two lines, line strings, or arcs to
their intersection.

To extend two elements to their intersection

1. Select the Extend Two Elements to Intersection tool.

N

Identify the first element.

w

Identify the second element.

4. Accept the modification.

3
2

Modify - CO =]
X 3¢ /C\)k FE N

~

Extend Two Elements to Intersection tool. Left: Lengthening two lines. Right: Lengthening an arc and

shortening a line.

No modification is made if the identified elements cannot be extended so that they intersect. When an
element is extended, the end nearest the point where it was identified is moved, and the other end

remains unchanged.

When an element is shortened, the part of the element that is identified is kept.

9.10 Extend Element to Intersection

Modify - CO =]
L @t Y N

~—~

Used to extend or shorten a line, line string, or arc to its intersection with another element.

To extend an element to its intersection with another element

1. Select the Extend Element to Intersection tool.

2. ldentify the element to extend or shorten.
3. ldentify the element to which the first element will be extended or shortened.
4. Accept the modification.
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>y

Modify - CO &l

9.11 Trim Elements Y TR

Used to trim or cut an element or series of elements at their intersection with one or more cutting
elements. The cutting element and the element that is trimmed can be lines, line strings, arcs, curves, B-
spline curves, shapes, ellipses, complex chains, or complex shapes.
To trim an element(s)

1. Use the Element Selection tool to select a cutting element(s).

2. Select the Trim Element tool.

3. Identify an element to trim.
The element is highlighted and how it will be trimmed is dynamically displayed.

4. Accept the trimmed element.
5. Go back to step 4 to identify another element to trim.
Or
Reset to finish.
Alternative Method — To trim an element(s)
1. Select the Trim Element tool.

2. Identify the cutting element.

3. Follow steps 3-5 above.

Trim Element tool. The cutting elements are indicated by handles.
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Modify - CO (]

9.12 IntelliTrim X ok R N

S

e Used to simultaneously trim, extend or cut multiple elements.

e The cutting elements or elements to which you can extend other elements are lines, line strings,
ellipses, arcs, curves, shapes, complex strings, complex shapes, text nodes, and cell headers.

e Elements that can be cut or trimmed are lines, line strings, curves, arcs, ellipses, shapes, B-spline
curves, complex strings, and complex shapes.

e The only elements that can be extended are lines, line strings, complex chains that end with a
line or line string, and b-spline curves.

i

Mode Quick i
Operation Trm ¥

Tool Settings Effect

Operation:

e Trim — If on, elements are trimmed.

e Extend — If on, elements are extended.

e Cut — If on, elements are cut. (You will not actually see where the element
was cut until you select it.)

Quick Mode

Operation:

Toggling between Trim and Extend in Advanced Mode causes all intersections and

extension points to be recalculated and displayed.

Advanced Mode P piay
e Trim — If on, elements are trimmed.
e Extend — If on, elements are extended.
e Cut — Dimmed if Advanced is selected.

Select Elements to |If selected, each element that is identified is designated as an element to trim (or
Trim extend).

Select Cutting

If selected, each element that is identified is designated as a cutting element.
Elements

To trim (or extend) multiple elements
1. Select the elements to trim or the cutting elements.
2. Select the IntelliTrim tool.
If the tool setting Operation option is set to Trim, the selected elements are highlighted.

If the tool setting Operation option is set to Cut, the selected elements are highlighted and
dashed.
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If the selected elements are the elements to trim, identify each cutting element.
Or If the selected elements are the cutting elements, identify each element to trim.
All potential cutting points are shown as small dots.

When done identifying elements, Reset.
The proposed results of the operation are displayed. The trimmable elements remain highlighted
to indicate the tentative nature of the display.

If the results are satisfactory, Reset to accept them. Otherwise, continue with step 6.

For each element whose trim or extension result is not as you desire, enter a data point on the
element on or near the part of the element you wish to keep. When entering these guide points,
you need not be concerned about “inside” and “outside” (because the cutting elements do not
have to be connected or closed).

For each element to trim, the series of entered guide points is evaluated and the part of the
element that is closest to the closest guide point is kept. Every time the element crosses a cutting
element, it is cut.

When done modifying the results, Reset.

Alternative Method — To trim (or extend) multiple elements

1.

Select the IntelliTrim tool.

Identify each element to trim.

When done identifying elements, Reset.
Identify each cutting element.

When done identifying elements, Reset. The proposed results of the operation are displayed. The
trimmable elements remain highlighted to indicate the tentative nature of the display.

If the results are satisfactory, Reset to accept them. Otherwise, continue with step 7.

For each element whose trim or extension result is not as you desire, enter a data point on the
element on or near the part of the element you wish to keep. When entering these guide points
you need not be concerned about “inside” and “outside” (because the cutting elements do not
have to be connected or closed).

For each element to trim, the series of entered guide points is evaluated and the part of the
element that is closest to the closest guide point is kept. Every time the element crosses a cutting
element, it is cut.

When done modifying the results, Reset.
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]

17 3 4

Trimming multiple elements. Top Left: Identify the elements to be trimmed (points 1-4), with a
Reset to finish. Top Right: Identify the cutting elements (points 5-6), with a Reset to finish.
Proposed cutting points appear as small dots. Bottom Left: Reset to display the proposed

result. Bottom Right: Reverse the result of any incorrect cuts by entering a data point near the

part of the element that you wish to keep (point 7). Reset to finish.

A
— 1

— - — . —-———

Extending multiple elements. Top Left: Identify the elements to be extended (points 1-5), with a Reset to
finish. Top Right: Identify the cutting elements (points 6-8), with a Reset to finish. Proposed cutting points
appear as small dots. Bottom: Reset to display the proposed result. A further Reset completes the
operation.
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e At any point while designating elements, you can switch between identifying elements to trim
and identifying cutting elements by selecting the appropriate radio button in the tool settings
window. If the focus is on one of the radio buttons, you can select the other simply by pressing
<space bar> or the Reset button.

e To change an element from an element to trim to a cutting element, or vice-versa, simply
reidentify it with the corresponding radio button selected. It is possible — and in some cases
efficient — to select both the elements to trim and the cutting elements prior to selecting
IntelliTrim. and then reidentify those elements whose designation is wrong.

e If an element cannot be either extended or trimmed, it is deleted under the following condition:
there is a cutting element directly between the closest guide point and the element; otherwise
the element is not modified.

Modify - CO B
9.13 Construct Circular Fillet DX 7 7 ) 4®\

=

Used to construct a circular fillet (arc) between two elements (lines, line strings, circular arcs, circles, or
shapes), two segments of a line string, or two sides of a shape.

I} construct Circular F o ] |

Badius: ID.B333
Tuncate: None vI

Tool Settings Effect
Radius Sets the fillet's radius.

Sets which side(s) are truncated.
None — Neither element or segment is truncated.

Truncate Both — Both elements or segments are truncated at their point of tangency with the fillet.

First — The first element or segment identified (step 2) is truncated at its point of tangency
with the fillet.

To construct a circular fillet
1. Select the Construct Circular Fillet tool.

2. Identify the first element or segment.
If Truncate is set to First, this element or segment is truncated.

3. Identify the second element or segment.

4. Accept the fillet and truncation(s), if any.
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Construct Circular Fillet. From left: Truncate set to None, Both, and First.

9.14 Construct Chamfer S
E ST QPR 5 1 \)

~

Used to construct a chamfer between either of the following:
e Two lines — The original lines are trimmed and a third line element forms the chamfer.

e Adjacent segments of a line string or shape — An additional vertex is inserted and the common
vertex is adjusted to form the chamfer.

i
Distance 1; |0.8333

Distance 2: | 0.8333

Tool Settings Effect
Distance 1 First element or segment identified (step 2).

Distance 2 |Second element or segment identified (step 3).

To construct a chamfer
1. Select the Construct Chamfer tool.
2. Identify the first line or segment.
3. ldentify the second line or segment.
If the first data point identifies a line element, the second data point must also identify a line
element. If the first data point identifies a segment of a line string or shape, the second data

point must identify an adjacent segment of the same element.

4. Accept the chamfer.

Chamfer. D1 denotes Distance 1. D2 denotes Distance 2.
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MicroStation V8i - Standards & the Settings Manager

10.0 MoDOT’s CADD Standards Manual

A manual has been set up as a visual reference to the Settings Manager used by MoDOT’s Design,
Construction, Environmental, Cultural, and other Divisions. It was created in cooperation with the CADD
Support Center, CADD Quality Circle, and the Support Center Design Division. The MoDOT Support Center
Design Division distributes this publication.

You will find an Adobe Acrobat Reader version at the following key-in link of your Internet browser:

http://caddnet/index.php ?title=MicroStation_SS2_Updates

@ MicroStation 552 Updates - CADD Wiki - Internet Explorer provided by MoDOT

@U L4 |'-.-, http://caddnet/index.php?title=MicroStation_552_Updates
< Favorites | 55 6 Intellicast - NOWrad at St.... (@) MOAA -7 Day Forecast | Web Slice Gallery »

=% MicroStation 552 Updates - CADD Wiki

page discussion view source history
Support MicroStation Updates
Contents [hide]

navigation 1 CADD Standards
= Main Page 2 Settings Manager
= Project Wise 3 Microstation QC Meeting Minutes
= MicroStation 4 Version Updates
= GEOPAK Road 5 Archived PowerPoint Presentations
= GEOPAK Site
= GEOPAK Survey CADD Standards

GIS Infi ti e \
" niarma |gn = (Cadd Standards Manual (updated 09/09/2011) B
= GPS Information .
= Drainage Apps
= Other Design Apps .
. PC"HowTo's" Settings Manager
= Training = Settings Manager Updates - (Current Update - June 2012)&
= Electronic Plans
= Construction
p— Microstation QC Meeting Minutes
= CADD Forums = Microstation QC Meeting Minutes (Last Meeting 08-2011) &
= CADD Staff
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This manual was constructed to support the MoDOT Engineering Policy Guide. The items listed are in
settings manager order from Title Sheet to Cross-Section/Preliminary Plan. It is intended to help all
MicroStation CADD users identify and utilize the proper text and symbology, established by the
department, while constructing plans for highway construction. Each item has a graphical representation
and a description of its type, color, level, line weight, line style, and text height (if applicable).

These standards where developed to ensure uniformity of highway plans created by the department
throughout the state of Missouri.

MISSOURI
DEPARTMENT OF TRANSPORTATION

MicroStation®

CADD Standards

A

M Select Settings [.\user.stg] IEIEI&J

File Category Style Options

10.1 What is the Settings Manager?

Group o
CMP/RCP

Within MicroStation, MoDOT utilizes an application called the gz:';ﬁ;s

Settings Manager to enable their users to standardize items such as Environmeital

: : H H H H H Fared End Sections (CONC)
line styles, line weights, text helghts and widths, dimension styles, Flared End Sections (METAL) N
cells, colors, and scales. The Settings Manager enables the user to

place geometry with the correct element attributes and it will also Sort:

invoke the recommended tool with a single mouse click.

m

Component Type -
CMP/RCP 12" Exist Linear £
CMP/RCP 12" New Linear 1
CMP/RCP 15" Bxist Linear
CMP/RCP 15" New Linear
CMP/RCP 18" Exist Linear
CMP/RCP 18" New Linear
CMP/RCP 21" Exist Linear
CMP/RCP 21" New Linear
CMP/RCP 24" Bxist Linear -
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10.2 Activating the Settings Manager

The Settings Manager is activated by selecting the Design pull down and then choosing the drawing type
you are working with.

There is also the Design Standards Toolbar that you can use to load up the Settings Managers by clicking
on the appropriate icon.

:a Testing'J550929\plan_sheets\Plan\PP_J550928 I30.dgn [2D - V& DG

v | Design | Construction Add-Ons  Help

r | CutPlan Sheets o |2
—  ProjectWise Start GEOPAK Job / Add User

Design Standard Toolbox b Large Dialog
Title Sheet I Small Dialog

Typical Sections
Summary Sheet

Plan Sheet

Profile Sheet

User Design File
Reference Points Sheet
Ceoordinate Points Sheet
Traffic Control Sheet
Erosion Control Sheet
Lighting Sheet

Signals Sheet

Signing Sheet

Signing Section Sheet
X-Sections / Culverts Sheets

General Services - Mapping

Survey

Preliminary Plan

10.3 The Design Standards tool box

Settings-Large - @

NNEEESDEEY @IS =

Each of the icons in the Design Standards tool box represent a type of Design File that is typically drawn by
MoDOT. Hover your curser over an Icon to get a “tool tip” of what each Icon represents. This tool bar is
resizable and dockable just like any other tool bar.

You can invoke a Settings Manager with a single click to one of the Icons. Each Icon represents a type of
sheet or design file.
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(=

Title Sheet
Typical Sections
Summary Sheet
Plan Sheet
Profile Sheet

i el

i3

User Design File
Reference Points Sheet
Coordinate Points Sheet
. Traffic Control Sheet
. Erosion Control Sheet
/ Lighting Sheet
/— Signals Sheet

Signing Sheet
/ Signing Section Sheet
/ X-Sections / Culverts Sheets

) s IEEH (B

|

The pull down menus are located

beneath the MoDOT pull down

The Title Sheet Icon

(

;et-hﬂ.& Large -

(5]

M EL EECToh - PR

\

The Title Sheet Icon and pull down menu contains text, lines and cells used in the production of standard

Title Sheet.

The Typical Section Icon

Settipgelqrge -

(=]

@myﬁima--vﬁmqﬁm

The Typical Section Icon and pull down menu contains text, lines, dimensions, and some Standard Typical
Section cells used in the production of Typical Section Sheet.

The 2B Sheet Icon

The 2B Sheet Icon and pull down menu contains text and lines used in the production of standard 2B

Summary of Quantities Sheet.

The Plan Sheet Icon

Settmgs L

(=]

B[@.’.um ."'ﬁEHj_]ﬁm

Settings-La 9E_ o~

(=]

mjal FI EErIchd TLER

The Plan Sheet Icon and pull down menu contains text, dlmensmns, and cells used in the production of a
Plan Sheet from other referenced (see the chapter regarding reference files) files.
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The Profile Sheet Icon

Settings-Large - @

Emlﬁﬁ%%lﬂvﬁmjﬁm

The Profile Sheet Icon and pull down menu contains text, lines and cells used in the production of a Profile
Sheet or the Profile section of a Plan & Profile Sheet.

The User Design File Icon

Settings-Large - @

EDIE“ijITNWTEW

The User Design File Icon and pull down menu contains lines and cells that are used in the production of a
standard highway design sheet (R/W, roadway items, property items, drainage items, etc.).

The Reference Points Icon

Settings-Large - @

EDIEI%&@ETEWTEW

The Reference Points Icon and pull down menu contains text and lines used in a standard Reference Point

Tie Sheet.

The Coordinate Points Icon

Settings-Large - @

ﬂmggﬁmﬁnﬁvﬁmqﬁm

The Coordinate Points Icon and pull down menu contains text and lines used in a standard Coordinate

Points Sheet.

The Traffic Control Icon

Settings-Large - P @

ﬂ@%ﬁ.ﬁ&@ﬁ?ﬁmmﬁm

The Traffic Control Icon and pull down menu contains cells, text and lines used in the production of
standard Traffic Control Sheet. (Signs, Cones, Barriers, etc.)

The Temporary Erosion Control Icon

Settings-Large - N\ @

The Temporary Erosion Control Icon and pull down menu contains cells, text and lines that are used in the
production of standard Temporary Erosion Control Sheet (Straw Bales, Silt Fences, Flow Arrows, etc.)
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The Lighting Icon

Settings-Large - N\ @

The Lighting Icon and pull down menu contains cells, text and lines that are used in the production of
standard Lighting Special Sheet. (Conduit, Pull Boxes, Luminaries, etc.)

The Signals Icon

Settings-Large -

iY==

(=]
Imm-ﬂvﬁmmﬁm

The Signals Icon and pull down menu contains cells, text and lines that are used in the production of
standard Signals Special Sheet. (Conduit, Pull Boxes, Signals, Mast Arms, etc.)

The Signing Icon

Settings-Large - A~ @

COECEEDEa~ M )~

The Signing Icon contains cells, text and lines that are used in the production of standard Signing SpeC|aI

Sheet. (Signs)

The Signing Section Icon

Settings-Large -

Bmgﬁﬁmm.ﬂvﬁm@ﬁé

The Signing Section Icon contains cells, text and lines that are used in the production of standard Signing
Section Sheet. (Signs, Section Lines, Utility lines, etc.)

The X-Sections / Culverts Icon

Settings-Large - /-@

EDIEImmIﬂTﬁmj&m

=

The Cross/Culvert Section lcon contains cells, text and lines that are used in the production of standard
Cross Section and Culvert Section Sheet. (Flared End Sections, Pipes, Slopes, Cuts, Fills, etc.)
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10.4 The Settings Manager pull downs

File menu

File menu > Open

Select Settings [..\profile.st
Opens the Open Existing Settings File dialog box, which # : gs l-p ?]
is used to open a Settings Manager file. File Eate?nr}r Style  Options
Open...
. . Edit
File menu > Edit _ and Giid lines)
Motes (misc)
This option is “read only“ Symbols & Pattems
|kilitie:s

Category menu
Category menu > Scale

Opens the Select Scale dialog box, which is used to select a scale settings group and make its settings
active. This should typically match the scale of the border that is placed in the dgn file.

The list box lists the scale settings groups in the open settings file that have design units that match the
active design file's master units. Double-clicking a group makes its settings active and closes the dialog
box. Clicking OK makes the settings in the selected group active and closes the dialog box.

Select Scale
Pl Select Settings [.\profile.stq] ::i; -
File | Category | Style Options 1"=10 3
Group >cale.. ::..:ig
Draing  Working Units.., 1"=40
Lines | 15D
Motes (misc) 1"=60" -
Symbols & Pattems
Ltilities
| oK | | Cancel |

English Units

Category menu > Working Units

MoDOT does not use this option at this time.
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Style menu
Style menu > Dimension

Opens the Select Dimension Style dialog box, which is used to select a dimension style.

. . . M Select Dimension Style = &
e Name — Lists the name of the dimension style.
Mame Description -
L. . . . dim 1large 1 scale dim large note =
e Description — Describes the dimension style. dim 1 med 1 scale dim medium nate
dim 1 small 1 scale dim small note
. . . dim 5large 5 scale dim large note
e Load — Loads the selected style in MicroStation. dim 5med 5 scale dim medium note
dim 5 small B scale dim small note S
Load

Style menu > Multi-line

MoDOT does not use this option at this time.

» By MName
By Type

Sorts the component list by name.

Sort menu > By Name

» By Name

Sort menu > By Type By Bpe

Sorts the component list by type.

Options menu
Options menu > Large/Small Dialog
If the Select Settings window is not expanded, selecting Options > Large Dialog expands the window

interface. If the Select Settings window is expanded, selecting Options > Small Dialog returns the window
to a smaller, dockable window.

P Select Settings [..\user.stg] 2 |

File Category Style Sert Options
Group: Component:
[Drop Inlets ~| [DI-TypeD DI -]

The Settings Manager as a small dialog box.

s8]

Element Selection = ldentify element to add to set

| [DI-Type D DI -

IMLIE loaded.

Settings Manager’s small dialog box docked at the bottom of the MicroStation window.
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Options menu > Hide/Show Menu Bar

(Small, dockable Settings Manager window only) Hides the menu bar to conserve screen space. When the
menu bar is hidden, the name of this menu item changes to Show Menu Bar, which enables you turn the

menu bar back on. (On the smaller Settings Manager window, regardless of whether or not the menu bar
is showing, all the menus on the menu bar are still available through a right-click menu.)

ML Select Settings [.\user.stg]

S

File Category 5tyle Sort | Options

Hide Menu Bar
Large Dialog

[E)fop Tnlets -

]

Hide Menu Bar option.

M Select Settings [.\user.stg]

(et |

Group: Component: File 2
[Drop Iniets ~| [DI-Type D DI Category  *
Style 3
Sort 2
Options 3

Menus on the menu bar are still available through a right-click menu.

10.5 Groups & Components

Groups and Components work similar to a Directory file structure. Groups could be compared to

Directories and Components to files located with-in those Directories. Groups are given specific names
such as Drainage, Drop Inlets, etc. Some Groups have generic names as in Notes or Lines. Selecting the
Group will display that Groups contents in the Component window in the Settings Manager. Components
are cells, line-types, text, dimensions, area patterns, multi-lines, circles, etc. that have been given the
correct symbology such as level, color, and line weight and can be placed on the Design File at the correct

scale. Using the Settings Manager will create an easier way of
maintaining standards throughout the Districts.

Group
Lists the names of drawing Settings Manager groups in the open

Settings Manager file.
The selected group is the active drawing Settings Manager group.
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M Select Settings [..\user:stg] lﬂ
File Category Style Options
ﬁ
Growp ) -
== L
Crainage 1
Crop Inlets
Environmental
Flared End Sections {COMNC)
Flared End Sections (METAL) 57
/\ Sort:
Component Type -
NQLES " Bxist Linear =
CMP/RCP 12" New Linear 3
CMP/RCP 15" Exist Linear
CMP/RCP 15" New Linear
CMP/RCP 18" Exdst Linear
CMP/RCP 18" New Linzar
CMP/RCP 21" Exist Linear
CMP/RCP 21" New Linear
CMP/RCP 24" Exist Linear -
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Component

Lists the name and type of each component of the active drawing settings group. Selecting a component
does the following:

e All settings associated with the component are set as specified in the component definition.

e If aKey-inis defined for the component, the corresponding tool is selected, letting you place an
element(s) without using a tool box.

Selecting a Component with a single mouse button click will allow that item, whether it be text, a
dimension, line-style etc. to be placed on the correct level, color and weight. Using these components
also keeps the user from having to attach a cell library or look up what level items are to be placed, the
Settings Manager takes care of that, so that everyone is placing the same cells on the same levels. This
also keeps the user from having to set text heights, widths and spacing. Dimensions also work with the
Settings Manager setting the correct text attributes and arrowhead sizes.

Attributes @
[Rnadway—hlew w vl . 2 - ; 0 - E 6
P Select Settings [.\user.stg] = @] & | M Place SmartLine ==] = ]
File Category 5tyle Options Segmert Type:
Group e Vertex Type:
Property Rounding Radius: | 1.0000
RN )
Roadside . Join Elements .
Roadway
Safety | )
Signs./Signals 57
Sort:
Component Type -
Latitude/Longitude Line Linear
New Controlled Access Symbol Cell
New RAW Controlled Access Line Linear
New RAW Line Linear
New RAW Location Survey Marker Cell - —
New F/W Mo Right Access Linear E
New RAV Temp. Access Line Linear
New Temp. Access Symbal Cell
New Teminal Point Symbaol Cell 57

Selecting a Component with a single left mouse button click will set the Active Attributes to the item
selected. Selecting a Component will also invoke the suggested tool for that Component.
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Groups - CO - @

11.0 Groups tool box Mg 9

The tools in the Groups tool box are used to create and manipulate complex chains, complex shapes, and
graphic groups.

To Select in the Groups tool box

Break up a complex element(s) or an element(s) of a special type into L‘J :
simpler components. =

Drop Element

.

Discontinue an association between a shared cell, dimension witness line, Ay
or multi-line and another element.

Drop Association

=

Create a complex chain (open complex element).
Create Complex Chain

Create a complex shape (closed complex element) from individual open =\
elements.

Create Complex Shape

G‘rﬂps - 00 - @

9l S 2

l

11.1 Drop Element

P
N

N

"

Used to break up an element(s) into simpler components. Tool settings are used to specify the element
types on which the tool operates.

M Drop Element =] ¥ |

Complex
[] Dimensions

[7] Line Strings/Shapes

[T] Muttidines
Shared Cells
[] Text

[7] Application Blemerts
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Tool Setting

Complex

Dimensions

Line
Strings/Shapes

Multi-lines

Shared Cells

Solids

Text

Application
Elements

MicroStation V8i - Groups and Patterns

Effect

If on, complex elements (cell, complex chain, complex shape, text node, surface, or
solid) are dropped into their components.

If on, dimension element(s) are dropped into lines, line strings, ellipses, arcs, and text.
e To Geometry — Drops down lines, line strings, ellipses, arcs, and text.

e To Segment — Drops down individual dimension segments.

If on, line strings and shapes are converted to series of individual line elements.

If on, multi-line elements are converted to sets of line strings, lines, and/or arcs.

If on, the associated option menu lets you drop shared cells:
e To Geometry — They are dropped into their components.

e To Normal Cell — They are converted to unshared cells.

(3D only) If on, the associated option menu lets you drop SmartSurfaces or
SmartSolids:

e To Surfaces — They are dropped to simple surfaces.

e To Wireframe — They are dropped to wireframe elements.

If on, text characters in text elements are converted to the individual elements that are
used to draw the characters — lines, line strings, arcs, ellipses, and shapes.

If on, used to drop light weight geometry.
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To break up an element into its components
1. Select the element(s).
2. Select the Drop Element tool.

3. Turn on the appropriate tool settings to specify the element type(s) on which to operate.

M Drop Element (=]l 2 |

Complex
[C] Dimensions
[] Line Stings/Shapes

[ Muttidines
Shared Cells
[C] Text

[7] Application Blemerts

4. Accept the settings and initiate the drop.
Only the selected elements of the specified type(s) are dropped. The tool has no effect on
selected elements of other types. If none of the selected elements is of the specified type(s), the
message “Nothing to drop” displays in the status bar.
Alternative Method — To break up an element into its components
1. Select the Drop Element tool.
2. Turn on the appropriate tool settings to specify the element type(s) on which to operate.

3. Identify the element.

4. Accept the drop.

Drop Element cannot be used to drop elements more than one level at a time. For example, if you turn on
Complex and Line Strings/Shapes and operate on a complex shape that contains two line strings, the
complex shape is dropped but the component line strings are not so the operation results in two line
strings.

Dropping chain dimensions to individual dimensions can be #A Drop Element BRI

accomplished by checking the Dimensions setting and selecting “To ™

S ts” from the drop- down options ™. Complex s 2
egmen P pHONS- Dimensors 7 o Geanety [}

[ Line Strings/Shapes

[ Muttiines
Shared Cells
[ Tt

[ Application Elements
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11.2 Drop Association L(Ef)i S\

Used to discontinue an association point between a shared cell origin, dimension extension line vertex, or
multi-line vertex and another element. The association point is converted to a non-associative origin or
vertex with its own x-, y-, and (in 3D) z- coordinates. It is then independent of the other element. For
more information about association points, see Associating Elements.
To discontinue an association

1. Select the Drop Association tool.

2. ldentify the association point.

3. Accept the drop.
To discontinue all association points on an element(s)

1. Select the element(s).
2. Select the Drop Association tool.

3. Accept the drop.

To discontinue all associations in a fence contents
1. Keyin FENCE DROP ASSOCIATION.

2. Accept the drop.

11.3 Create Complex Chain — _
G

Used to create a complex chain — an open complex element that is formed from a series of open
elements (lines, line strings, arcs, curves, and open B-spline curves) that can be manipulated as if it were a
single primitive element. The resulting complex chain takes on the active element attributes regardless of
the attributes of the component elements.

M Create Complex Chain [=[/=! WS
Method: [Manual -

Simplify geometny
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Tool Setting Effect

Sets how elements are added to the complex chain:
e Manual — Each element is manually identified.

Method e Automatic — After the first element is identified, and accepted, if endpoints of
additional open element(s) are within the Max. Gap distance of each other, they
are included automatically. Where there is a choice of two or more elements (at
the endpoint of an element) then the process lets you choose to either Accept the
highlighted element, or Reset to see the alternative(s).

. The greatest allowable distance between elements when the Method is Automatic.
Max(imum)

Ga
P If zero, only elements that connect (have a common endpoint) can be added.

Simplify If on, connected lines are added as line strings. If you identify only connected lines, the tool
geometry |produces a primitive line string element rather than a complex chain.

To create a complex chain manually
1. Select the Create Complex Chain tool.
2. Setthe Method to Manual.
3. ldentify the first element to include in the chain.

4. Continue to identify elements to add to the chain.
If they are not already connected, the elements are connected as they are identified.

5. Reset to complete the complex chain.

To create a complex chain automatically
1. Select the Create Complex Chain tool.
2. Set the Method to Automatic.
3. Identify the first element.
4. Accept to automatically include other elements that are within the Max Gap distance. If a fork is

found, where more than one element is within the Max Gap distance, the message “FORK —
Accept or reset to See Alternate” displays in the status bar.
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5. Enter a data point to accept the highlighted element
or
Reset to highlight an alternate element. Continue to reset until the desired element highlights.

6. Accept to complete the complex chain. Creation of the chain ends automatically if there are no
elements within the Max. Gap.

N~

i
1 3

Create Complex Chain with Method set to Automatic. After entering data point 2, the top element in the
fork was highlighted (top). To highlight the alternate path, a Reset was entered (bottom).
To convert a complex chain back to its individual components, use the Drop Element tool.

It is best to create complex chains from elements that share common endpoints.

To draw a complex chain of connected arcs and line segments with one tool, use the Place SmartLine tool
in the Linear Elements toolbox.

Groups - CO - ’@
11.4 Create Complex Shape ey EQ:_’% )

A

Used to create a complex shape (a closed complex element that can be manipulated as if it were one
primitive element) from a series of open planar elements (lines, line strings, arcs, curves, and open B-
spline curves). The resulting complex shape takes on the active element attributes regardless of the
attributes of the component elements.

M Create Complex Shape (S [ 2/ 2 |

Area: | Solid -
Eill Type: [Outlined -
Fill Color
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Tool Setting Effect

Sets how elements are added to complex shape.
e Manual — Each element is manually identified.

Method e Automatic — After the first element is identified, and accepted, if endpoints of
additional open element(s) are within the Max. Gap distance of each other, they
are included automatically until a closed shape is created. Where there is a choice
of two or more elements (at the endpoint of an element) then the process lets you
choose to either Accept the highlighted element, or Reset to see the alternative(s).

. The largest distance allowed between consecutive elements, if Method is Automatic.
Max(imum)

Ga
P If zero, only elements that connect (have a common endpoint) can be added.

Simplify  [If on, connected lines are added to the boundary as line strings. If you identify only
geometry |connected lines, the tool produces a primitive shape element rather than a complex shape.

Sets the type of shape created.

e Solid — The shape created is solid (can be hatched/patterned).

Area
e Hole — The shape created is a hole (cannot be hatched/patterned).
Sets the active Fill Type.
e None — Nofill
Fill Type e Opaque — Filled with Active Color
e  OQutlined — Filled with Fill Color (outline of shape takes the Active Color)
Fill Color Complex shape is filled with this color if the Fill Type is Outlined; otherwise disabled

(dimmed).

To create a complex shape manually
1. Select the Create Complex Shape. tool.
2. Set the Method to Manual.
3. Identify the first element.

4. Continue to identify elements to add to the shape.
The elements are connected as they are identified, unless they already are connected.

5. If the first and last elements connect, accept the shape.

If the first and last elements do not connect, Reset to close the shape and create a line element
between their endpoints.
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To create a complex shape automatically

1.

Select the Create Complex Shape. tool.
Set the Method to Automatic.

Identify the first element.

Accept to automatically include other elements that are within the Max Gap distance.
If the elements do not have a common endpoint, they are connected.

If a fork is found; that is, if more than one element is within the Max. Gap, the message “FORK —

Accept or Reset to See Alternate” displays in the status bar.

Enter a data point to accept the highlighted element.
or

Reset to highlight an alternate element. Continue to Reset until the desired element highlights.

If an element is accepted that is connected to the first element identified, the complex shape is closed. If
an element is not found within the Max Gap, a line element is created between the open endpoints of the
first and last elements and the complex shape is closed.

To convert a complex shape back to its individual components, use the Drop Element tool.

To draw a complex shape of connected arcs and line segments with one tool, use the Place SmartLine
tool in the Linear Elements tool box.
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11.5 Hatching and Patterning

Patterning is the repeated placement of a hatch line or cell through a closed area at a specified interval
(spacing), scale, and angle. You can place patterns on any designated level.

When using a hatching or patterning tool with the tool setting Method set to Flood, Union, Intersection,
or Difference, turning on Dynamic Area along with Associative Pattern lets you create patterns that
regenerate themselves when their bounding elements are modified. As well, you can create single

associative patterns with disjoint regions.

Controlling the display of patterns

Elements — either lines or cells — in a pattern are designated as
pattern elements.

To turn the display of patterns on or off in one or more views

1. From the Settings menu, choose View Attributes.
The View Attributes dialog box opens.
or
In the view control bar, select the View Attributes icon or
the adjacent downward-pointing triangle.
The View Attributes dialog opens.

AQQLI&I@IH B G| oF [«

] TS @ % 2 X AT

Cirop from Graphic Group = |dentify element j,J No Elements Found

2. From the View Number option menu, choose the
number of the desired view.

3. Click on Patterns to turn on or off.

4. Repeat steps 2 and 3 for additional views.

To turn the display of patterns on or off in all views

1. From the Settings menu, choose View Attributes.
The View Attributes dialog box opens.

2. Turn Patterns on or off.

3. Click the All button.
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M View Attributes - View 1 =B X |

View Number: 1 - [y Bl

() Presentation M=
Display Style: (Wireframe Display) + Q
T ACS Triad = Fill
&4 Background HH Grid
511 Boundary Display & Level Overrides

Camera ? Line Styles
4p Clip Ba ?Line \Weights
&* Clip Front ? Pattern/Bump Maps

Clip‘u'olurne T Patterns
E Constructions ? Default Lighting
Dimensions S Tags
Iz‘ Data Fields T Text
K- Displaysst TText Nodes
[ Fast Cells @ Transparency
f-}._ Fast Curves
Global Brightness: ‘ 1 b gt
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11.6 Patterns tool box Patterns - C

A8 A2 IR

The tools in the Patterns tool box are used to pattern areas and along linear elements.

To Select in the Patterns tool box

;
4

Hatch Area

Hatch an area.

Crosshatch an area. ;%.t

Crosshatch Area

5

Pattern an area by tiling the Active Pattern Cell.
Pattern Area
Display the angle and scale attributes of a pattern element. —R‘

Show Pattern Attributes

Set the active pattern settings to match the attributes of an existing j
pattern element.

Match Pattern Attributes

x3

Delete patterning.

Delete Pattern
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11.7 Hatch Area C@@ﬁ ABIR

Used to hatch an area. Elements used to define the area to be hatched can
be in the active file, or in references. Where associative patterning is used,
any modification to elements defining the hatched area results in an
equivalent update to the hatching.

Tool Setting Effect

Determines the area that is hatched.

M Hatch Area =

2

® (&5 M

Spacing: | 1.0000
Angle: | 45° 3
Tolerance: | 0.0000
V| Associative Pattem
V| Associative Region Boundary
Snappable Pattem

B E %

Max Gap: | 0.0008
Text Margin: | 0.0000

e Element — The interior of a shape, ellipse, or closed B-spline curve; or

between components of a multi-line. —

e Fence — The area inside the fence.

e Intersection — Of two or more closed elements.

e  Union — Of two or more closed elements.
Method

e Difference — Between two or more closed elements.

e Flood — The (minimum) area enclosed by a set of elements (something like the
flood fill tool common in painting programs). With method set to Flood, a Show
Extended Information icon appears in the lower right corner of the tool settings

window. Clicking this icon expands the tool settings to display further controls.

e Points — An area defined by a series of data points, each of which defines a

vertex.

Spacing Sets the interval between hatching lines.

Sets the angle at which hatching lines are drawn. By default, the angle is relative to the
Angle view being used. Where AccuDraw is active, however, the angle is relative to the

AccuDraw drawing plane.

Tolerance
pattern.

Maximum distance between curved element and approximating line segments used to

If on, hatching is associated with the patterned element and is automatically updated

when the element is manipulated or modified. In other words, if the element is modified

later, the hatch lines are re-drawn to match the modified element.

Associative

Pattern If Method is Intersection, Union, Difference, or Flood, a complex shape that bounds the
patterned area is created, and the hatch lines are associated to the complex shape. If
you move or modify the original element(s), used to create the complex shape, the

complex shape is updated, along with the hatching.
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Associative
Region
Boundary

Snappable
Pattern

Ignore Interior
Shapes

Locate Interior
Shapes

Identify
Alternating
Interior Shapes

Locate Text

Dynamic Area

Alternating
Area

Max(imum) Gap

Search For
Holes

Use Element
Symbology

Fill Type

Fill Color
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(Associative Pattern on only) If on, hatching can be placed on a level other than the level
of the hatched element. If the Method is Intersection, Union, Difference, or Flood, a
complex shape that bounds the hatched area is created, and the hatching is associated
to the complex shape. If you move or modify the original element(s), used to create the
complex shape, the complex shape is updated, along with the hatching.

If on, hatching lines can be snapped to. If off, hatching lines do not interfere with
snapping to other elements.

(Method set to Flood only) If selected, interior shapes are ignored when the region
boundary is calculated.

(Method set to Flood only) If on, all closed elements (regardless of their Area attributes)
inside the selected area are avoided when the area is hatched.

(Method set to Flood only) If selected, alternating areas are hatched where shapes are
nested inside one another.

(Method set to Flood only) If on, any text or dimension text inside or overlapping the
selected area is avoided when the area is hatched.

(Method set to Flood only) If on, the area to be hatched displays dynamically as you
move the screen pointer over the shapes.

(Method set to Flood only, with Locate Interior Shapes on and Dynamic Area off) If on,
alternating areas are hatched where shapes are nested inside one another.

(Method set to Flood only) The maximum distance, in working units, between the
endpoints of enclosing elements.

(Method set to Element only) When creating a non-associative pattern, gives you
options for how hole elements are treated. You can ignore hole elements or search for
hole elements on the same level as the element to pattern, or on all levels displayed in
the view.

e No — Ignores hole elements.

e Element Level — Searches for hole elements on the same level as the element
to hatch.

e View Levels — Searches for hole elements on all levels displayed in the view.

If on, hatching is created using the active color, line weight, and line style of the element
being patterned

(Method set to Points only) Sets the active fill type for the closed shape defined by the
points — None (no fill), Opaque (filled with the active color), or Outlined.

(Method set to Points only) Sets the color and optional gradient with which the
elements are filled.

e If Fill Type is Opaque, the element(s) are filled with the active color, which is
also the color of the element's outline.

e If Fill Type is Outlined, the element(s) can be filled with a color that is different
from the active color.
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To hatch the area inside a closed element
1. Select the element.
2. Select the Hatch Area tool.
3. Set the Method to Element.

4. Enter a data point to define a point through which a hatch line must pass.
Elements that are inside the selected element and have the Area attribute Hole are hatched as

follows:
If Associative Pattern is Then Hole elements inside selected element
Off Are not hatched.
If they were grouped with the Solid element using the Group Holes
tool, they are not hatched and the hatching is associated with the
Hole elements as well as the Solid.
On

Otherwise, the area enclosed by any other element inside the
element, regardless of its Area attribute, is hatched, and no
associations are made to it.

Alternative Method — To hatch the area inside a closed element
1. Select the Hatch Area. tool.
2. Set the Method to Element.
3. Identify the element.

4. Enter a data point to define a point through which a hatch line must pass.

Hatching the area inside a closed element. Identify the element (1) and then enter a data point to define a
point through which a hatch line must pass. “A” denotes the Active Pattern Angle. “S” denotes the Active
Pattern Spacing.
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To hatch the fenced area
1. With the fence present, select the Hatch Area. tool.
2. Set the Method to Fence.
3. Enter a data point to define a point through which a hatch line must pass.
To hatch the intersection or union of closed elements
1. Select the Hatch Area. tool.
2. Inthe Tool Settings window, set Method to Intersection or Union.
3. Identify one element.
4. Identify another element(s).
As you accept each successive element, the edges that do not enclose the area to be hatched are

hidden. The resulting area is highlighted.
If the elements do not overlap, the following occurs, depending on the Method:

Method If elements do not overlap, then
Intersection |“Elements do not intersect” is displayed in the status bar.

Union All elements are hatched.

5. After you accept the last element, Reset to finish (or select a different tool).
The area is hatched. The final acceptance point defines a point through which a hatch line must
pass.

X
Z %

Identify one element (1), then another element (2), accept (3), and then Reset to finish.
Results with Method set to Intersection (left) and Union (right).
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To hatch the difference between elements

Select the Hatch Area tool.

Set the Method to Difference.
If any elements are selected, they are de-selected.

Identify the element from which to subtract.
Identify the element(s) to subtract from the element that was identified in step 3.

Accept the elements.
The area to be hatched is displayed dynamically.

Reset to finish. 1

w

J

With Method set to Difference, identify the first element (1) and the element to subtract (2), then accept

(3).

To hatch an area enclosed by bounding elements

1.

1114

Select the Hatch Area tool.
Set the Method to Flood.

(Optional) If you want the hatching to avoid closed elements, text or dimension text inside the
selected area, or you want to view the hatch area dynamically, click Show Extended Information
(lower right in the tool settings) and turn on Locate Interior Shapes, Locate Text, and/or Dynamic
Area.

Enter a data point in the area enclosed by the bounding elements. (To minimize the time
required, zoom in to the area of interest or select the bounding elements.)

The area to be patterned is displayed dynamically.

If there are selected elements, only selected elements are considered as possible bounding
elements. If no elements are selected, all elements in the view in which the data point is entered
are considered.

Accept the hatching.

The area is hatched. If Locate Interior Shapes and Locate Text is on, any inside closed element
(regardless of its Area attribute), text or dimension text is avoided. If Associative Pattern is on,
the hatch lines are associated to a complex shape created from the bounding elements and the
inside elements.
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A

SECTION A
2 |/

Enter a data point inside the bounding elements (1). Accept the hatching (2).
Results with Locate Text on (left), and Locate Interior Shapes on (right).

To hatch an area containing nested elements within the bounding elements

1. Select the Hatch Area tool.

2. Set the Method to Flood.

3. (Optional) Click Show Extended Information (lower right in the tool settings) and turn on Locate

Interior Shapes, and Alternating Area.

4. Enter a data point in the area enclosed by the bounding elements.

The area to be patterned is displayed dynamically.

5. Accept the hatching.

The areas are hatched alternately. If Associative Pattern is on, the hatch lines are associated to a
complex shape created from the bounding elements and the inside elements.

1
— 2

O O

/’

(a7}

7

<

/

Left: Enter a data point inside the bounding elements (1). Accept the hatching (2).

Right: With Alternating Area on, alternating enclosed areas are hatched or left blank.

To hatch an area defined by data points
1. Select the Hatch Area. tool.

2. Set the Method to Points.

3. Enter a data point to define each vertex of an imaginary shape that encloses the area.

The imaginary shape is dynamically displayed.

4. Reset to finish.
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Patterns - CO

11.8 Crosshatch Area _; 27

Used to crosshatch an area. Elements used to define the area to be crosshatched can be in the active
model, or in references. Where associative patterning is used, any modification to elements defining the
crosshatched area results in an equivalent update to the crosshatching.

The tool settings and procedures are the same as those for the Hatch Area tool, except that there are
additional fields to specify the Spacing and Angle of the crosshatch lines, in addition to those for the hatch
lines. Icons in the tool settings let you select the method for defining the area to be crosshatched.

Crosshatch Area. “A1” and “A2” denote the Active Pattern Angles.
“S1” and “S2” denote the Active Pattern Spacing.

"’{‘_]. Crosshatch Area EI =] @ﬁ
LAY EE L

[1.00004 1.0000
B Angle: | 45° = | 45" z
Tolerance: | 0.0000
Associgtive Pattem
[] Associative Region Boundary
[] Snappable Pattem

Search For Holes: | No -
[] Use Hement Symbology
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Tool Setting

Element icon

Flood icon

Union icon

Intersection icon

Difference icon

Points icon
Fence icon

Spacing

Angle

Tolerance

Associative
Pattern

Associative
Region Boundary
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Effect
The interior of a shape, ellipse, or closed B-spline curve; or between components of a

multi-line.

The (minimum) area enclosed by a set of elements (something like the flood fill tool
common in painting programs). With method set to Flood, a Show Extended
Information icon appears in the lower right corner of the tool settings window. Clicking
this icon expands the tool settings to display further controls.

Edges bound the union of two or more closed planar elements.

Where more than two elements are involved, use <Ctrl-data point> to select the extra
elements.

Edges bound the intersection of two or more closed planar elements.

Where more than two elements are involved, use <Ctrl-data point> to select the extra
elements.

Edges bound the difference of two or more closed planar elements.

Where more than two elements are involved, use <Ctrl-data point> to select the extra
elements.

An area defined by a series of data points, each of which defines a vertex.
The area inside the fence.
Sets the interval between the rows and the columns of the cross-hatching.

The angle at which instances of the crosshatch are placed. By default, the angle is
relative to the view being used. Where AccuDraw is active, however, the angle is
relative to the AccuDraw drawing plane.

Maximum distance between a curved element and the approximating line segments
used for crosshatching.

If on, crosshatching is associated with crosshatched geometry.

e If Method is set to Element, the crosshatching is associated with the
crosshatched element and is automatically updated when the crosshatched
element is manipulated or modified.

e If Method is set to Flood, Intersection, Union, or Difference, a complex shape
that bounds the crosshatched area is created, and the crosshatching is
associated with the complex shape. The crosshatching and the complex shape
are not automatically updated when the original element(s), used to create
the complex shape, are modified or manipulated.

(Available only when Associative Pattern is set)
If on, crosshatching is associated with the region boundary.

e If Method is set to Element, the crosshatching is associated with the region
boundary, which is the boundary of the crosshatched element, and is
automatically updated when the crosshatched element is manipulated or
modified.
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Snappable
Pattern
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Locate Interior
Shapes icon

Identify
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Dynamic Area
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Text Margin

Search For Holes

Use Element
Symbology

Fill Type

Fill Color
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e |f Method is set to Flood, Intersection, Union, or Difference, an associative
region that bounds the crosshatched area is created, and the crosshatching is
associated with the associative region. The crosshatching and the associative
region are automatically updated when the original element(s), used to create
the associative region, are modified or manipulated.

If on, crosshatched cells can be snapped to. If off, crosshatched cells do not interfere
with snapping to other elements.

(Flood icon selected only) If selected, interior shapes are ignored when the region
boundary is calculated.

(Flood icon selected only) If on, all closed elements (regardless of their Area attributes)
inside the selected area are avoided when the area is crosshatched.

(Flood icon selected only) If selected, alternating areas are crosshatched where shapes
are nested inside one another.

(Flood icon selected only) If on, any text or dimension text inside or overlapping the
selected area is avoided when the area is crosshatched.

(Flood icon selected only) If on, the area to be hatched displays dynamically as you
move the screen pointer over the shapes.

(Flood icon selected only) The maximum distance, in working units, between the
endpoints of enclosing elements.

(Flood icon selected only) Sets the size of the margin between hatching lines and
existing text elements in the area to crosshatch.

When creating a non-associative pattern, you can ignore hole elements or search for
hole elements on the same level as the element to pattern, or on all levels displayed in
the view.

e No — Ignore hole elements.

o Element Level — Searches for hole elements on the same level as the element
to hatch.

e View Levels — Searches for hole elements on all levels displayed in the view.

If on, hatching is created using the active color, weight, and style of the element being
patterned.

(Points method only) Sets the active fill type for the closed shape defined by the points
— None (no fill), Opaque (filled with the active color), or Outlined.

(Points method only) Sets the color and optional gradient with which the elements are
filled.

e If Fill Type is Opaque, the element(s) are filled with the active color, which is
also the color of the element's outline.

e If Fill Type is Outlined, the element(s) can be filled with a color that is different
from the active color.
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Patterns - CO

=

7 a2 @ o

4 %9@4 =X
M Pattern Area = | 19|

Used to pattern an area by tiling the Active Pattern Cell. Elements used to define & AT
the area to be patterned can be in the active file, or in references. Where . —
associative patterning is used, any modification to elements defining the Pattem:
patterned area results in an equivalent update to the patterning. o Sp:i::f ;Eggg”
Col_:mn Spacing: | 0.0000
Angle: | 07 2
Tolerance: | 0.0000
/| Associative Pattem
/| Associative Region Boundary

11.9 Pattern Area

Snappable Pattem
V| True Scale

b
Max Gap: | 0.0008
Text Margin: | 0.0000

Tool Setting Effect

Determines the area that is patterned.

e Element — The interior of a shape, ellipse, or closed B-spline curve; or
between components of a multi-line.

e Fence — The area inside the fence.

e Intersection — Of two or more closed elements.
Method e  Union — Of two or more closed elements.

e Difference — Between two or more closed elements.

e Flood — The (minimum) area enclosed by a set of elements (something like the
flood fill tool common in painting programs).

e Points — An area defined by a series of data points, each of which defines a
vertex.

Lets you key in the name of the cell that is tiled to create the pattern. Optionally, you
can click the Browse Cells button to the right of the input field, which opens the Cell
Library dialog box to let you browse the cells in the attached library, or you can attach a
cell library.

Pattern Cell

Browse Cells Opens the Cell Libraries dialog box for purposes of placement of a different active cell.

Scale Sets the factor by which the Active Pattern Cell is scaled.
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Column Spacing

Angle
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Associative
Pattern

Associative
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Boundary

Snappable
Pattern

Ignore Interior
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Identify
Alternating
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Locate Text

Dynamic Area

Max(imum) Gap

True Scale

Text Margin

Search For
Holes

Use Element
Symbology

Fill Type
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The interval between rows.
The interval between columns.

The angle at which instances of the active Pattern Cell are placed. By default, the angle is
relative to the view being used. Where AccuDraw is active, however, the angle is relative
to the AccuDraw drawing plane.

Maximum distance between a curved element and the approximating line segments
used for patterning.

If on, patterning is associated with a patterned element and is automatically updated
when the element is manipulated or modified. If the Method is Intersection, Union,
Difference, or Flood, a complex shape that bounds the patterned area is created, and
the patterning is associated to the complex shape. If you move or modify the original
element(s), used to create the complex shape, the complex shape is updated, along with
the patterning.

(Associative Pattern on only) If on, patterning can be placed on a level other than the
level of the patterned element. If the selected method is Intersection, Union, Difference,
or Flood, a complex shape that bounds the patterned area is created, and the patterning
is associated to the complex shape. If you move or modify the original element(s) used
to create the complex shape, the complex shape is updated, along with the patterning.

If on, patterning cells can be snapped to. If off, patterning cells do not interfere with
snapping to other elements.

(Flood method only) If on, all closed elements (regardless of their Area attributes) inside
the selected area are ignored when the area is patterned.

(Method set to Flood only) If on, all closed elements (regardless of their Area attributes)
inside the selected area are avoided when the area is patterned.

(Flood method only) If on, alternating areas are patterned where shapes are nested
inside one another.

(Method set to Flood only) If on, any text or dimension text inside or overlapping the
selected area is avoided when the area is patterned.

(Method set to Flood only) If on, the area to be patterned displays dynamically as you
move the screen pointer over the shapes.

(When Method is set to Flood) The maximum distance, in working units, between the
endpoints of enclosing elements.

If on, the active pattern cell is scaled to adjust it to the units of the active file. The scaling
occurs only if the cell is shared and the units of the file in which the cell was created
differ from those of the active file.

(Flood method only) Sets the size of the margin between pattern elements and existing
text elements in the area to pattern.

When creating a non-associative pattern, you can ignore hole elements or search for
hole elements on the same level as the element to pattern, or on all levels displayed in
the view.

If on, a pattern is created using the active color, weight, and style of the element being
patterned.

(Points method only) Sets the active fill type for the closed shape defined by the points
— None (no fill), Opaque (filled with the active color), or Outlined.
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(Points method only) Sets the color and optional gradient with which the elements are
filled.

e If Fill Type is Opaque, the element(s) are filled with the active color, which is

Fill Color also the color of the element's outline.

e If Fill Type is Outlined, the element(s) can be filled with a color that is different
from the active color.

To pattern the area inside a closed element

1.

Off

On

Select the element.
Select the Pattern Area tool.
Set the Method to Element.

Enter a data point to place the origin of one of the pattern cell instances.
Elements that are inside the selected element and have the Area attribute Hole are patterned as
follows:

If Associative Pattern is Then Hole elements inside selected element
Are not patterned.

If they were grouped with the Solid element using the Group Holes
tool they are not patterned and the pattern is associated with the
Hole elements as well as the Solid.

Otherwise, the area enclosed by any other element inside the
element, regardless of its Area attribute, is patterned, and no
associations are made to it.

Alternative Method — To pattern the area inside a closed element

1. Select the Pattern Area tool.
2. Set the Method to Element.
3. Identify the element.
4. Enter a data point to place the origin of one of the pattern cell instances.
\>\\> _@{\\>/\/\/\ At left, pattern cell EARTH is used to
4§//\\//\ K& pattern a complex shape. At right, the
NN PN : - ;
\//\é\//\ 7 outside block is also patterned with
\//\\//\\//\\ \\ EARTH. Since the inner block has the area
\>/\\\// far <\ attribute of Hole, the area inside it is not
K /\\//\\//\\// patterned.
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To pattern the fenced area
1. With the fence present, select the Pattern Area. tool.
2. Set the Method to Fence.

3. Enter a data point to place the origin of one of the pattern cell instances.

To pattern the intersection or union of closed elements
1. Select the Pattern Area tool.
2. Inthe Tool Settings window, set Method to Intersection or Union.
3. Identify one element.
4. Identify another element(s).
As you accept each successive element, the edges that do not enclose the area to be patterned

are hidden. The resulting area is highlighted.
If the elements do not overlap, the following occurs, depending on the Method:

Method |If elements do not overlap, then
Intersection |“Elements do not intersect” is displayed in the status bar.

Union All elements are patterned.

5. After you accept the last element, Reset to finish (or select a different tool).
The area is patterned. The final acceptance point defines a point through which a pattern line
must pass.
To pattern the difference between elements

1. Select the Pattern Area tool.

2. Set the Method to Difference.
If any elements are selected, they are de-selected.

3. Identify the element from which to subtract.

4. Identify the element(s) to subtract from the element that was identified in step 3.
The area to be patterned is displayed dynamically.

5. Reset to finish.
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To pattern an area enclosed by bounding elements

1.

Select the Pattern Area tool.
Set the Method to Flood.

(Optional) If you want the patterning to avoid closed elements, text or dimension text inside the
selected area, or you want to view the pattern area dynamically, click Show Extended
Information (lower right in the tool settings) and turn on Locate Interior Shapes, Locate Text,
and/or Dynamic Area.

Enter a data point in the area enclosed by the bounding elements. (To minimize patterning time,
zoom in to the area of interest or select the bounding elements.)

The area to be patterned is displayed dynamically.

If there are selected elements, only selected elements are considered as possible bounding
elements. If no elements are selected, all elements in the view in which the data point is entered
are considered.

Accept the patterning.

The area is patterned. If Locate Interior Shapes and Locate Text is on, any inside closed element
(regardless of its Area attribute), text or dimension text is avoided. If Associative Pattern is on,
the patterning is associated to a complex shape created from the bounding elements and the
inside elements.

To pattern an area defined by data points

1.

11.11 Show Pattern Attributes A 2 @j N

Select the Pattern Area tool.
Set the Method to Points.

Enter a data point to define each vertex of an imaginary shape that encloses the area.
The imaginary shape is dynamically displayed.

Reset to finish.

Patterns - C

Used to display the Pattern Angle and Pattern Scale attributes of a pattern element.

To display the angle and scale of a pattern element

1.

Select the Show Pattern Attributes. tool.

Identify the pattern element.
The element highlights, and its type and level display in the status bar.

Accept the element.
The pattern angle and scale are displayed in the status bar.
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11.10 Match Pattern Attributes ] @ﬁ 2 3

Used to set the active pattern settings (Angle, Scale, and Spacing) to match the attributes of a pattern
element in the DGN file.

To match the active pattern settings to those of an existing pattern element
1. Select the Match Pattern Attributes. tool.
2. Identify the pattern element.

3. Accept the pattern element.
The new active pattern settings are displayed in the status bar.

11-12 DEIEte Pattern Patterns - C

0 =
7, G I
Used to delete patterning. @ % j fase) @

To delete patterning

1. Select the Delete Pattern tool.

2. ldentify the patterning to delete or, in the case of associative patterning, the patterned element.

3. Accept the deletion.
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12.0 Text and Notes

Text
Text elements are useful for including labels other than dimensions in a design file.

As an element type, text differs in several ways from other types of elements. The following attributes
apply exclusively to text:

e  Fonts — Text is placed in the Active Font.

e Justification — Text is aligned in a specific way with respect to the data point that positions its
origin.

e  Text sizes (Height and Width) — Text characters have height and width.

Tw
(I
THIZZMi broStation Miaroddat ion MicroStatioy
< __Xirer Line First Line First Line
TTTSecond Line Secor%<l_‘ime Second L’m§<

Single (top) and Multi-line (bottom) text Justification. From left: Left Top, Center, and Right Bottom. The
origin is placed at the location of the pointer. TH denotes Text Height, TW denotes Text Width, and LS
denotes Line Spacing.

Notes

Included in the Text tools for MicroStation are Note placement tools which allow the user to label
geometry or elements within the design file by using a block of text with a leader. Note placement tools
represent a hybrid between text and dimensions with the text portion of the note being controlled by the
Text Styles settings and the arrow and leader portion of the note being controlled by the Dimension Styles

settings.

/fNE]TE WITH LEADER

/
/" MULTI-LINE NOTE

/ WITH LEADERj

’ \
\
\
1

Single line note with leader (top). Multi-line note with leader (bottom), right justified and right side leader
placement option set for bottom line.
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12.1 Text Styles
'_' pw:\\ghpwise10:MoDOT\Documents\Central Officel!
File Edit | Element | Settings Tools Utilities \
The Text Styles dialog box provides an interface for working with text styles  : [RoadwayNey 3D and E-spline - =
. . . =y Cells
and for setting active text attributes. T = .
k i ! Dimension Styles hics]
s o Detailing Symbol Styles
Text Styles ) \“_» Line Styles 8
2, — Multi-line Styles
MicroStation V8 supports text styles and provides an interface for Y ,
constructing text using available system fonts and a wide variety of text .
) . . By, A
attributes. A text style comprises a group of text attributes, such as font "
ﬁ \&r— Element Templates

type, width, height, and color. Once set up and stored with all necessary

oo | -
attributes, a text style allows the user to produce text with these preset N M, @ Information Sl
attributes simply by activating that text style. & =

M Text Styles - Style (none) = | (|
Style  View
= o = ﬂ
NE S| XYealf
Teut Styles General | Spacing " Under/Overine || Background || Advanced |
Style none) _
Fort: (33 3 MoDOTEng. = | [7] Calor: H 5 ~
Height: | 6.0000 & { Bold
Width: | 6.0000 L [ talics
Slart: {0¢ [[] Undedine
Justification [Center Center ~| [] Overine
[] Fractions
[ Vertical
[ Full Justfication

NOTE: At this time MoDOT has not set up any standard text styles. It is the intent of CADD Support to
utilize this option and create a library of text styles for the Department’s users. When this library is set up
and becomes available this section of the manual will be updated to reflect these changes.

Users can create their own custom text styles and save them within the design file. For more information
on text styles see the Contents section under the Help menu.

The Text Styles dialog box also utilizes icon driven functions that parallel the menu options at the top of
the dialog box. Most of these functions deal with the creation or manipulation of text styles, however the
icon on the far right toggles the text style preview on or off. This preview provides the user with a visual
aid that reflects changes in text attributes
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Text Attributes

MicroStation employs an extensive and advanced set of text options that are categorized under a series of
tabs on the Text Styles dialog box. To change an attribute simply access the corresponding tab and make
any necessary modifications. Once the changes have been made any new text entered will take on those
new attributes.

General Tab
= — = rA | AN
|| General |Spacing ” Under/Overing ” Background " Advanced |
Fort: (2333 MoDOTEng. = | [C] Color: H 5 -~
Height: | 6.0000 _ﬁ i Eold
Width: | 6.0000 1 [ talics
Slart: | 0 [ Underine
Justification [Center Canter - | [] Owerdine
[] Fractions
[ Vertical

[ Full Justification

None

Font
Sets the Active Font for text when placed.
Height & Width

Sets the Active Text Height and Active Text Width, in working units, of text upon placement. When lock
icon is “locked” the height and width are forced to the same measurement.

Slant

Sets the angle, in degrees, by which text is slanted when placed. This setting is only available if the /talics
check box to the right of the General Tab is checked.

Justification (Single-Line & Multi-Line)

Sets the position of text relative to its origin (the position where the data point is entered) when using the
Place Text tool.

Color

If on, activates the color picker to select the color of the text when placed.
Bold

Bold text when placed, if on.

1202



MicroStation V8i - Text and Notes

Italics

Italicize text when placed, if on.

Underline

Underline text when placed, if on.

Overline

Place a line over the text when placed, if on.
Fractions

If on and using a MicroStation resource font, numeric characters separated by a slash (/) are placed as
single characters (numerator over denominator).

Vertical
Orient text vertically when placed, if on.
Full Justification

If on, perform full text justification. Full justification adjusts word spacing so that no word is hyphenated
to complete a line of text.

Spacing Tab = R = S B
] |Gener.:|| I Spacing | Under/Overline ” Background " Advanced |
Line Spacing: | 0.83 [ Fixed Spacing
Line Spacing Type: [Exact - ] || Backwards
Intercharacter: | 0.00 [7] Upside Down
Line Offset X | 0.00 [~] Super Script
Line Offset Y: | 0.00 [7] Sub Script

None

Line Length

Sets the Active Line Length or the maximum number of characters per line in a multi- text element (text
node).

Line Spacing
Sets the Active Line Spacing or the vertical spacing in working units, between:
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e Linesin a multi-line text element (text node) when it is placed.

e Text and an identified element, when the Place Text tool is used with any of these Methods:
Above Element, Below Element, or Along Element.

Line Spacing Type
Set the type of vertical spacing between lines of text using the following methods:

e Exact (DGN workmode only) - The distance to the next line is calculated as: Top of line + Line
Spacing + the baseline. (Baseline is determined by the arrangement origin of the text (upper left)
+ the height of the tallest character.)

When the Vertical text style setting is on, the distance between lines of vertical text is calculated
as: Current line origin + the maximum width of characters in the line + Line Spacing.

The Exact method does not account for extreme variance in descender depth. To get the line
spacing that you want, try adjusting the line spacing value.

e Automatic (DGN workmode only) - The distance to the next line is calculated as: Top of line + Line
Spacing + baseline. (Baseline is determined by the arrangement origin of the text (upper left) +
the height of the tallest character.)

When the Vertical text style setting is on, the distance between lines of vertical text is calculated
as the maximum of either Line Spacing or the maximum width of characters in the line.

The Automatic method does not account for extreme variance in descender depth. To get the
line spacing that you want, try adjusting the line spacing value.

e From Line Top - For horizontal and vertical text, the distance to the next line is calculated as: Top
of line + Line Spacing.

This method is analogous to the AutoCAD Exactly line spacing setting. It provides rigid control
over line spacing, and is generally used for table-based text. However, since the spacing does not
vary, the lowest point on one line may overlap the top of the next line.

e At Least - The distance to the next line is calculated as: 1/3 of the maximum height of a character
+1/3 of the node number height + the lowest point of the text * Line Spacing. When the Vertical
text style setting is on, the same rules apply, except that the distance is between the left side of

one line of text and the left side of the following line of text.

This method is analogous to the AutoCAD At Least line spacing setting. It is variable, data
dependent, and uses Line Spacing as a factor, not a distance.

Intercharacter

Set the distance, in working units, between characters in text when placed. The preference Fixed-Width
Character Spacing controls the manner in which the specified distance is measure.
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Line Offset X

Control the spacing, in working units, between placed text and the position from which the text is drawn
in X.

Line Offset Y

Control the spacing, in working units, between placed text and the position from which the text is drawn
inY.

Fixed Spacing

Use Inter Character Spacing value to set the distance from the start of one character to the start of the
next character, rather than between characters.

Backwards

Reverse the orientation of text horizontally when placed, if on.
Upside Down

Reverse the orientation of text vertically when placed, if on.
Super Script

Set placed text with superscript characteristics, if on.

Sub Script

Set placed text with subscript characteristics, if on.

Under/Overline Tab

— © o e .
General | Spacing I Under/Overing | Background ” Advanced

Underline Overine
Offset: | 0.00 Offset: | 0.00
Use Style Below
Color Color
Style: | 0 -] Style: [ i -]
Weight: | 0 -] Weight: [ i -]

Underline

Underline text when placed, if on.
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Use Style Below (Underline)

Activates the Offset, Color, Style and Weight settings for underlining Text Styles.

Offset (Underline)

Control the spacing, in working units, between the base of the text and the underlining.
Color (Underline)

Set the type of underline color. Only applies when Underline is on.

Style (Underline)

Set the type of underline used when text is placed. Only applies when Underline Style is on.
Weight (Underline)

Set the thickness of underline used when text is placed. Only applies when Underline style is on.
Overline

Place a line over the text when placed, if on.

Use Style Below (Overline)

Activates the Offset, Color, Style and Weight settings for overlining Text Styles.

Offset (Overline)

Control the spacing, in working units, between the height of the text and the overlining.
Color (Overline)

Set the type of overline color. Only applies when Overline style is on.

Style (Overline)

Set the type of overline used when text is placed. Only applies when Overline Style is on.
Weight (Overline)

Set the thickness of overline used when text is placed. Only applies when Overline style is on.
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— .

- T | E—. |
Background Tab | General " Spacing ” Under/Overine I Background |Advanced

Fill Color:

Background Border:

Cffzet X: | 0.50
Offset ¥ | 0.50

Color; [1] -

Styte: [ 0 -]
Weight: [ 0 hd ]

Nond

Background

If on, enables a background for the active text. The remaining controls are enabled only while Background

is on.

Fill Color

Sets the fill color of the background when text is placed.
Background Border Offset X

Sets the thickness of the background along the sides of the text box.

Background Border Offset Y

Sets the thickness of the background along the top and bottom of the text box.

Background Border Color
Sets the color of the border around text when placed.
Background Border Style
Sets the style of the border around text when placed.

Background Border Weight

Sets the weight of the border around text when placed. Line weights range from 1 to 15 in working units.
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Advanced Tab

— - - —3
|Gener:i| ” Spacing " Under/Overine " Background | Advanced

Library Sty
File Name

General

Faont

Shx Big Font
Height

\width

None
False

c\pwise_local\d0129197PP_J550929_|

=] MoDOT Eng.
]

6.0000

6.0000

30°

Sl

-~

The Advanced Tab contains a series of configurable controls that allow the user to customize individual
text attributes. For additional information see the Contents option under the Help menu.

Controlling the display of text

Using the View Attributes dialog box (Settings > View
Attributes), you can turn off the display of the text itself

or numbers and symbols.

To turn on or turn off the display of text in a view

1. From the Settings menu, choose View

Attributes. (or press <CTRL-B>).
or

From any view window's control menu, choose

View Attributes.

The View Attributes dialog box opens.

2. From the View Number option menu, choose

the number of the desired view.

3.  Turn on or turn off the Text attribute.

4. (Optional) Repeat steps 2 - 3 for additional

views.
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M View Attributes - View1
View Number: 1 ~ |&y B

Lj Presentation
Display Style:

T, ACS Triad
4 Background

=1i Boundary Display

v

Clip Back
Clip Front

[
cnpvomn»e

1M Constructions

Dimensions
[1sz] D2tz Fielas

K- Displayset
(] FastCells

"’-}_ Fast Curves
Global Brightness:

E view Setup

(Wirsframe Display)

Fill
= Grid
&'j Level Overrides

Line Styles

= Line Weights

. Fattern/Bump Maps

Patterns

8- Default Lighting
Tags

Text

Y% Text Nodes
@ Transparency
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12.2 Entering and Editing Text

Unless it is already open, the Text Editor window opens when you select a text placement or editing tool.
Input from the letter keys and arrow keys on the keyboard is treated as text input until you press the
<Esc> key, select another tool, or click the Key-in window.

M Text Editor - Word Processor \EI = @
7 Key-in [E3 woboTEw~] B 7 U € al- W 1 - @~ o [ B
TEXT] T | | | | | | I | I
a
task = [fast
template off
[ lon
teatstyle —  |slow
teatstyleset = |toggle

thaw

M Text Editor ===

The three types of Text Editors; from left to right, Key-in, WYSIWYG, Word Processor, and the Dialog Box.
You can choose the Editor from the Workspace pull down. Choose Preferences and then Text.

Basic text editing functions

You can edit text in the Text Editor window (and in text fields in MicroStation dialog boxes) using these
functions:

e New textis placed at the insertion point, which is indicated by a vertical bar. You can click within
the text to place the insertion point, and then you can use any available method for Moving the

insertion point.

e Inthe default insert mode, new characters are inserted at the insertion point. Also, overwrite
mode, in which each new character overwrites an existing character, is available.
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Moving the insertion point

You can move the insertion point in the following ways:

To move
Right one character
Left one character
Up one line
Down one line
To the beginning of the line
To the end of the line
Up to the previous window
Down to the next window
To the next word
To the previous word
To the beginning of the text
To the end of the text

Selecting text

You can select text in the following ways:

To

Select a range of text

Select a word

Select all text

Increase a selection

Increase selection by one character
Decrease selection by one character
Increase selection by one word

Decrease selection by one word

Deselect text
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Press this key
<>
<>
<>
<>

<Home>
<End>
<Page Up>
<Page Down>
<CTRL->>
<CTRL-¢>
<CTRL-Home>
<CTRL-End>

Do this
Drag through the desired text

Double-click before the first character of the word

Double-click after the last character of the word

Double-click within the word
Press <CTRL-A>
Shift-click a point beyond the selected text
Press <SHIFT-—->>
Press <SHIFT-<>
Press <CTRL-SHIFT-->>
Press <CTRL-SHIFT-<&>

Click anywhere in the Text Editor window

Press <->>

Press <&>
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Editing text

The available text editing functionality is as follows:

To
Delete previous character or selected text
Delete next character or selected text
Delete previous word
Delete next word
Cut selected text
Copy selected text
Paste selected text

Toggle between insert mode and overwrite mode

To replace text in the Text Editor window
1. Select the text.
2. Type the new text.
The typed text replaces the selected text.
To move text in the Text Editor window

1. Select the text.

Text and Notes

Do this
<Back Space>
<Delete>
<CTRL-Back Space>
<CTRL-Delete>
<SHIFT-Delete> or <CTRL-X>
<CTRL-Insert> or <CTRL-C>®
<SHIFT-Insert> or <CTRL-V>’

<Insert>

2. Right-click and choose Cut from the pop-up menu .

or
Press <CTRL-X>

3. Place the insertion point at the desired location for the moved text.
If you want to replace text, you can select the text to be replaced.

4. Right-click and choose Paste from the pop-up menu.

or
Press <CTRL-V>
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To copy text in the Text Editor window
1. Select the text.
2. Right-click and choose Copy from the pop-up menu .
or

Press <CTRL-C>

3. Place the insertion point at the desired location for the copy of the text.
If you want to replace text, you can select the text to be replaced.

4. Right-click and choose Paste from the pop-up menu .
or
Press <CTRL-V>
To insert a new line in the Text Editor window

1. From the Text tool box, select the Place Text tool.

2. Inthe Text Editor window, press <Enter>.

To create an enter data field in the Text Editor window
1. From the Text tool box, select the Place Text tool.

2. Inthe Text Editor window, type the enter data field character once for each character in the
enter data field. By default, “_" is the enter data field character.
or
Key in a matched pair of field delimiters. To leave an empty enter data field with a certain
number of enter data field characters, you can type that number of spaces within the delimiters
or you can type text between the delimiters.

3. (Optional) Use the JUSTIFY. (Justify Enter Data Field) key-in to change the justification.
When created, MicroStation left justifies all enter data fields.
Searching for and replacing text
You can search all text in a design file for a sequence of letters and numbers, and you can specify a text

search for single character fractions. Also, you can replace some or all instances of text with other text.
Also, you can append and prepend text while retaining an original string.
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To search for text in a design file

1.

2.

(Optional) To search for text only in a certain part of the design file, place a fence and set the
appropriate fence search criteria.

From the Edit menu, choose Find/Replace Text
The Find/Replace dialog box opens.

ﬂFind!Replacetext EI [=] @

Find: ||

Replace:
— Find Options
Match Case Wheole Words
Use Regular Expressions In Cellz

Inside

— View Options
| Animate Rotate

¥] Zoom g

Pick

In the Find field, type the text for which you want to search.

(Optional) To search for text with special characteristics, perform one of the following:

To find only text with the same capitalization as the text in the Find field (case-sensitive), turn on
Match Case.

To find only complete words that match the text in the Find field, turn on Whole Words.

To use special characters in the Find field, turn on Reg. Expr.

To search for text in cells, turn on In Cells.

To search for text with fractions, turn on Fractions.

Click Find.
The first placement in the design file of the specified text in the Find field is displayed in the view
in which you entered the last data point.

To find the desired text, continue clicking the Find button.
An information box confirms that all text in the design file has been searched. If text matching
the specified text is not found, the search resumes at the beginning of the design file.

To find and replace text in a design file

(Optional) To search for text only in a certain part of the design file, place a fence and set the
appropriate fence search criteria.

From the Edit menu, choose Find/Replace Text.
The Replace Text settings window opens.

In the Find field, key in the text to replace.

From the Change option menu, choose Replace.
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In the With field, key in the replacement text.
To delete text that matches the text in the Find field, you can leave the With field blank.

(Optional) To search for text with special characteristics, turn on one of the following check
boxes:

— Match Case

— Whole Words

— Reg. Expr.

— In Cells

— Fractions

To execute a search, perform one of the following:

— To examine the first instance of text that matches the specified text, click Find.

— To replace text, click Change.

— To replace all text that matches the specified text, click Change All.

— To replace all text elements that match the current Fence search criteria, click Change Fence.
— To examine additional instances of matching text, continue clicking Find.

To replace text in a known location in the design file

1214

(Optional) To search for text only in a certain part of the design file, place a fence and set the
appropriate fence search criteria.

From the Edit menu, choose Find/Replace Text.
The Replace Text settings window opens.

In the Find field, key in the text to replace.
From the Change option menu, choose Replace.
In the With field, key in the replacement text.

(Optional) To search for text with special characteristics, turn on one of the following check
boxes:

— Match Case

— Whole Words

— Reg. Expr

— In Cells

— Fractions

Click Change Single.

Identify a text element.
Any matching text found in the text element is replaced.
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Window controls for the Word Processor Text Editor

Used to create and modify the text in the text window of the Word Processor Text Editor window. Opens
when you select the Place Text tool from the Text tool box.

M Text Editor - Word Processor ol & ==
[E3 WooTea~] B I U “€ 4} - W 1 - &~ s P L

@
| | | | | | | | | |
a

Text Editor Icon Bar

Contains the controls that create and modify the text style of the text in the text window of the word
processor Text Editor window. For more information, see the Text Editor Icon Bar.

Find <CTRL-F>

Choosing Find from the right-click, pop-up menu, opens the Find dialog box.
Select All <CTRL-A>

Choosing Select All from the right-click, pop-up menu, selects all text.

Cut <CTRL-X>

Choosing Cut from the right-click, pop-up menu, cuts the selected text.
Copy <CTRL-C>

Choosing Copy from the right-click, pop-up menu, copies the selected text.
Paste <CTRL-V>

Choosing Paste from the right-click, pop-up menu, pastes the text on the Clipboard to the location of the
pointer.

<CTRL-B>

If pressed with the pointer in the text window, bolds the selected text.
<CTRL-I>

If pressed with the pointer in the text window, italicizes the selected text.
<CTRL-U>

If pressed with the pointer in the text window, underlines the selected text.
<CTRL-Z>

If pressed with the pointer in the text window, undoes the previous operation.
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12.3 Text tool box A 7 B a0 e )

The tools in the Text tool box are used to place text, modify existing text elements, and fill in enter data

fields.

To

Place text in the design.

Edit a text element to replace, add, or delete characters.

Change selected text-specific element attributes of a text or tag element(s).

Place a note.

Fill in or change enter data fields in a view.

Review text elements for spelling errors.

Fill in all enter data fields in a view.

Used to search all the text in a file for any sequence of letters and numbers
and replace some or all instances of the text with other text.
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Select in the Text tool box

A
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B
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Edit Text
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Change Text Attributes

oA

Place Note

Fill In Single Enter Data
Field
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Y

Spell Checker

Excel to MicroStation

=

?-./-
Find & Replace
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12.4 Place Text 1

U Place Text o] @ ==
Used for the following: Method: (ByOrgn ]
Text Stye: QY
Active Angle: | 0.0000° =
e Placing a text element(s) Height: (00180 2
Width: [0.0180 | =
e Selecting and modifying a text style(s). -
Fort: |3 ™ 3 MoDOTEnc~
Justification:
Line Spacing: | 0.750000
Interchar Spacing: | 0.000000
Text Node Lock
Tool Setting Effect
Sets how the position, scaling, and rotation of text is determined (see below).
e By Origin — At the Active Angle and the active text settings.
e Fitted — Text is stretched to fit between two data points. The vertical
alignment of the text is determined by the active Justification.
e View Independent — At the Active Angle and the active text settings.
Once placed, text stays at the same orientation regardless of the view
rotation.
e  Fitted V(iew) I(Independent) — Combines fitted and view
independent views.
e Above Element — Above a line segment
Method

at the active text settings
at the same angle as the segment at a distance equal to the Active
Line Spacing.

Below Element — Below a line segment

at the active text settings

at the same angle as the line segment at a distance equal to the
Active Line Spacing.

On Element — On a line or segment of a line string, shape, B-spline
curve, or multi-line at the active text settings.

Along Element — Along — above or below — an element (curve, B-
spline curve, arc, ellipse, line, line string, or shape). Each character is
placed as a single text element that is a component of a graphic
group. The characters are placed at the active text settings a distance
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Text Style
Magnifying Glass icon

Active Angle

Height
Width

Font

Justification

Line Spacing

Interchar(acter) Spacing

Apply changes to all text

(only shows up in Word
Processor mode)
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equal to the Active Line Spacing.

e Word Wrap — (Available only if Word Processor is selected in the
Preferences dialog box, Text category, Text Editor Style option menu.)
Allows you to contain text within a box, once a box is identified. If a
word is entered that exceeds the limit of the box, that word drops to
the next line.

Sets the current text style from a list of all available text styles.
Opens the Text Styles dialog box which is used to create and modify text styles.

Sets the angle, in degrees, at which text is placed, when Method is By Origin or
View Independent.

Sets the text height, in working units.
Sets the text width, in working units
Sets the Active Font.

Controls the text alignment. Options are Left Top, Left Center, Left Bottom,
Left Margin Top, Left Margin Center, Left Margin Bottom, Center Top, Center
Center, Center Bottom, Right Margin Top, Right Margin Center, Right Margin
Bottom, Right Top, Right Center or Right Bottom.

Sets spacing between identified element and text, when Method is Above
Element, Below Element, or Along Element (only visible when Method is Along
Element).

Sets spacing between the characters, when Method is Along Element.

e If on, applies style changes to all text in the Text Editor window. For
example, if you key in text in the Text Editor, then click the Bold icon,
all text becomes bold.

If off, applies style changes to selected text in the Text Editor window,
or to new text. For example, if you key in text in the Text Editor, then
click the Bold icon, only selected text becomes bold. Any new text will
also be bold.

To place text at the Active Angle and active text settings

1. Select the Place Text tool.
The Text Editor window opens if it is not already open.

2. Set the Method to By Origin or View Independent.

3. (Optional) Adjust the size of the text by changing the Height and Width settings. Setting Width to
three-quarters of Height generally produces the desired appearance with traditional
MicroStation fonts.

4. Inthe Text Editor window, type the text.
As you move the pointer, the text displays dynamically.

5. Enter a data point to position the origin of the text element.
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6. Return to step 5 to place another instance of the same text.

or
X O(\/R
&

Return to step 4 to place other text.
K AN

o)

Place Text with Method set to By Origin or View Independent

To place fitted text

1. Select the Place Text tool.
The Text Editor window opens if it is not already open.

2. Set Method to Fitted or Fitted V(iew) I(ndependent).
3. Inthe Text Editor window, type the text.
4. Enter a data point to define the left end of the fitted text.

5. Enter a data point to position the right end of the text and define the height, width, and rotation
angle.

6. Return to step 4 to place another instance of the same text.
or
Return to step 3 to place other text.

2
Et
}

-~ :
-
-
-~ -
O

t-

Place Text with Method set to Fitted or Fitted VI
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To place text above or below an element

1. Select the Place Text tool.
The Text Editor window opens if it is not already open.

2. Set Method to Above Element or Below Element.
3. Inthe Text Editor window, type the text.
4. Identify the line segment. The data point positions the left-to-right origin of the text element.

5. Accept the text.

Place Text with Method set to Above Element (left), Below Element (right), and “L” denotes Active Line
Spacing.

To place text on an element

1. Select the Place Text tool.
The Text Editor window opens if it is not already open.

2. Set the Method to On Element.

3. Inthe Text Editor window, type the text.

4. Identify the element on which to place the text. The origin of the text element is placed at this
point.

The text displays.

5. Accept the text.
The part of a line, line string, B-spline curve, or shape that is under the text is deleted. A multi-

line is not modified. \

2
ey, b
W

S

Place Text with Method set to On Element

1220



MicroStation V8i - Text and Notes

To place text along an element

1. Select the Place Text tool.
The Text Editor window opens if it is not already open.

2. Set the Method to Along Element.

3. Inthe Text Editor window, type the text.

4. Enter a data point along the element to position the origin.
The text displays both above and below the element. If the text is too long to fit along the
element with the current Inter-char(acter) Spacing, it is truncated.

5. If necessary, adjust the Inter-character Spacing.

6. Enter a data point to position the text either above or below the element.

Place Text with Method set to Along Element, “L” denotes Line Spacing and “S” denotes Inter-character
Spacing.

12.5 Edit Text

Used to edit text in a text or dimension element to replace, add, or delete characters. Text Justification is
preserved if the text is lengthened or shortened.

) Edit Text =] = (==
ot Sy (Sepone) __~] R

Height: [0.0180 3
Width: [0.0180 |
Fort: | 3 ™ 3 MoDOTEng ~

4,
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Tool Settings Effect

(Text Editor Style preference set to Word Processor) Sets the current text style from a

Text Style list of all available text styles. To create a new text style, click the Magnifying Glass icon

next to the Text Style option list to open the Text Styles dialog.

Magnifying Glass |(Text Editor Style preference set to Word Processor) Opens the Text Styles dialog which

icon is used to create and modify text styles.
Reset Style Removes text style override(s) and resets the style to its previously saved version.
e If on, applies style changes to all text in the Text Editor window. For example,

if you key in text in the Text Editor, then click the Bold icon, all text becomes

Apply changes to bold.

all text o If off, applies style changes to selected text in the Text Editor window, or to
new text. For example, if you key in text in the Text Editor, then click the Bold
icon, only selected text becomes bold. Any new text will also be bold.

Height (Text Editor Style preference set to Word Processor) Sets the text height, in working

& units.
Width (Text Editor Style preference set to Word Processor) Sets the text width, in working

units

Sets the Annotation Scale Lock. When this lock is on, the annotation scale is applied to

Annotation Scale |any text that is placed in the model.
Lock icon The annotation scale is set in the Model Properties dialog. It defines the scale for text

and dimensioning in the model.

Font (Text Editor Style preference set to Word Processor) Sets the Active Font.
To edit tex:
1. Select the Edit Text tool.
2. ldentify the text.
The Text Editor window opens, with the text already highlighted.
3. Inthe Text Editor window, make the desired changes to the text. To start a new text line while
typing in the edit field, press <Enter>.
4. To accept the changes, enter a data point in a view.
or
Identify another text element in the design.
> Double-clicking a text element with the Element Selection tool pointer activates the Edit Text
tool and opens the Text Editor window.
> If the Text Editor Style preference (Workspace > Preferences, Text category) is set to Dialog Box,
you must first accept the identified text (step 2) before it will display in the Text Editor window.
> If the Text Editor Style preference is set to Dialog Box, to apply the changes (step 4), click Apply
or press <alt-A>.
» Asingle-line text element is changed to a text node if a line is added to it.
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» The procedure for editing dimension text differs from that for editing regular text in the following

ways:
[ )

(Step 2) If the Text Editor Style preference is set to Dialog Box, a special dialog, the
Dimension Text dialog opens for editing the text.

(Step 3) All text that is generated from the geometry of the dimension element is
marked in the editor by asterisks (*). All text that was previously edited displays in the
fields.

Text placed before or after the asterisk precedes or follows the text that is generated
from the dimension's geometry.

If the asterisk is deleted or replaced, then the text displayed in the dimension element is
whatever is keyed in the field.

(Step 4) If using the Dimension Text dialog, to apply the changes, click OK.

» Dragging the handle of a selected text element with the Element Selection tool pointer modifies

the text:

12.6 Change Text Attributes A L8y e 20 Ma

To change the aspect ratio of the area in which the text resides, drag a corner handle.
This may cause the text to rewrap; the text need not have been placed using the Word
Wrap method for rewrapping to occur.

To scale the text, drag either the top, bottom, left, or right handle.

Used to change selected text-specific element attributes of a text or tag element(s). Tool settings controls
are used to specify the new attribute settings. The controls are similar to those in the Text Styles dialog
box (Element menu > Text Styles) and, as do the controls in the Text Styles dialog box, change the active

text attributes.

Q} Change Text Attributes EI = @
] Text Style: |Style (none) | Q

Use Fence: | Inside - -
V| Font: |3 ™ 3  MoDOTEng =
] Height: | 0.0180
¥ Width: | 0.0180
v Line Spacing: | 0.750000
V| Line Space Type: |BExact -
ilnterchar. Spacing: | 0.000000
Slant: | 0.0 Disable -
Underine: |Disable
Vertical: |Disable
View: [Dependent =
dustfication:

4,
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Tool Setting Effect
Text Style Sets the current text style from a list of all available text styles.

Magnifying Glass icon |Opens the Text Styles dialog box that is used to create and modify text styles.

Use Fence If on, the selected attributes of the fence contents are changed.
Font If on, sets and changes element(s) to active Font.
Height If on, sets and changes element(s) to active Text Height.
Width If on, sets and changes element(s) to active Text Width.
Line Spacing If on, sets and changes element(s) to active Line Spacing.
Interchar(acter) . . .
Spacing If on, sets and changes element(s) to active Intercharacter Spacing setting.
Slant If on, sets and changes element(s) to active Slant setting.
Line Length If on, sets length of the text line for the text editor.
. If on, sets and changes element(s) to active Underline setting — choose Enable

Underline .

(on) or Disable (off).

. If on, sets and changes element(s) to active Vertical Text setting — choose Enable

Vertical .

(on) or Disable (off).

If on, determines the effect of rotating the view on the orientation of the text:

e Dependent — Rotating the view will rotate the text.
View
e Independent — Text will stay at the same orientation regardless of the
view rotation.

Justification If on, sets and changes element(s) to active Text Justification.

To change a text or tag element'’s attributes (those that are set to On)

1. Select or fence the text or tag element(s).
2. Select the Change Text Attributes tool.

3. Accept the change.

Alternative Method — To change a text or tag element'’s attributes (those that are set to On)

1. Select the Change Text Attributes tool.
2. Identify the text or tag element.

3. Accept the change
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12.7 Place Note A B A A ) A %Q

Used to place lines of text with a leader line and arrow, or a callout without a leader.

'@ Place Mote EI = @

®
Text Style: [Style inone} ] Q&
Dimension Style: ||H| Style:fnone) '| Q P
Text Botation: | Horizontal s
Text Frame: |None -

Height: (00180 [ 2
Width: [0.0180 |

Location: | Automatic -

Leader Type: [Lne |

Start At: [Teminator ]

Horizontal Attachment : Ate |
Indine Leader

Associztion

Place Note tool in Place Note mode

Tool Settings Effect

Sets the tool mode to Place Note. Used to place lines of text with a leader line

Place Note . .
and arrow, as a dimension element.

Sets the tool mode to Place Callout. Used to place lines of text with a callout, as
a dimension element.

(NOTE: This option does NOT apply for MoDOT because there are no defined
text styles).

Place Callout

Text Style

(NOTE: This option does NOT apply for MoDOT because there are no defined

Dimension Style . .
y dimension styles).

Sets the rotation of the text relative to the leader line: Horizontal, Vertical, or
Text Rotation In Line.
The default is value is set by the dimension style (Text category).

Sets the type of frame (if any) — None, Line, Box, Rotated Box, Circle, Capsule,
Text Frame Hexagon, Rotated Hexagon, Triangle, Pentagon, or Octagonal.
The default is value is set by the dimension style (Text category).

Sets the text height, in working units.

Height The default is value is set by the text style.

Sets the text width, in working units.

Width
! The default is value is set by the text style.

Annotation Scale Lock

icon (We do not use Annotation Scale at MoDOT).
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Apply changes to all text
(Only functional in Word
Processor Mode)

Location

Leader Type

Start At

Horizontal Attachment

In-line Leader

Association

To place a note:
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If on, applies style changes to all text in the Text Editor window. For example, if
you key in text in the Text Editor, then click the Bold icon, all text becomes
bold.

If off, applies style changes to selected text in the Text Editor window, or to
new text. For example, if you key in text in the Text Editor, then click the Bold
icon, only selected text becomes bold. Any new text will also be bold.

Determines whether the leader line can be placed with multiple segments.
Manual, you can place multiple segments.

Automatic, you can only place one segment of a leader line.

The default setting is set by the dimension style (Placement category).

Sets the type of leader: Line or Curve.

Controls how the note is placed:

Terminator — If selected, the first data point that you enter places the end of
the terminator, and the last data point places the text.

Text — If selected, the first data point that you enter places the text, and the
last data point places the end of the terminator. You can place multiple leaders
on a single piece of text by holding the <Ctrl> key down. Each data point you
select (after the first data point), places an additional leader on the text.

Sets the leader attachment side: Auto, Left or Right.

If on, uses an in-line leader. The in-line leader is an extra segment of the leader
that aligned with the text.

Turning this off and setting Start At to Text enables a note to be placed without
a leader.

If on, snapping to the element being dimensioned causes an association point
to be created.

If off, no associations are created.

Association is active only when the Association lock is on.

1. Select the Place Note tool.
The Text Editor window opens if it is not already open.

2. Type the text in the Text Editor window.
If there is no text in the Text Editor window, only the leader line and arrow are placed.

3. Enter a data point to position the terminator arrowhead.

4. Enter a data point.
If Location (Dimension Settings dialog box) is set to Automatic or Semi-Automatic, this data point
indicates the location of the end of the leader line and text, and ends the note.
If Location is set to Manual, you can enter more data points to define additional vertices of the
leader line. Reset to end the note.
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TEXT 1 TEXT 1 TEXT 1
1 TEXT 12 TEXT 12 TEXT 12
TEXT 1 TEXT 1 TEXT 1 TEXT 1
TEXT 12 TEXT 12 TEXT 12 TEXT 12

Place Note. Top row, from left: Text Frame set to None, Line, Box. Bottom row: from left: Text Frame set to
None and Justification set to Left, Right, Dynamic with data points resulting in left-justified text, Dynamic
with data points resulting in right-justified text.

12.8 Fill Single Enter Data Field

Used to fill in or change an enter data field. The field's justification (left, center, or right) determines the
text position in the field.

To fill in an enter data field
1. Select the Fill In Single Enter Data Field tool.
2. ldentify the enter data field. A rectangle is drawn around the enter data field and the field
contents display.
The Text Editor window opens if it is not already open.

3. Inthe Text Editor window, key in the new contents for the enter data field.

4. Press <Enter> and the previous field contents are replaced

> Values longer than the enter data field length are truncated. To change the length of an enter
data field, use the Edit Text to

12.9 Spell Checker

$ Spell Checker [ = || = (23]

Usze Fence: |[Inside -

Used to review text, text nodes, tags, dimensions, notes and symbols for spelling errors.

For every unrecognized word, Spell Checker offers a list of suggestions. You can choose to change the
flagged word with one of the suggested words, or to leave it as is by clicking the Ignore button. If you
want Spell Checker to automatically ignore certain words that it normally might flag, such as a product’s
name or an abbreviation, you can add them to a special user dictionary.
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M Spell Checker =] @ | 2

Eror Word: 10

DEPARMENT Zoom Factor: [ [E] ¢

Change To:

DEPARTMENT [ lonoe | oAl |

Suggestions - | Change || Change Al |

DEPARTMENT E

DEPARTMENTS [ Add | Suggest |

DEPORTMENT

DEPARTMENTAL = || Dictionary || Stop |
Tool Settings Effect

Use Fence

If on, the fence contents are checked for spelling errors. The option menu sets the Fence
(Selection) Mode

To search for and correct spelling errors in an entire file:

Select the Spell Checker tool.
Identify element or accept to scan whole file displays in the status bar.

Click on an empty area in the design file to scan the entire file.

If there are no misspelled or unrecognized words in the selected text, the status bar displays the
message, “Spelling Check Complete.” If there are misspelled or unrecognized words, the
erroneous text zooms in and theSpell Checker dialog opens with the flagged word highlighted in
the Not in dictionary field, and the first word from the Suggestions list box displayed in the
Change to field.

If you are satisfied with the word in the Change to field, click Change.

or

Make another selection from the Suggestions list box and click Change.

or

Type a new word in the Change to field and click Change.

The text from the Change to field replaces the highlighted text, and the search advances to the
next unrecognized word in the Not in dictionary field. After the last flagged word is modified,
replaced or skipped, the Spell Checker dialog closes, and any changes made to the selected text
are updated in the design file.

To search for and correct spelling errors in a text element, text node, tag, dimension, note or symbol

1.
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Select the Spell Checker tool.
Identify a text element, text node, tag, dimension, note or symbol.

Accept the selected text.

If there are no misspelled or unrecognized words in the selected text, the status bar displays the
message, “Spelling Check Complete.” If there are misspelled or unrecognized words, the
erroneous text zooms in and the Spell Checker dialog opens with the flagged word highlighted in
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the Not in dictionary field, and the first word from the Suggestions list box displayed in the
Change to field.

If you are satisfied with the word in the Change to field, click Change.

or

Make another selection from the Suggestions list box and click Change.

or

Type a new word in the Change to field and click Change.

The text from the Change to field replaces the highlighted text, and the search advances to the
next unrecognized word in the Not in dictionary field. After the last flagged word is modified,
replaced or skipped, the Spell Checker dialog closes, and any changes made to the selected text
are updated in the design file.

If more than one word in a text node is flagged, the text node is not updated (in the design file)
until the last flagged word in it is modified, replaced or skipped.

To search for and correct spelling errors in a selection set

1.

Create a selection set.
or
From the Edit menu, choose Select All.

Select the Spell Checker tool.

Accept the selection set.

If there are no misspelled or unrecognized words in the selection set, the status bar displays the
message, “Spelling Check Complete.” If there are misspelled or unrecognized words, the
erroneous text zooms in and the Spell Checker dialog opens with the flagged word highlighted in
the Not in dictionary field, and the first word from the Suggestions list box displayed in the
Change to field.

If you are satisfied with the word in the Change to field, click Change.

or

Make another selection from the Suggestions list box and click Change.

or

Type a new word in the Change to field and click Change.

The text in the Change to field replaces the flagged word in the design file, and the search
advances to the next unrecognized word in the selection set. After the last flagged word in the
selection set is modified, replaced or skipped, the Spell Checker dialog closes.

To search for and correct spelling errors within a fence contents

1.

2.

Place a fence.

Select the Spell Checker tool.
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From the Spell Checker tool settings window, turn on Use Fence, and select a Fence Mode
(Inside, Overlap, Clip, Void, Void Overlap or Void Clip).

Accept the fence contents.

If there are no misspelled or unrecognized words in the selection set, the status bar displays the
message, “Spelling Check Complete.” If there are misspelled or unrecognized words, the
erroneous text zooms in and the Spell Checker dialog opens with the flagged word highlighted in
the Not in dictionary field, and the first word from the Suggestions list box displayed in the
Change to field.

If you are satisfied with the word in the Change to field, click Change.

or

Make another selection from the Suggestions list box and click Change.

or

Type a new word in the Change to field and click Change.

The text in the Change to field replaces the flagged word in the design file, and the search
advances to the next unrecognized word in the selection set. After the last flagged word in the
selection set is modified, replaced or skipped, the Spell Checker dialog closes.

To search for and correct spelling errors before placing text in a design file

1.

Select the Place Text tool.
In the Text Editor window, type the text you want to place in the design file.

Click the Spelling button.

ABC
s i
If there are no misspelled or unrecognized words in the selected text, the status bar displays the

message, “Spelling Check Complete.” If there are misspelled or unrecognized words, the
erroneous text zooms in and the Spell Checker dialog opens with the flagged word highlighted in
the Not in dictionary field, and the first word from the Suggestions list box displayed in the
Change to field.

If you are satisfied with the word in the Change to field, click Change.

or

Make another selection from the Suggestions list box and click Change.

or

Type a new word in the Change to field and click Change.

The text from the Change to field replaces the highlighted text, and the search advances to the
next unrecognized word in the Not in dictionary field. After the last flagged word is modified,
replaced or skipped, the Spell Checker dialog closes, and any changes made are then reflected in
the Text Editor window.

To add the currently flagged word to the user dictionary

You will not be able to add words to the standard MoDOT dictionary. If there is a word that needs to be
added, contact CADD Support for assistance.
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To delete a word from the user dictionary

You will not be able to delete words to the standard MoDOT dictionary. If there is a word that needs to
be removed, contact CADD Support for assistance.

12.10 Excel To MicroStation
(Quantab) A L84 oA el 2

The next to last tool icon on the Text toolbar activates the MicroStation portion of the Quantab
application. Quantab is an application that allows MoDOT’s MicroStation users to transfer information
that is input within a specific template in Microsoft’s Excel spreadsheet program over into MicroStation.
This provides users with a tool so that they can use Excel to build quantity boxes or other information
boxes and take advantage of how easy it is to input text as well as its ability to perform calculations then
simply transfer this information directly into MicroStation with all text and geometry conforming to
MoDOT standards.

For additional information on Quantab, including full instructions on usage, see CADD Support’s intranet
page.

12.11 Find and Replace Text —

Used to search all the text in a DGN file for any
sequence of letters and numbers and replace some or all instances of the text with other text. Opens
when Find/Replace Text is chosen from the Edit menu.

The Find/Replace Text functionality supports dimensions, tags, text, text nodes, notes, symbols. Selections
sets are also supported. The Find and Replace fields remember the last 20 items entered; an auto-
complete menu is provided as you type.

Clicking the plus or minus signs for Find Options and View Options expands or collapses that section of the
dialog.

When working in a read-only file, only find and view options are enabled; replace options are not
available.

.“.Find!RepIacetext EI [=] @

Find: |

Replace:
— Find Options
Match Case Wheole Words
Use Regular Expressions In Cellz
Inside
— View Options

V| Animate Rotate

7| Zoom g

Pick
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Find

The Find field specifies the search string to be located. It searches for an exact match but is not case-
sensitive, unless overridden by the selection of other options on the dialog. The search runs left to right,
top to bottom across the screen, beginning in the top left corner. If there is a cluster of text in one section
of the design and you start the find inside that cluster, the search is completed in that cluster before
moving on to the rest of the design.

Replace
The Replace field specifies the replacement string that replaces the search string in the Find field. This
field is case-sensitive and replaces the string exactly as entered.

Match Case
If on, performs a case-sensitive search of your search string; that is, finds only text with the same
capitalization as the text in the Find field.

Whole Words

If on, specifies a search for only complete words that match the text element in the Find field. For
example, when Whole Words is on, a search for “fill” will not find “filled” or “fillet.” Each instance of the
search string must be surrounded by a blank space on each side.

Use Regular Expressions
Regular expressions consist of patterns that can be used to search for variable forms of text. If on, treats
the search string as a regular expression for special characters and advanced search patterns.

In Cells
If on, specifies a search for text in cells, as well as standalone text.

Use Fence
If on, specifies a search for text in a fence. The option menu sets the Fence (Selection) Mode

Animate
If on, shows the transition from the current view to the destination. You are automatically panned and
zoomed to the text so that you can see it in context.

Rotate
If on, the view rotates so that the text displays horizontally.

Zoom
If on, view zooms to the specified text (and activates the slider). When the slider is set to the right end
(smaller zoom factor), the result is greater zooming (text appears larger).

Find
Locates the next instance of the text.
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Replace

Replaces the found text in the currently highlighted element with the replacement string.

Replace All
Replaces all the specified text elements in the design file.

Pick
Launches a tool that allows you to pick individual elements and to do the replace operation immediately
upon picking.
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Measure - CO 2
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13.0 Measure tool box

The tools in the Measure toolbox are used to perform measuring operations.

To

Measure the distance(s) along an element.

or

Measure the cumulative distance from a data point.

or

Measure the perpendicular distance between an element and a data point.
or

Measure the minimum distance between two elements.

Measure the radius of a circle, circular arc, cone, or cylinder, or the axes of an

ellipse or elliptical arc.

Measure the angle between two lines.

Measure the length of an element.

Measure the area and perimeter of a shape, ellipse, or complex shape and to
analyze mass properties.

1300
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13.1 Measure Distance

Used to measure distance.

MicroStation V8i — Measuring Elements & Shapes

Measure - CO

M Measure Distance

Between Points -

Distance

Mode
Distance
Accumulated Distance

ol ® &=

#. Measure Distance EI = @
Between Points
Along Element
Perpendicular
Minimum Between
Maximum Between

Made
Distance
Accumulated Distance

Tool Settings

2 Mea

Distance

=lleEd
Di e | Between Points -

g » e
Duos ks
Accumulated Distance Gt

Effect

Sets the method of distance measuring.

Distance °

Between Points — Measures the cumulative distance from an origin.

Along Element — Measures along an element from an origin.

Perpendicular — Measures the perpendicular distance between an element

and a data point.

Minimum Between — Measures the minimum distance between two elements.
Maximum Between — Measures the maximum distance between two elements.

Sets how measurements for distances are calculated.

Mode °

Distance

Accumulated
Distance

True — Measures the true distances in 3D, taking into account the depth component in
the view.

View — Measures distances between projections of the elements on to the view plane
(no allowance for the depth component).

AccuDraw/ACS — Measures distances between projections of the elements on to the
AccuDraw drawing plane, or on to the active ACS.

Displays the result of the last measurement.

(Distance set to Between Points only) Displays the total distance measured.

(Distance set to Perpendicular only) If on, the measurement is constrained to be perpendicular

Segment Only

to the selected segment of the element, or the projection of the segment.
If off, the perpendicular measurement is taken from the nearest segment of the selected

element.
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To measure the cumulative distance from an origin
1) Select the Measure Distance tool.
2) Inthe tool settings window, set Distance to Between Points.
3) Enter a data point to identify the origin (the point from which to measure).

4) Enter a second data point.
The Distance and Accumulated Distance fields display the same distance.

5) Enter another data point(s). The cumulative distance from the origin is displayed in the Accumulated
Distance field, while the Distance field displays the distance between the last two data points.
or
Reset to return to step 3.

To measure the distance along an element

1) Select the Measure Distance tool.

2) Inthe tool settings window, set Distance to Along Element.

3) Identify the element at the origin (the point from which to measure).

4) Enter a data point to define a point along the element. The distance from the origin along the element is
displayed in the status bar.
If the element is closed, this data point defines the direction (clockwise or counterclockwise) in which
measurements are made.

5) Enter a data point(s). The distance along the element from the origin is displayed in the Distance field.

or
Reset to return to step 3.

To measure perpendicular distance from an element

1) Select the Measure Distance tool.

2) Inthe tool settings window, set Distance to Perpendicular.

3) Turn off Segment Only.

4) Identify the element.

5) Enter a data point.
The perpendicular distance between the nearest part of the element and this point is displayed in the
Distance field. A temporary “line” is displayed as a visual aid but is not placed in the design.

6) Enter another data point(s) to define other perpendicular measurements.

or
Reset to return to step 4.
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To measure perpendicular distance from a segment of an element

1)

2)

Select the Measure Distance tool.

In the tool settings window, set Distance to Perpendicular.
Turn on Segment Only.

Identify the element at the segment that is to be used.

Enter a data point.

The perpendicular distance between the element and this point are displayed in the Distance field. A
temporary “line” is displayed as a visual aid but is not placed in the design. If the data point is not within
the limits of the selected segment, then the projection of the segment is used.

Enter another data point(s) to define other perpendicular measurements.

or

Reset to return to step 4.

If the element is a line string, shape, curve, complex chain, or complex shape, the distance is measured
perpendicular to the segment identified in step 3.

To measure the minimum distance between elements

1)

13.2 Measure Radius

Select the Measure Distance tool.

In the tool settings window, set Distance to Minimum Between.

Identify the first element.

Identify the second element.

Accept the elements.

The minimum distance between the elements is displayed in the Distance field. A temporary “line” is

displayed as a visual aid but is not placed in the design.

To construct a minimum distance line between two elements, use the Construct Minimum Distance Line
tool in the Linear Elements toolbox.

Used to measure:

The radius of a circle or circular arc.

The radius of a cone or cylinder.

The primary and secondary axes of an ellipse or elliptical arc.

The radius of a circular segment or axes of an elliptical segment of a complex chain or complex shape

# Measure Radius (=] = || 2

Primary Radius:
Primary Diiameter:
Secondary Radius:

Secondary Diameter:
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To measure an element's radius
1) Select the Measure Radius tool.
2) Identify the element or segment.

3) Accept the element.
The measurement displays in the status bar.

e To dimension an element's radius, use the Element Dimensioning tool.

Measure - CO

.

13.3 Measure Angle between Lines

Used to measure the angle between two lines or segments of a line string, shape, or multi-line. If the identified
lines do not intersect, an intersection point is computed to serve as the vertex of the measured angle.

M Measure Angle Between Lines o || = )| ER ‘u Measure Angle Between Lines EI = @
Mode: (Tue < j—— b Ine
Angle: B he
' AccuDraw/ACS
Tool Settings Effect
Mode Sets how measurements for the angle are calculated. Options are True, View, and AccuDraw/ACS.
Angle Displays the result of the angle measured.

To measure the angle between two lines
1) Select the Measure Angle Between Lines tool.
2) Identify the first line.
3) Identify the second line.

4) Accept the lines.
The angle measurement is displayed in the status bar.

1304


mk:@MSITStore:C:\Program%20Files\Bentley\Documentation\MicroStation.chm::/ustnhelp1128.html#P1C3D6

MicroStation V8i — Measuring Elements & Shapes

13.4 Measure Length

ﬁMeasureLength E =] @

1.000000
Mags Properties
Display Centroid

Mode: [True Y:I——
Length:
Direction:

Tolerance (%)

Measure - CO ]
P ?] —_— -
s O — A a—

Used to measure the length of an element(s) and to analyze mass properties. For a closed element or a surface,
the length of the perimeter or wireframe geometry is measured.

M Measure Length =

=

1.000000
Mags Properties

Tolerance (%):

Display Centroid
» True

View

Direction: Coobian e

23

Tool Settings

Effect

When measuring curves, the maximum percentage of the distance between the true curve and the

Tolerance (%)

increases calculation time.

Mass

approximation used to measure. A low Tolerance makes the measurement more accurate but

If on, the Mass Properties window displays the mass property analysis.

Properties

Display

Centroid displayed.

If on, a graphic crosshair that represents the center of mass for the measured element(s) is

Sets how measurements for the length are calculated.
e True — Measures the true distances in 3D, taking into account the depth component in
the view.

Mode °

View — Measures distances between projections of the elements on to the view plane (no
allowance for the depth component).

e AccuDraw/ACS — Measures distances between projections of the elements on to the
AccuDraw drawing plane, or on to the active ACS.

Length

Angle Of Line |Displays the result of the last angle measured.

Displays the result of the last length measured.

To measure the length of an element

1) Select the element.

2)

Select the Measure Length tool.

The length displays in the status bar. If Mass Properties is on, the mass properties are displayed in the
Mass Properties window.

Alternative Method — To measure the length of an element(s)

1) Select the Measure Length tool.
2) Identify the element.
3) Accept the element.

The length displays in the status bar. If Mass Properties is on, the mass properties analysis is displayed in
the Mass Properties window.
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Measure - CO B

13.5 Measure Area DA TS

Used to measure area and perimeter.

‘H- Measure Area EI = @
Method: | Element hd

Tolerance (%) | 1.000000
Mass Properties
Display Centroid

Mode: (Tue =

frea Unit: (Square” =)
Area:

Permeter Unit: [Survey Feet -
Perimeter:

Tool Settings Effect

Sets the area that is measured.

e Element — Area of one closed element (its Area attribute must be Solid).

e Fence — (Fence present only) Area enclosed by the active fence, other than a named
fence, or a fence created from an element.

e Intersection — Area bounded by the intersection of two or more closed planar

elements.

e  Where more than two elements are involved, use <Ctrl-data point> to select the extra
elements.

e Union — Area bounded by the union of two or more closed planar elements.

Method e Where more than two elements are involved, use <Ctrl-data point> to select the extra

elements.

e Difference — Area bounded by the difference between two or more closed planar
elements.

e Where more than two elements are involved, use <Ctrl-data point> to select the extra
elements.

e Flood — Area enclosed by elements that either touch one another or whose endpoints
fall within the Maximum Gap.

e Points — Planar area with its vertices defined by a series of data points. Where the
points are input in a figure 8 type shape, then the total area of the two loops is
calculated.

For curves, sets the maximum percentage of the distance between the true curve and the
Tolerance (%) |approximation used to measure. A low Tolerance makes the measurement more accurate but
increases calculation time.

Mass Properties |If on, the mass property analysis displays in the Mass Properties window.
Display Centroid |If on, a graphic crosshair that represents the measured element's center of mass is displayed.

Sets how measurements for area are calculated.

e True — Measures the true distances in 3D, taking into account the depth component in
the view.

e View — Measures distances between projections of the elements on to the view plane
(no allowance for the depth component).

Mode
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e AccuDraw/ACS — Measures distances between projections of the elements on to the
AccuDraw drawing plane, or on to the active ACS.

Sets the units used to display the last area measured.
e square <master units>
Area Unit e square m — (Metric units only) Square meters.
e Acre (US) — (English units only)
e Hectare — (Metric units only)

Area Displays the result of the last area measured.
Perimeter Unit |Sets the units used to display the perimeter length for the last area measured.
Perimeter Displays the perimeter length for the last area measured.

Locate Interior |(Method set to Flood only) If on, the area enclosed by the bounding elements is calculated,
Shapes minus the area of any closed elements inside the bounding area.

(Method set to Flood only) If on, the area to be included displays dynamically as you move the

Dynamic Area . .
screen pointer over the view.

(Method set to Flood only) Sets the largest distance allowed between consecutive elements. If

Max(imum) Gap
zero, the elements must connect to bound an area.

To measure the area and perimeter of one element

1) Use the Element Selection tool to select the element.

2) Select the Measure Area tool.

3) Inthe tool settings window, set Method to Element.

4) Accept the element.

The element's Surface Area, and Perimeter, are displayed in the tool settings window.

Alternative Method — To measure the area and perimeter of one element

1) Select the Measure Area tool.

2) Inthe tool settings window, set Method to Element.

3) Identify the element.
The element's Surface Area, and Perimeter, are displayed in the tool settings window.

To measure the area defined by a fence
1) Use the Place Fence tool to place a fence.
2) Select the Measure Area tool.
3) Inthe tool settings window, set Method to Fence.

4) Accept the fence contents.
The fence's Surface Area, and Perimeter, are displayed in the tool settings window.

1307


mk:@MSITStore:C:\Program%20Files\Bentley\Documentation\MicroStation.chm::/ustnhelp120.html#F38571
mk:@MSITStore:C:\Program%20Files\Bentley\Documentation\MicroStation.chm::/ustnhelp640.html#F39619

MicroStation V8i — Measuring Elements & Shapes

To measure the area of the intersection or union of closed elements

1)

2)

6)

Select the Measure Area tool.
In the tool settings window, set Method to Intersection or Union.
Identify one element.

Identify another element.
The resulting area is highlighted.

(Optional) Use <Ctrl-data point> to select further elements.
As you identify each successive element, the resulting area is highlighted.
If the elements do not overlap, the following occurs, depending on the Method:

Method If elements do not overlap, then
Intersection |“Elements do not intersect” is displayed.

Union Each element is highlighted.

After selecting the last element, accept to view the result.

The results display in the tool settings window. When measuring a union, the Perimeter value does not
display if the elements do not overlap. If Mass Properties is on, the mass properties analysis is displayed in
the Mass Properties window.

To measure the area of the difference between elements

1)

2)

Select the Measure Area tool.

In the tool settings window, set Method to Difference.
If any elements are selected, they are de-selected.

Identify the element from which to subtract.

Identify the element to subtract from the element identified in the preceding step.

(Optional) Use <Ctrl-data point> to select further elements to subtract.

Accept with a data point.

The results display in the tool settings window. When measuring a union, the Perimeter value does not

display if the elements do not overlap. If Mass Properties is on, the mass properties analysis is displayed in
the Mass Properties window.

To measure the area enclosed by elements that touch

1)

(Optional) Select the elements.
Select the Measure Area tool.
In the tool settings window, set Method to Flood.

(Optional) If you want to exclude, from the total measurement, the area of any closed elements inside the
selected area, turn on Locate Interior Shapes.
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5) Enter a data point in the area enclosed by the bounding elements.

6) Accept the elements.
The results display in the tool settings window. If Mass Properties is on, the mass properties analysis is
displayed in the Mass Properties window.
To measure an area defined by data points
1) Select the Measure Area tool.

2) Inthe tool settings window, set Method to Points.

3) Enter a data point to define each vertex of an imaginary shape that encloses the area.
The imaginary shape is dynamically displayed.

4) When done, Reset.
The results display in the tool settings window. If Mass Properties is on, the mass properties analysis is

displayed in the Mass Properties window.
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14.0 Using References

Elements in a reference file display as though they are geometry in the active design file. Although you
cannot manipulate or delete the elements displayed in a reference file, you can snap to them and even
copy them into the active design file.

The most common usage of references is in the creation of design compositions. Engineers and other
technical professionals use design compositions to communicate through the visual content of their
designs.

To create a design composition using MicroStation, you build a design file consisting of a working
collection of references used in the performance of particular engineering tasks. For example, you may

attach as references a collection of survey points as a guide for placement of additional geometry.

e [tis sometimes convenient to refer to one part of a design file while drawing in another area by
attaching the active design file to itself.

14.1 References dialog box

Used to attach and detach referenced models, adjust reference settings and select reference tools. Opens
when the Reference icon is selected in the Primary Tools toolbox or when File > Reference. is chosen.

ﬂ References (1 of 1 unique, 1 displayed) EI = @
Tools  Settings

E-Bxe £26¢RAP 0 Ak D 1% @ 5 Hre e [k )

St ¥ (4 File Name Model Description Logical Presertation [« .J & __-,|
2 PW_WORKDIR:dms01525\MoDOT_DE_2008.dgn Default border border Wireframe A

Scale | 1.000000 : | 1.000000 Rotation | 0° Offzet X | 0.0000 Y (0.0000

ml;—, 1‘ i H B £ A |No Nesting > | |Alow Ovemides | Depth: |1 MNew Level Display: |Corfig Variable -
Georeferenced: [No -

Show Hierarchy

“ References (1 of 1 unique, 1 displayed) E = @
Settings
Bk $DERATE Mg B 7@ > tie ode: [Boundares -]
erarchy St ¥ 4 Fle Name Model Description Logical Presentation [3] .§ & _-, ‘
=1 001 Tie_4451935 1 [ PW_WORKDIR:cms01929\MoDOT_DE_2008.dgn_Defaut border border Virsframe v
border, PW_WOF
Scale | 1.000000 : | 1.000000 Rotation | 07 Offset X | 0.0000 Y | 0.0000
IE"_J 1 > B £ A [MNo Nesting x| [Allow Ovemides »| Depth: | 1 New Level Display: |Config Variable
El T 3 Georeferenced: [MNo -

When on, displays a tree that shows the active file and references that are directly attached to it.
References that have other references attached to them (nested references) are listed in black text, and
references that do not have attached references are listed in gray text.
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If a reference in the hierarchy has a nest depth value of 1 or more, you can:
e  Click on the (+) sign and expand the hierarchy display.

e Select the reference. When you do this, the References list box updates to include only the
references that are attached to the selected reference.

When the tree is turned off, you can use the arrow button next to the Show Hierarchy icon to list the
active file and any references that are directly attached to it. As in the tree, if you choose a reference that
has attached references, the References list box updates to include only the references that are attached
to the selected reference.

Reference tool box

Contains tools used to:
e  Access the References dialog.
e Attach referenced models to the active model.
e Control the positioning, scaling, clipping, and orientation of attached referenced models.
o  Detach referenced models from the active model.

5 oy O . S [0 iy
E%_l ¥ @D ¢ ﬂa_';j _‘ljﬁ?‘ju;a-ﬂﬁj@ﬁ

These tools can also be selected in these ways:

e  From the icons on the References dialog ( File > Reference).
e  From the Tools menu in the References dialog (File > Reference). The controls in the References
dialog are used to adjust reference settings as well.

All tools in a toolbox are not always visible by default. To see all tools, right-click in the toolbox and select
Show All from the menu.

To Select in the Reference toolbox
Manage reference attachments using the References dialog.
The References tool is also found on the Primary Tools toolbox.
References

fi

Attach a model (reference) to the active model. [
Attach Reference
Change a reference clipping boundary. _gﬁ
Set Reference Clip Boundary
-

Mask (cover) part of a reference that is inside the clipping boundary. (-]

Set Reference Clip Mask

Selectively delete a reference's clipping mask(s). %
Delete Reference Clip
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T.@

Set the back clipping plane for a 3D reference. Set Reference Back Clip Plane

L
Set the front clipping plane for a 3D reference. éé
Set Reference Front Clip Plane

-
Reread and redraw a reference to see recent changes made to it. =

Reload Reference
B
Move Reference

>R

Copy a reference. _:’l

Move a reference.

Copy References

F Y
Scale a reference. ﬁ

Scale References

Rotate a reference. [
Rotate Reference

u
Mirror a reference about a horizontal or vertical axis. .:I
Mirror Reference
Copy a reference, then attach a view of the reference by folding it about j:j
=

an orthogonal axis or a line defined by two points.
Copy Reference by Folding

Sets the rendering mode of the reference. L—l'
Set Reference Presentation

Detach a reference from the active model. Xj
Detach Reference

None

» Boundaries

. Model Hilite:
Hilite Mode . Both

Controls whether the selected references are highlighted and surrounded by a border.
e None — Selected references are not highlighted in any way.
e Boundaries — Places a dashed border around selected references.

e Hilite — Highlights selected references.
e Both — Places a dashed border and highlights selected references.
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Located along the bottom of the References dialog box are additional icons that control the attachment
settings for the different reference files.

Scale | 1.000000 : | 1.000000 Botation | 0° Offset X | 0.0000 Y | 0.0000
|I|'__1 1|1| 2o B Mo Nesting x| [Allow Ovenides | Depth: | 1 New Level Display: |Config Variable =
Georeferenced: |Mo -

Displays and controls settings for a selected reference.

e Scale — Displays and sets the ratio of master units in the active model to the master units in the
attached model.

e Rotation — Displays and sets the rotation for the selected reference. For 2D files, you can enter
the rotation angle for the z-axis only. In 3D, you can enter the rotation angles for the x-, y- and z-
axes.

e Offset — Displays and sets the distance between the global origin of the reference from the
global origin of the parent file, measured in units of the parent file. If the parent is 2D, Offset X
and Y values are displayed. If the parent is 3D, Offset X, Y, and Z values are displayed.

e Attachment settings icons — The information panel icons correspond to columns in the
References list box, as well as to icons on the Reference Attachment Settings dialog.

If anicon is pressed, the setting is on. Click the icons to toggle the settings on or off. For more information
on an icon, see the description for the corresponding column in the References list box.

If you select multiple references that have different settings, the icons representing different settings are
shaded. For example, if one of the selected references has True Scale enabled while the other selected
reference has True Scale disabled, the True Scale icon is shaded.

e Nesting menu — Displays and sets how nested references (references attached to references)
are handled for the selected attachments.

Menu Iltem Description
No Nesting Nested references are ignored for this attachment.

The hierarchical structure of any nested references are maintained when
attaching the reference. The child references are displayed if:

the nest Depth is set high enough

the child reference does not have its Ignore Attachment When Live Nesting

Live Nesting .
setting turned on
All of the nested attachments display in the view window; however you see only
the parent reference in the References list box. To see the hierarchy of nested
references, use the Show Hierarchy icon on the References dialog.
o Models that are attached to the attached model are copied (referenced) directly
Py into the active model, which flattens the hierarchical structure of the nested
Attachments

references.

— Note: When working in a DWG or DXF file, live nesting is always on, and there is no limit to nest depth.
Therefore the nested attachment and Depth items are disabled. To control the display of nested
attachments, use the Ignore Attachment When Live Nesting icon.
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e Overrides menu — Controls how override settings are saved for nested references. For a specific
nested reference, overrides let you control the settings for reference display, locate, snap, raster
reference display, and level display.

Menu Item Description
Allow The overrides are automatically created as required when you modify the
. corresponding settings for nested references.

Overrides . .

Key-in: reference set nestOverrides=allow

Saves the toggle and level display state for every nested attachment. This option
Always locks in the settings for all nested attachments. The settings change only if you
Override specifically change them.

Key-in: reference set nestOverrides=always

Never creates overrides for any of the nested references. The nested references
Never are displayed the same as they are when the reference is opened as the master
Override file.

Key-in: reference set nestOverrides=never

o Depth — Sets the number of levels of nested references that are displayed. Models can have
their own referenced models, which, in turn, can have more referenced models, and so on.

If Depth is set to 0, only the selected model is attached to the master model; models referenced to the
selected model are ignored.

When working in a DWG or DXF file, live nesting is always on, and there is no limit to nest depth.
Therefore the Nested Attachments and Depth items are disabled. To control the display of nested
attachments, you must open the reference as the active model, and use the Ignore Attachment When Live
Nesting setting for its attachments.

e New Level Display — Specifies whether a reference displays new levels. The setting also applies
to new levels in nested references that are attached to the reference.

Menu Item Description
Config New levels in the reference are displayed according to the setting for the
Variable MS_REF_NEWLEVELDISPLAY configuration variable.
Always New levels in the reference are always displayed.
Never New levels in the reference are never displayed.

e Georeferenced — Sets the georeference mode. When a reference is attached in Reprojected
mode, the current Reference Reprojection Settings are copied into the reference attachment and
stored so every user who opens the master file uses the same reprojection settings and thus,
gets the same results.

e path — Shows the full specification for the reference, including the directory.

e Right-click menu — Controls the display of items in the information panel.
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M References (1 of 1 unique, 1 ¢
Tools | Settings
(=—
Detach =
Detach Al =

14.2 Attach Reference

Opens the Attach Reference dialog, which is used to attach one or more models to the active model.

M Attach Reference - Tde-prof\monitaeu\J5PO631 AN data’, 29
Lookin' )| date - @ F @ = 30-V8DGN
- Name - Date modified Type
el . rddbs 8/21/20099:12 AM  File folder
Recent Places  4f1te5g_plan_2D_transition 8/7/200012:5 PM  Bentley MicroStsti | NE—
! M rteS0_planmodel 7/10/2003 2:27 PM Bentley MicroStati
Desktop
Libraries
i ™ Attachmert Method
Coincident World hd
Computer
o,
@
Network
] I D
File: name fte50_planmodel - Open
Files of type: CAD Files ("dgn:™.dwg;" ) - [ cancd |
v ] Save Relative Path Options

1. Inthe Primary Tools toolbox, click the References icon.
2. Inthe References dialog, click the Attach Reference icon.

3. Inthe Attach Reference dialog, select the DGN file that contains the model to attach as a
reference.

4. From the Attachment Method option menu, choose Coincident World (Coincident World —
Aligns the references with the active model with regard to both Global Origin and design plane
coordinates). This is the preferred method at moDOT.

5. Click OK.

6. Inthe Reference Attachment Settings dialog, adjust settings as required.

7. Make sure “Save Relative Path” is checked (Save Relative Path allows MicroStation to search
backwards through the directory structure for reference files).

8. Click OK.
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14.3 Locating “lost” attachments

If MicroStation cannot locate a reference upon opening a DGN file, the geometry for that file will not be
displayed in the active file. Upon opening the Reference dialog box, “lost” reference files will be listed in
red instead of the black color that represents a correctly attached file.

M References (1 of 1 unique, 0 displayed) [o] =@ | =]
Tools  Settings
E-lBxd £9¢EaR2R ug: b 3t ote: Bondaies <)

St ¥ (4 File Name Model Description Logical Presertation [=] .4 % i3

631_topo.dan Global Origin aligne Viireframe:

Scale [1.00 : [T-000000 Betation [0° Offset X [0 Y. [D:0001
] > ¢ [E]® [P] A [NoNesing ~] [Alow Overides +] Depth: [1
New Level Display: (Config Varizble ~] Georeferenced:

Reattaching a “lost” file

1) Double-click on the listing for the lost reference file within the Reference dialog box.

The attachment Settings Attachment Settings: 631_topo.dgn
dialog box appears. Y e l63 1 topo dorl
Full Path:  File Not Found
. ) . Model:
Notice that no path is listed .
Logical Mame:
next to the FU” Path portion Description: | Global Origin aligned with Master Fj
of the dialog. Also make note Detal Scale: [Ful Size 1=1 =
. Scale (Master:Ref): | 1.000000 : | 1.002000
of the file name that needs to
. Named Group: hd
be attached so that this exact Revisian: -
file can be located. Lzt =
MNested Attachments: hd Depth; |1
Alloy -

v |Use MS_REF_NEWLEVELDW
: | Master hd

2) Since the path for this file has
been lost, it will need to be

located manually. Within the = EE0E >o@Ee@a 4
Attachment Settings dialog [

Synchronize with Saved View

oK ] [ Cancel ]
box click the Browse button:
The Reattach Reference dialog box appears.
7 Rentach Reference- To\de-prej monitaeut SPOGILA! data == |
Loak n dats = R 10 -VE OGN
Harne Type
<l st ;.; felder
RecentPlaces i3 popo.dgn M Bentiey MicroStati.
M) te50_plan 20 transition.dgn &M Bentiey MicroStati
! M) riesd :lnmc;fl.m,:‘ 2 F/H0/2009 227 P4 npn::, M.mm:.
Desdtop
L-brlJlng"
A
Computes
(19
Network e —
Fie rame: 631 3200.dgn - L Geen |
Fls of by Miero Station DGH Fles (dgn] - Cacnl
Srvw Falaton Fath
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3) The Reattach Reference dialog box will default to the home directory of the active file that you
are working in, so you may have to navigate to the directory where the reference file is located.

4) Once you are within the correct directory, navigate through the Files listing until you find the
correct file name to attach.

Be careful you have the correct file name ! MicroStation will attach any file that you specify at this
point, so choosing the wrong file will result in geometry that is incorrect for the active file.

If necessary, you can grab the Reattach Reference dialog box by the banner and move it so that you
can see the file name in the Attachment Settings dialog box.

5) Make sure the Save Relative Path setting is checked in the lower left corner of the dialog box.

6) Select the desired file for attachment by highlighting the name in the list and hitting Enter on
your keyboard or the OK button on the dialog box, or by double-left-clicking the name within the
listing.

7) Once the file has been selected from the Reattach Reference dialog box, you will notice that the
full path portion of the Attachment Settings dialog box is now populated with the correct
directory path and file name. Click the OK button on the Attachment Settings dialog box.

You will notice now that the listing for the reference file is now shown in black and that the
geometry for that file is now displayed in the active file.

2]

14.4 ldentifying References [, . 7. o
o2l @

Identifying references on which to operate is an alternative to selecting the reference in the References
dialog box’s list box; the identification technique is typically used with the tools in the References tool
box.

To identify a reference

In a view window, identify an element in the reference with a single data point click. The reference
information will be displayed with-in the Message Center of the Status bar.

Element Selection > Identify element to add to set 5 Complex Shape * Line. Level: Border-Border, Ref: barder (PW_WORKDIR dms01525\MoDOT_DE_2008 dan)
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14.5 Set Reference Clip Boundary

o~

ﬁ References (2 of 2 unique, 2 displayed)

Tools  Setti
- e AL D ¢ B LT @ R wen

Slet ¥ jWName Model Description Logical
1 £31_alignment dgn Default Global Origin aligne...
2 A AMeDOT_DE_2008.¢ Defautt Global Origin aligne...
i M Set Reference Clip Boundary [= = |[=] | Active Fence
Used to define a reference FEHE=TTeA] > I
Method: (Element =] b 2=

clipping boundary.

[] Discard Existing Clip Masks MNamed Fence
Use References Dislog List

Tool Settings Effect

Determines the method by which the reference clip boundary is set.
e Active Fence — Uses the active fence as the clip boundary.
e Element — Uses an element or cell to set the clip boundary.
e Named Fence — Uses a named fence to set the clip boundary.

Method:

Discard Existing Clip If on, deletes existing clip masks before applying a new clipping boundary.

Masks

Use Reference If on, the clip boundary applies to the references selected in the References dialog. If
Dialog List off, you are prompted to select the references to be clipped.

For example:

v | Here we have too
much roadway for
our plan view.

1408



MicroStation V8i — Using References

Using the Level Display dialog, we can turn on
the appropriate level with the element boundary
showing the plan view. With this boundary
displayed we can place a fence on that element.

[ M Level Display - Vie.. [ = || @ |[ =]
oy
K= A Used'v [4
EHW rte50_plan_2D_transition dgn

v 631_alignment .dgn
v LAY Astandard wsmod'design®y

< ] b
MName o

Border-Plan-profile major grid lines
Border-Plan-profile minor grid lines
Border-Full profile major grid lines
Border-Full profile minor grid lines
Border-Plan bottom shape
Border-Xsection shape
Border-Plan-profile top shape
Border-Plan top shape

|

m b

At this point we can
choose the Reference
Clip Boundary tool to
initiate the clip. Now
simply left-click in the
view to accept the clip.
This will clip off the
excess roadway.

14.6 Set Reference Clip Mask

“ References (2 of 2 unique, 2 displayed)
Tools  Settings oy

=) o=

Y 1=

EDEAPR MDD

Used to place a reference clipping
mask defined by an active fence.

St | ¥ [ F'Eﬁg Model Description Logical Presertation [o] .§ &
1 6317 _alignment.dgn Default Global Origin aligne.. Wireframe: AT
2 U AMoDOT_DE_2008 « Default Global Crigin aligne Wireframe [V Ay

L Set Reference Clip Mask E\ =]

Use References Dialog List

| Tool Settings |

Effect

Use Reference
Dialog List

If on, the clip mask applies to the models selected on the References dialog. If off,
you are prompted to select the models to be clipped.

1409



MicroStation V8i — Using References

14.7 Delete Reference Clip Mask

ﬁ References (2 of 2 unique, 2 displayed) EI =] @
Tools  Settings o~
EE - E Y g}‘: N ¢ e 4 % 7 } Hilite Mode: [Boundaries |
St ¥ [§ File Name Model Description Logical Presentation [o] .§ &
1 631_alignment.dgn Default Global Origin aligne... Wireframe [ A
2 A AMoDOT_DE_2008.« Default Global Origin aligne... Wireframe [ A

Used to selectively delete clipping masks or clip boundaries.

Tool Settings Effect

Use Reference Dialog If on, clipping is deleted in the models selected on the References dialog.

List
If on, the fence contents are deleted from the reference clipping. The option menu
Use Fence .
sets the Fence (Selection) Mode.
M Delete Reference Clip [ = | & || &=
V| Use References Dialog List
To selectively delete reference clipping Use Fencs:  (Inside 2

1) Inthe References dialog, select the references that have clipping to delete.

2) Click the Delete Clip icon.
The Delete Reference Clip tool settings window opens.

3) Turn on Use References Dialog List.
The clip boundary and any clip masks within the boundary highlight.

4) Identify the clip boundary, or clipping mask to be deleted.
5) Accept the deletion.
or
Reset to keep the highlighted clip boundary or clipping mask.
6) Repeat step 4 for each subsequent clipping mask.
e When you select a reference (or have one selected from the selection set, fence or dialog), the

reference is highlighted. If there is a clip boundary and one or more masks, the boundary is
shown in yellow and the masks shown in red.
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14.8 Reload Reference

When working with models that include references, it is possible that other users are making changes to
the references. When a change has been made to a reference, and it has not been updated in the active
model, the references dialog displays an icon in the Status column for the reference. This indicates that
you need to reload the reference in the current session to get the latest updates.

ﬂ References (2 of 2 uni 2 displayed) EI = @
Tools  Settings

E By $9CRPY BLAM@ R oo +
S\oiA A File Name Modsl Description Logical Presentation [o] .J X%
1w E_}'I__al_ignment.dgn Defautt Global Origin aligne... Wireframe LA
2 A AMoDOT_DE_2008.« Default Global Crigin aligne... Wireframe LA A,

1 [T} 3
Scale | 1.000000 : | 1.000000 Botation | 0% Offset X | 0.0000 Y | 0.000
ml:;] < ¢ B @_g | [NoMNesing _ ~ g =] [Nev mde | Depth: |1

Mew Level Display: Mever =) Georeferenced: Mo =

To reload a reference
1) Inthe list box in the References dialog, select the reference.

2) Click the Reload Reference icon.
The reference is redrawn.

e Reloading a reference lets you see changes that have been made to the reference by a co-worker
on the network since the reference was last attached or reloaded.

To reload all attached references

1) From the Tools menu, choose Reload All.
The references are redrawn.
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14.9 Move Reference File

){ References (2 of 2 unique, 2 displayed) EI = @

Tools  Settings

.EEE - E -&‘; = gé D (¢ :1; -&» Fj ;1:' ij bl ﬂlrleMude Boundaries «

St ¥ | File Name Description Logical Presentation [+] .§ X
1 £31_alignment dgn Default Global Origin aligne... Wireframe AR
2 A AMeDOT_DE_2008.¢ Default Global Origin aligne... Wireframe AR A
Used to move a referenced design file. M Move Refere.. [ ] = |

| Move Boundary with Reference
/| Use References Dialog List

Use Fence: | Inside -

Tool Settings Effect

If on, any clipping boundary and/or clipping mask(s) is moved with the reference.
If off, the reference is moved, with any clipping boundary and/or clipping mask(s)
remaining as is. In effect, the reference “slides” through the boundaries/masks.

Move Boundary with
Reference

Use Reference Dialog

List If on, the models selected on the References dialog are moved.

If on, the fence contents are moved. The option menu sets the Fence (Selection)

Use Fence Mode

To move a reference selected from the References dialog list

2) Inthe References dialog's list box, select the references that you want to move in the active
model.

3) Turn on Display, Snap, and Locate.

4) Click the Move References icon in the References dialog.

5) Inthe tool settings window, turn on Use References Dialog List.

6) Enter a data point to begin the move, and drag the reference to the desired location.
To move a reference using a fence

1) Place a fence around the area containing the references to be moved.

2) Inthe References dialog's list box, select a reference.

3) Click the Move References. icon.

4) Inthe tool settings window, turn off Use References Dialog List.

5) Turn on Use Fence and choose the fence mode.

6) Enter a data point to begin the move, and drag the fence and reference to the desired location.
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14.10 Copy Reference File

.K References (2 of 2 unique, 2 displayed) =HINE] 3
Tools  Settings

EEE - E * ] g D ¢ ﬁ a‘j é:_, ’:3 ﬁj L_jj 7 Hiite Mode: | Boundaries v

St ¥ [ File Name WMaodel — Description Logical Presentation [a] .J &
1 631_alignment dgn Default Global Crigin aligne Wireframe ARV
2 M AMoDOT_DE_2008.¢ Default Global Crigin aligne... Wireframe [T AN S
Used to copy attached references. M Copy Reference Attachment [ o [ =1 [ 72

Copies 1
V| Move Boundary with Reference
/| Use References Dialog List

Fence: | Inside -

Tool Settings Effect
Copies Set the number of copies to make.

If on, any clipping boundary and/or clipping mask(s) is copied along with the
Move Boundary with reference.
Reference If off, only the reference is copied, while any clipping boundary and/or
clipping mask(s) is ignored.

Use Reference Dialog List  |If on, the models selected on the References dialog are copied.

If on, the fence's contents are copied. The option menu sets the Fence

Use F
serence (Selection) Mode.

To copy elements from a reference to the active DGN file
1) Inthe References dialog's list box, select the reference in which the elements are located.
2) Turn on Display, Snap, and Locate.
3) Select or place a fence around the elements to be copied.
4) From the Manipulate toolbox, select the Copy tool.
To copy references selected from the References dialog list

1) Inthe References dialog's list box, select the references that you want to copy in the active
model.

2) Turn on Display, Snap, and Locate.
3) Click the Copy References icon.
4) In the tool settings window, turn on Use References Dialog List.

5) (Optional) To make multiple copies, turn on Copies and in the adjacent field, key in the number
of copies.

6) Enter a data point to begin the copy.

7) Drag the reference to the desired location, and enter a data point to place the copied model.
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To copy references using a fence
1) Place a fence around the area containing the references to be copied.
2) Inthe References dialog's list box, select a reference.
3) Click the Copy References. icon.
4) Inthe tool settings window, turn off Use References Dialog List.
5) Turn on Use Fence and choose the fence mode.

6) (Optional) To make multiple copies, turn on Copies and in the adjacent field, type in the number
of copies.

7) Enter a data point to begin the copy.

8) Drag the reference to the desired location, and enter a data point to place the copied model.

14.11 Scale References

‘K References (2 of 2 unique, 2 displayed) o || B[
Tools  Settings
E-lBxa AN B 05 Q) % e Mode: [Boundaies o]
St ¥ 5 File Mame Model Yss:ripﬂun Logical Presentation [&] .4 &
1 631_alignment dan Default Global Crigin aligne... Wireframe [ S
2 LML AMoDOT_DE_2008« Default Global Crigin aligne... Wireframe AN
“ Scale Reference =1 I <

Method: |Scale Factor =

¥ Scale Factor
Scale Factor: | 1.000000

Absolute Ratio
. . . V| Move Boundary with Reference ﬁ'l' Poirts
Used to resize a referenced design file. | Lse References Diclog List
Use Fence:  |Inside -
Tool Settings Effect

Method by which the referenced model is scaled.

e Scale Factor — Reference is scaled by a specified factor. For example, a scale
factor of 2.00000 doubles the size of the reference.

e Absolute Ratio — Reference is scaled by a specified ratio of Master file units
to Reference file units. For example, to set five active model master units for
each referenced model master unit, key in 5 in the left-hand field and 1 in the
right-hand field.

e By Points — Model is scaled by points entered.

Method

If on, any clipping boundary and/or clipping mask(s) is scaled along with the reference.
If off, only the reference is scaled, while any clipping boundary and/or clipping mask(s)
remain as is.

Move Boundary
with Reference

Use Reference

. . If on, the reference(s) selected in the References dialog is scaled.
Dialog List

(Fence present only) If on, the fence contents are scaled. The option menu sets the

Use Fence Fence (Selection) Mode.
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To scale references selected from the References dialog list

1. Inthe References dialog's list box, select the references that you want to scale in the active
model.

2. Turn on Display, Snap, and Locate.
3. Click the Scale References icon.

4. Inthe tool settings window, choose the scaling Method (and key in the scale factor or ratio, if
applicable).

5. Turn on Use References Dialog List.
6. Enter a data point about which the reference is scaled.
To scale references selected using a fence
1. Place a fence around the area containing the references to be scaled.
2. Inthe References dialog's list box, select a reference.
3. Click the Scale References. icon.

4. Inthe tool settings window, choose the scaling Method (and key in the scale factor or ratio, if
applicable).

5. Turn off Use References Dialog List.
6. Turn on Use Fence and choose the fence mode.

7. Enter a data point about which the references are scaled.

14.12 Rotate References

-

M References (2 of 2 unique, 2 displayed) o || = | &=
Tools  Settings

E- By €96 022 7D 57 @ 0 e Gk )

St ¥ (4 File Name Model Descnption Logical Presentation [] & &
1 £31_alignment dan Defautt Global Origin aligne ... ‘Wireframe W W W
2 G AMoDOT_DE_2008. Defaut Global Origin aligne... ‘Wireframe W

M Rotate Refere.. | = | = |[ 22 |

Used to rotate a reference. » By Angles

Method: [By Angles v~ ” By Poirts
x: [C.0000°

Y: )
Z: | 0.0000°
Move Boundary with Reference

Use References Dialog List
Use Fence: | Inside -
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Tool Settings Effect

Method

Move Boundary with
Reference

Use Reference Dialog

List

Use Fence

Sets the method by which the reference is rotated.
e By Angles — Sets the rotation angle(s). In 2D, sets the rotation angle(s) on
the z-axis only. In 3D, sets the rotation angle(s) on the x-, y-, and z axes.
e By Points — Sets the point about which the reference is rotated.

Angle to rotate the reference about the x axis for 3D files.
Angle to rotate the reference about the y axis for 3D files.
Angle to rotate the reference about the z axis for both 2D and 3D files.

If on, any clipping boundary and/or clipping mask(s) is rotated with the reference.
If off, only the reference is rotated, with any clipping boundary and/or clipping
mask(s) remaining as is.

If on, the model(s) selected in the References dialog is rotated.

If on, the fence contents are rotated. The option menu sets the Fence (Selection)
Mode.

To rotate references selected from the References dialog list

In the References dialog's list box, select the references that you want to rotate in the active
model.

Turn on Display, Snap, and Locate.
Click the Rotate References icon.

In the tool settings window, choose the rotate Method (and key in X, Y, Z coordinates if method
is By Angles).

Turn on Use References Dialog List.

Enter a data point about which the references are rotated.

To rotate references using a fence

1.

1416

Place a fence around the area containing the references to be rotated.
In the References dialog's list box, select a reference.
Click the Rotate References. icon.

In the tool settings window, choose a rotate Method (and key in X, Y, Z coordinates if Method is
By Angle).

Turn off Use References Dialog List.
Turn on Use Fence and choose the fence mode.

Enter a data point about which the references are rotated.


mk:@MSITStore:C:\Program%20Files\Bentley\Documentation\MicroStation.chm::/ustnhelp632.html#F11438

MicroStation V8i — Using References

14.13 Detach Reference

# References (2 of 2 unique, 2 displayed) E' =] @

Tools Settings

B g DGR 3 M s D 55 G| o (Boundares +)

Slot ¥ 4 File Name Model Description Logical Presertation [o] & &
1 £31_alignment.dgn Default Global Origin aligne... Wireframe [ R
2 A SMeDOT_DE_2008 .« Default Global Origin aligne... Wireframe Y S

Used to detach a referenced design file from the active design file.

M Detach Refere... [ = || @ |[ 2]

Use References Dialog List

[] Use Fence: | Inside A
Tool Settings Effect
Use Reference If on, the reference(s) selected in the References dialog is detached from the master
Dialog List file.

If on, the references contained by the fence are detached from the active model.

Use F . .
>erence The option menu sets the Fence (Selection) Mode

To detach references
1. Inthe References dialog's list box, select the references.

2. Click the Detach Reference icon.
An alert box asks you to confirm that the selected references are to be detached.

3. Click OK.
To detach all references

1. From the Tools menu, choose Detach All.
An alert box asks you to confirm that all references are to be detached.

2. Click OK.
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MicroStation V8i — MoDOT Plotting

15.0 MoDOT Plotting

Network Plotting is designed to allow MoDOT MicroStation users the ability to plot design files to plotters

connected to MoDOT'’s in-house network plotter system depending on your location. It has the following

features:

e  Plotter selection

e Location selection

e  Papersize

e Color, Black & White, Gray scale
e Plot multiple or single files

e Scale factor

e Number of copies

e Seal Manually option

e  PDF File Destination

e Plot by either fence or border reference file

15.1 Plotting Preparation

In order to plot out the design files correctly you will need to be in the proper Project.
The Project controls the how the linestyles appear when the design file is plotted.
Selecting the corresponding Project to drawing scale will plot the drawing to scale.

As an example, if you are working with 1” = 100’ plan sheets then you would choose the i_100 Project. Or
if you are working with 1” = 50’ plan sheets then you would choose the i_50 Project.

Using the correct Project will give you a “what you see is what you get” (wyswyg) display on your screen.
A dash line will have the correct spacing between the dashes or the correct symbol at the correct scale for

the linestyle.

Lok in:
T
el

Recent Places

Desktop

Libraries

LY

Computer

1500

File name:

Files of type:

Mame
) OLD JUNK
@4 DELETE-PP_J5P0892_1100_15.dgn

¥ PP_I5P0892_150_13_ENTRANCES-opt.dgn

#L]PP_I5P092_1100_04.dgn

| PP_I5P0&92_1100_05.dgn

| PP_I5P0892_1100_06_MTOLIVET.dgn
L] PP_I5P0892_T100_07.dgn

M| PP_I5P0892_T100_08.dgn
#L1PP_I5P0892_1100_09_RTEHH.dgn
| PP_I5P0892_T100_10.dgn
#LPP_I5P0892_1100_11.dgn

| PP_I5P0&92_1100_12.dgn

(< 5
Date modified

4/15/200911:29 AM
471572009 11:02 AM
4/15/200911:03 AM
4/15/2009 11:02 AM
4/15/200911:02 AM
4/15/2009 11:03 AM
4/15/200911:03 AM
4/15/2009 11:03 AM
4/15/2009 11:03 AM
4/15/200911:03 AM
471572009 11:03 AM
4/15/2009 11:03 AM

PP I15PORG? TIO0 14.dan
4| 1

4/15/200811:03 AM
|

6_plan05_merged.dan

v

L=

Type *

File fol
Bentle
Bentles
Bentler
Bentley
Bentle
Bentle:
Bentle
Bentle

Bentles

Bentler

Bentler

e

Rentler ™

3

=
=]
-
2
@
Q

RO
(=]

%l‘é‘é‘&’ﬁ

=

N
g

m

i_misc
i_titlesheet

— 5
S

[CAD Files (" dan:” dwa.” df)

v | Cancal |

[] Open as read-only

Options

Eggéggg

m_converted
m_misc
m_titleshest
map_1
map_100
map_200

-

Interface: | Design
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15.2 Begin Plotting

There are three ways to activate MoDOT Plotting. The first way is under the pulldown menu option of File.
The second is located on the Standard Toolbox, all you have to do is select the printer icon and the
MoDOT Plotting is started. The third way is to use the “hot keys”

,Ivl TA\de-projtBenten'J5P0892\plan_sheets\Plan\PP_J5P0892 1100 _04.dgn [2D - V8 DGN] - MicroStation V8

File | Edit Element Settings Tools Utilities Workspace Applications Window Design  Construction

|_j New... N |y 3 v () -L+ °j =

*

Help

Open... Ctrl+Q
Close Ctrl+W
& Save Ctrl+S
f Save As...
Compress 4
Save Settings Ctrl+F
. O] References —— MoDOT Plotting

|[ES) Raster Manager
Import 3

MoDOT Plotting

Properties Alt+Enter

| 1 T\de-proj\Benton'J5P0832\plan_sheets\Plan\PP_I5P0892_T100_04.dgn
2 Jh\greencd\06_plan05_merged.dgn

When MoDOT Plotting is activated it looks for one of two things. First it looks for an active Fence. If it
finds an active fence then MoDOT Plotting will generate its plot data from the contents of that fence. If
there is no active fence then MoDOT Plotting will look for a referenced border. This referenced border is
1 of 2 reference files called plot2d.dgn or plotdata.dgn.

If you do not have a Fence or a Border plotting will fail and you will get the following dialog information
box.

Information

Mo Fence or Border found!

Another important facet to MoDOT Plotting is the file name. You cannot have any spaces in the file name.

Also, these symbols are not allowed in the file name:
\ /[ *?2<>"& =
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The following shows MoDOT Plotting with a Fence Status: Active (Fence is active) and a Fence Status:
Border (Reference file is active).

M MODOT Plotti.. = 25 M MOoDOT Piotti. = Lo
Plotter: [Lexmark W40 ] Plotter: | Lexmars Wa40 |
Location: |CADD Support Location: |CADD Support
PaperSize: b ] PaperSize: b ]
Color: | Black & White Color: | Black & White
Files: Files:
[F] Scale: | 199.993600 [[] Scale: | 120.785521
Copies: |1 [ Portrait Copies: | 1 [ Portrait
[] Seal Manually F Stat [] Seal Manually
ence Status
Place PDF File in ProjectWise / \ Place PDF File in ProjectWise
PDF File Destination: < > PDF File Destination:
Browse... Browse...
Open File Destination Folder > Open File Destination Folder
Fence Status: Border Fence Status: Active
[ Pot ] | Cancel | [ Pot ] [ Cancel |

15.3 MoDOT Plotting Settings

Within MoDOT'’s plotting routine there are a number of options that you can choose from.

Plotter

Location

Paper Size

Color

Files

Scale

Copies

Portrait

1502

This will allow the user to choose a plotting device from a list of plotters.

This will allow the user to specify a location to send a plot, depending on the choice of the
plotter.

This will allow the user to choose from the various paper sizes depending on the choice of the
plotter.

This will allow the user to select either color, black & white, or grey scale plots.

This will allow the user to send single plots, multiple plots, or multiple borders in the file.

This will allow the user to send a plot at a scaled size other than the default border size.

This will allow the user to enter in a number of copies to plot without having to send the same
plot repeatedly.

This allows the plot to be rotated from a “landscape” to a “portrait” print.
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Seal Manually This will place a mask around the text in the sealing area for wet sealing a sheet.
PDF File This allows the user to place the PDF files being created from the MicroStation files to a certain
Destination folder on the network.
Plot This allows the user to submit the plot(s) to the selected plotting device.

Cancel This button unloads the plotting application without submitting a plot.

15.4 Plotting Using a Fence & Scale Factor

Using the Place Fence tool, place a fence around the geometry that you would like to plot.

M MODOT Piott,. | S

Start the MoDOT Plotting routine.

Fill in the dialog options, as you prefer.
If the Scale option is unchecked you will get a plot that will fit the size

of the paper that you selected. \/'

Plotter: | Lexmark W840 |
Location: [CADD Suppott | ppot |
PaperSize: b |
Color: [Black & White |

Copies: Portrait
Seal Manually
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If you need to apply a particular scale factor to your plot you can select the Scale option to make it active.
Once the Scale field is active you can enter a scale factor in the input field. The value cannot be less than

the value shown in the input field.
M MODOT Plotti. o= =1 S

Plotter:
Location:
PaperSze:(b ]
Color:

C

Scale:

|:| Seal Manually

Place PDF File in ProjectWise
PDF File Destination:
Browse ...

Open File Destination Folder

Fence Status: Active
Pt | | Cancel

15.5 Plotting Multiple Design Files

,K MODOT Plotti..

Within the MoDOT plotting routine under the “files” button there is an option Plotter: (Leamaic Wadd |

to plot multiple plots. Location: CJ\DD Support
Paper Size:
Cal Black & White

b Cument
Selecting this “Multiple” option will bring up the Select Files dialog box. oo, Mutiple

Copies: Multiple Borders in Same File

B Select Files G=NEENL X | L)z s
ey This field displays the Pléce PDF Fil-e in ProjectWise
; / files to be plotted. PDF File Destination: ~ )
rowse. ..

\

/ L . Cpen File Destination Folder

This field displays the
Fence Status: Active

directory you are
i p— — . . [ Plat ] [ Cancel ]
de-proj' BentorJ5P0B92'plan_shests'Plan’™, dgn currently working in.

[ Plet in Reverse Order
[ Plet Standard Sheets

English
Metric
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Browse This will allow the user to navigate through directories to choose design files for plotting.
Remove This will allow the user to remove one or more design files from the “Files to Plot” field.
Open This will allow the user'to Ieaye the current drawing and e'nter thg selected file keeping the
“Select Files” dialog box open and loaded with the files to plot.
Add All This will allow the user to add all the files in the selected directory.

Plot in Reverse
Order

Plot Standard

This will allow the user to plot in a reversed order. This option is for the plotters that plot the
drawings face up.

When plotting Standard Sheets this option should be checked. This will allow the next two

Sheets options to open up.
Enelish Choosing this option allows you to plot an English Standard Sheet. The plotting routine will

& open the file and turn off level 46 the Metric information.

. Choosing this option allows you to plot a Metric Standard Sheet. The plotting routine will open
Metric ) . .
the file and turn off level 45 the English information.
oK This option allows the user to send the information to the MoDOT plotting dialog where a click
on the plot button begins the process.

Cancel This cancels the multiple plot option and returns you to the MoDOT plotting dialog.

To plot multiple files at one time
1. Start the MoDOT plotting routine.
2. Set the plotting parameters as you need.
3. Click on the “Current” button and select the “Multiple” option.
4. Click on the “Browse” button. Englsh

5. Choose the desired files for plotting by selecting and clicking the

M Select Files

Files to Plot

de-poj n'J5P0892"plan_sheets\Plan\".dgn || Folder...
Browse lemove Open Add Al

Flot in Reverse Order
Plot Standard Shests

Metric

| Cancel ‘

“Add” button.
After the files are picked you can still “Add” or “Remove” files as needed by highlighting the file
and clicking the appropriate “Add” or “Remove” buttons.
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Files: Directories:
.Mbenton'j5p0832\plan_shests\plan'.

PP_J5P0892_1100_04.dgn 1 B

PP_J5P0892_1100_05.dan [ de-proj

PP_J5P0892_1100_06_MTOLIVET.da— [ berton

PP_J5P0892_1100_07.dgn (£ j5p0892

PP_J5P0852_1100_08 dgn [ plan_shests

PP_J5P0892_IN00_09_RTEHHdon |z = plan

PP_J5P0892_1100_10dagn 3 0LD JUNK

PP_J5P0892_1100_11.dgn

PP_J5P0892_1100_12.dgn

PP_J5P0892_1100_14.dgn

PP J5P0892 150 13 ENTRANCESo ™
4 | mn | F

-Canca
List Files of Type: Drives: -
“dan ~ 2 T TustationvEy ¥ Help
Files
Add
Bemove

Select Files to Add

Files: Directories:
..\benton'j5p0852\plan_sheets\plan®
PP_J5P0892_1100_04.don - |EFtN
PP_J5P0892_1100_05.dan (£ deproj
PP_J5P0852_1100_06_MTOLVET dai— [ berton
5 I (£ 5p0892
5 [ plan_shests
PP_J5P _RTEHHdan |z = plan
PP_J5P .dagn £ 0LD JUNK
PP_J5P 11.dan
x 12.dgn
PP_J5P0832_1100_14.dan
PP J5P0892 150 13 ENTRANCES-ol ™
4 T | L
List Files of Type: Drives:
“dan ] [2 T TustationvBhy 7]
Files

t:\de-proj*benton’j5p 0852 plan_sheetz plan*PFP_J5P0852_1100_07 dgn
t:\de-proj*benton'j5p0852°plan_sheets plan“PFP_J5P0852_1100_08.don i A
t:\de-proj*bentonj5p 0852 plan_sheetsplan*PP_J5P0852_1100_10.dgn Remove

t\de-proj‘berton'j5p 0832 plan_sheetsplan"PP_J5P0852_1100_03 RTEHHdgn ~ - :

[m] »

6. Click on the “Done” button when you are finished choosing the desired files for plotting and it
will bring you back to the Select Files dialog box.

7. Itis here that you may want to check the “Plot in Reverse Order”
button, only if you are plotting to a plotter that plots face up.
Also, if you are plotting Standard Sheets you will want to select the
“Plot Standard Sheets” option and it will give you a choice of English or
Metric to choose from.

Click the “OK” button.

8. This will bring you back to the original MoDOT Plotting dialog box
where a simple left click on the “Plot” button starts the process of

sending the plots to the plotter.

When plotting multiple plots MicroStation will open up each file that you selected,
turn on the lineweights, locate the plotdata border file and place a fence or if the
border file is not present it will do a fit view and place a fence around the
geometry and plot the drawing to the selected plotting device.

1506

M Select Files

Files to Plot
t-\de-proj*benton’5p0852\plan_sheets'plan PP _JE
t:de-proj*benton’j5p 0892 plan_sheets plan ' PP_JE ?
t:\de-proj benton{5p0892\plan_sheets plan\PP_JF|= |
t:\de-proj*benton’5p 0852 plan_sheets"plan PP _JE
t:\de-proj‘benton'i5p0852\plan_sheets plan PP _JE —

de-proj\Benton"J5P 0892 plan_sheets"Plan*" dan

[ Remove | Open

[ Plot in Reverse Order
[ Plot Standard Sheets

English
Metric

Cancel

M MODOT Plotti..l.= i

Plotter:
Location:
PaperSize: (b |
Color
Fles:
¥} Scale: |100.000000
Copies: | 1 [ Portrait
[ Seal Manualty

Flace PDF File in Project\Wise
PDF File Destination:

Browse...

Open File Destination Folder

R

=l o) |
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15.6 Plotting Multiple Borders in the Same File

Within the MoDOT plotting routine under the “Files” button there is an
option to plot “Multiple Borders in Same File”-

' -
M moDoT Plotti..| .= i

Plotter:
Location:
PaperSize: b |
:
» Curment
Scale: Multiple

When you choose this option you will get the “Select Files” dialog box that
has a pick list.

Copies: Muttiple Borders in Same Fi

=]

[] Seal Manualty

Place POF File in Project\Wise
PDF File Destination:

Open File Destination Folder

Fence Status: Active
Pot | [ Cancel

Browse...

From this dialog choose the border(s) to plot. You can use the control key to
build the list.

M Select Files = e

xsection(1
xsection2

[\

xsection(4

x5S
xsectionD6
xsectiond7
xsection08
xsection0S

xsection12

# the list for plotting.
[ SELECTALL | ) [ Identiy Border |

[T Plot in Reverse Order

—> B Select Files (=] )

ot
xsection(l
xsection (2
xsection(3
xsection(4
xsection(5
xsection 6
xsectionl7
xsection (8
xsection(
xsection10
xsection11
xsection12 o

[m] »

[ SELECTALL | [ Identiy Border |

[ Plet in Reverse Order

xsection10
xsection /\\‘ The “Select All” button does exactly that.... it will select all the borders in

The “Identify Border” allows the user to identify a border name from the
design file. Click on the “Identify Border” button then in the design file click
on a border and the border name will highlight.

Click the “OK” button when you are finished selecting the borders that you want to plot.
This brings you back to the main MoDOT Plotting dialog box where a simple click on “Plot” button initiates

the routine.
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15.7 Plotting to PDF File

Within the MoDOT plotting routine, there is also an option to print the file into a PDF file. This option is
very useful because there may be someone that wants to see the plans, but don’t have a cadd program to

view it.
M MODOT Piotti. = e

To plot a file to a PDF file

PDE_ D> ]
Location:
1. Start the MoDOT plotting routine. Paper Size. [b ]
Color:
2. Set the Plotter option to “PDF”. Files:
] Scale: | 199.995600
3. Set the plotting parameters as you need. Copies: |1 [ etk
[ Seal Manually
4. Click on the “Browse” button for the PDF file destination Flace PDF File in ProjectWise
location for the PDF files to be stored. PDF Fie Destination:

[] Open File Destination Folder

Fence Status: Border
[ Pot | | Camcel |

Browse For Folder M
Select Directory Where the POF file should be placed:
» # (N} cognos (\\ghapps011.gh.modot.local +
» L (R:) deapps (\\scdata(2.gh.modot.local)
5. Inthe Browse For Folder dialog box, navigate to the 452 (T:) ustation-v8i (Vighcaddtc01)
folder to where you are wanted to place the PDF 8 Bentley 3
X . 4 | de-proj in
files being created. Then select the “OK” button. 1‘”“
. AL
4 |, Benton
2 J5P0100
. J5P0&g2 i
M MODOT Plotti. L= G 4l 0 C
Plott BDF [ Make Mew Folder ] [ QK ] [ Cancel
ec [PDE_ |
Location: | PDF File Destination
Paper Size: [b |

Color: | Black & White

Fles: |Curert 6. Finally click the “Plot” button. This will create the selected

Scale: [199.999600 . B __— ) .
O CDE?B:: 1 7] Portrait MicroStation files into separate PDF files in the desired location
[F] Seal Manually that you previously specified. There is also an option in the
, MoDOT Plotting to “Open File Destination Folder”, which will
Place POF File in ProjectWise . A .
—- o open Windows Explorer to the location of the created PDF files.
le Destination:

[7] Open File Destination Folder
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ﬂ Tde-proj\Benton'\J5P083

plan_shests\X5\XS_I5P089 - MicroStation V8
Cut Plan Sheets

ProjectWise Start GEOPAK Job / Add User

File Edit Element Settings Tools Utilities Workspace Applications Window

. B ; o E 0 - @ vlﬂé" é e Design Standard Toolbox 3
15.8 Plotting Preliminary e

Summary Sheet
H Plan Sheet
DeSIgn Profile Sheet
User Design File
Reference Points Sheet
There is a simple way to plot strip maps to scale. Coordinate Points Sheet
Traffic Control Sheet
Erosion Control Sheet

First you must open the Preliminary Plan settings manager located Lighting Sheet
under the MoDOT pull down menu. Janes e
gning Sheet

Signing Section Sheet
X-Sections / Culverts Sheets

General Services - Mapping

Surv

To plot a long plot (Strip Map) from MoDOT plotting M Sclect Settings [ \stripmapstg] | B =M IR
L. . . File Category Style Options
1. From MoDOT choose the Preliminary Design settings S
aroup -
manager. 1"= 20 Strip Map E
1"= 50 Stip Map i
. 1" = 100° Strip Map
2. Inthe Group area choose a desired scale. 1" = 200 Strip Map -
3. From the Component area choose a length. Sart:
Component Type -
. o 4length - 100 scale Cel I
4. Place the cell and adjust the location if need be. &'length - 100 scale Cell |
& length - 100 scale Cell 7
10 length - 100 scale Cell
5. Place a block fence based on the extents of the cell. 12'length - 100 scale Cel
14" length - 100 scale Cell
16" length - 100 scale Cell &7
6. You may delete the cell or turn the level off that it was

placed in if desired.

7. Complete by starting MoDOT Plotting and choosing desired plotter, desired location and a paper
size of long and then “Plot”.

M. MODOT Plotti.. = S M MODOT Plotti...= X M MODOT Plotti...= X
Plotter.

Plotter:

Location:

. | Black & White Color: | Black & Whits

Fies: Files: Files:
[ Scale: |95.311127 [ Scale: |35.311127 [ Scale: |95.311127
Copies: | 1 [ Portrait Copies: | 1 [ Portrait Copies: | 1 [ Portrait
[ Seal Manually [ Seal Manually [ Seal Manually
Place PDF File in ProjectWise Place PDF File in ProjectWise Place PDF File in ProjectWise
PDF File Destination: PDF File Destination: PDF File Destination:
Browse... Browse. .. Browse...
Open File Destination Folder Cpen File Destination Folder Cpen File Destination Folder

Fence Status: Active Fence Status: Active atus: Active
Pt | [ Cancel Pt | [ Cance @ Cancel |
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Imperial (English)

Drawing Scale D-Size Paper Scale B-Size Paper Scale

17=1 1 2

1”7 =5 5 10

1” =10 10 20

1”7 =20 20 40

1” =50’ 50 100

1”7 =100’ 100 200

1”7 =200’ 200 400
Metric

Drawing Scale D-Size Paper Scale B-Size Paper Scale

1:100 2.54 5.08

1:500 12.7 25.4

1:1000 254 50.8

1:1500 38.1 76.2

1:2000 50.8 101.6

1:2500 63.5 127
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